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Product comparison
The product is available in the following configuration.

HP LaserJet M1319 MFP
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●

Prints letter-size pages at speeds up to 19 pages per minute (ppm) and A4-size pages at speeds up to 18 ppm.

●

Tray 1 holds up to 250 sheets of print media or up to 10 envelopes.

●

The priority input tray holds up to 10 sheets of print media.

●

Manual two-sided (duplex) printing, fax receiving, and copying.

●

Hi-Speed USB 2.0 port and one telephone handset port.

●

V.34 fax modem and 4-megabyte (MB) flash fax-storage memory.

●

Two RJ-11 fax/phone cable ports.

●

32-MB random-access memory (RAM).

●

30-page automatic document feeder (ADF).

●

Integrated telephone handset.

Chapter 1 Product basics
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Product features
●

Prints letter-size pages at speeds up to 19 ppm and A4-size pages at speeds up to 18 ppm.

●

Prints at 600 dots per inch (dpi) and FastRes 1200 dpi.

●

Includes adjustable settings to optimize print quality.

Copy

●

Copies at 300 dots per inch (dpi).

Scan

●

Provides 600 pixels per inch (ppi) full-color scanning.

Fax

●

Full-functionality fax capabilities with a V.34 fax; includes a phone book and delayed-fax
features.

Memory

●

Includes 32-megabyte (MB) random-access memory (RAM).

Paper handling

●

Priority input tray holds up to 10 pages.

●

Tray 1 holds up to 250 sheets of print media or 10 envelopes.

●

Output bin holds up to 100 sheets of print media.

Printer driver features

●

FastRes 1200 produces 1200-dots-per-inch (dpi) print quality for fast, high-quality printing
of business text and graphics.

Interface connections

●

Hi-Speed USB 2.0 port.

●

RJ-11 fax/phone cable ports.

●

Provides N-up printing (printing more than one page on a sheet).

●

Provides an EconoMode setting, which uses less toner.

Supplies

●

The product ships with a 1,000-page (average yield) starter cartridge. The average yield
for replacement cartridges is 2,000 pages.

Accessibility

●

Online user guide that is compatible with text screen-readers.

●

Print cartridges can be installed and removed by using one hand.

●

All doors and covers can be opened by using one hand.

Print

Economical printing
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Product walkaround
Front view
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Tray 1

2

Priority input tray

3

Output bin

4

Automatic document feeder (ADF) output bin

5

Automatic document feeder (ADF) input tray

6

ADF media lever

7

Control panel

8

Telephone handset

9

Print-cartridge door latch

Back view
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Interface ports
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Kensington lock
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Power switch

13

Power connector
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Interface ports
The product has a Hi-Speed USB 2.0 port, fax and phone ports, and a handset port.

1
2
3

1

Handset port

2

Hi-Speed USB 2.0 port

3

Fax ports

Serial number and model number location
The serial number and product model number label is at the back of the product.
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Supported operating systems
The product supports the following operating systems:
Full software installation

Print and scan drivers only

●

Windows XP (32-bit)

●

Windows XP (64-bit)

●

Windows Vista (32-bit)

●

Windows Vista (64-bit)

●

Mac OS X v10.3, v10.4, and later

●

Windows 2000

●

Windows 2003 Server (32-bit and 64-bit)

NOTE: For Mac OS X v10.4 and later, PPC and Intel Core Processor Macs are supported.

Supported product software
Software included with the product
There are several options for completing a recommended install. Easy installation will complete the
installation with default settings. Advanced installation allows you to review the license agreements and
the default settings.

Easy installation for Windows
●

●

●

HP drivers
◦

Printer driver

◦

Scan driver

◦

Fax driver

HP MFP software
◦

HP LaserJet Scan program

◦

PC Fax Send program

◦

HP Toolbox program

◦

Uninstall program

Other programs
◦

Readiris OCR (not installed with other software; separate installation is required)

Advanced installation
Advanced installation includes all of the features that are available with the easy installation. The
HP Customer Participation program is optional.

6
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Macintosh software
●

HP Product Setup Assistant

●

HP Uninstaller

●

HP LaserJet software
◦

HP Scan

◦

HP Director

◦

Scan to e-mail program

Supported printer drivers
The product comes with software for Windows and Macintosh that allows the computer to communicate
with the product. This software is called a printer driver. Printer drivers provide access to product
features, such as printing on custom-sized paper, resizing documents, and inserting watermarks.
NOTE: The most recent drivers are available at www.hp.com/support/ljm1319. Depending on the
configuration of Windows-based computers, the installation program for the product software
automatically checks the computer for Internet access in order to obtain the latest drivers.
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Control panel
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Control-panel walkaround

●

Control-panel menus
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Control-panel walkaround

1

10

2

3

4

1

Fax controls. Use the fax controls to change commonly used fax settings.

2

Alphanumeric buttons. Use the alphanumeric buttons to type data into the product control-panel display and dial
telephone numbers for faxing.

3

Setup and cancel controls. Use these controls to select menu options, determine the product status, and cancel the
current job.

4

Copy controls. Use these controls to change commonly used default settings and to start copying.

Chapter 2 Control panel
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Control-panel menus
Use the control-panel menus
To gain access to the control-panel menus, use the following steps.
1.

Press Setup.

2.

Use the arrow buttons to navigate the listings.

●

Press OK to select the appropriate option.

●

Press Cancel to cancel an action or return to the Ready state.

Control-panel main menus
These menus are available from the control-panel main menu:
●

Use the Fax Job status menu to display a list of all faxes that are waiting to be sent, or have been
received but are waiting to be printed, forwarded, or uploaded to the computer.

●

Use the Fax functions menu to configure fax functions such as scheduling a delayed fax,
cancelling the Receive to PC mode, reprinting faxes that were previously printed, or printing faxes
that are stored in memory.

●

Use the Copy setup menu to configure basic copy default settings such as contrast, collation, or
the number of copies printed.

●

Use the Reports menu to print reports that provide information about the product.

●

Use the Fax setup menu to configure the fax phone book, the outgoing and incoming fax options,
and the basic settings for all faxes.

●

Use the System setup menu to establish basic product settings such as language, print quality,
or volume levels.

●

Use the Service menu to restore default settings, clean the product, and activate special modes
that affect print output.

NOTE: To print a detailed list of the entire control-panel menu and its structure, print a menu map.
See Information pages on page 122.
Table 2-1 Fax Job status menu
Menu item

Description

Fax Job status

Displays pending fax jobs, and allows you to cancel pending fax jobs.

Table 2-2 Fax functions menu
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Menu item

Description

Send fax later

Allows a fax to be sent at a later time and date.

Stop Recv to PC

Disables the Receive to PC setting that allows a computer to upload all current faxes that have
not been printed and all future faxes received by the product.

Reprint last

Reprints the faxes that are stored in the product memory.

Control-panel menus
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Table 2-2 Fax functions menu (continued)
Menu item

Description

Polling receive

Allows the product to call another fax machine that has polling send enabled.

Clear saved faxs

Clears all faxes in the product memory.

Table 2-3 Copy setup menu
Menu item

Sub-menu item

Description

Default Quality

Text

Sets the default copy quality.

Draft
Mixed
Film photo
Picture
Def. Light/dark

Sets the default contrast option.

Def. # of copies

(Range: 1-99)

Sets the default number of copies.

Def. Reduce/Enlrg

Original=100%

Sets the default percentage to reduce or enlarge a copied
document.

A4->Ltr=94%
Ltr->A4=97%
Full Page=91%
2 pages/sheet
4 pages/sheet
Custom:25-400%
Restore defaults

Sets all customized copy settings to the factory default
values.

Table 2-4 Reports menu
Menu Item

Sub-menu item

Demo page

12
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Sub-menu item

Description
Prints a page that demonstrates print quality.
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Table 2-4 Reports menu (continued)
Menu Item

Sub-menu item

Sub-menu item

Description

Fax Reports

Fax Confirmation

Never

Sets whether or not the product prints a confirmation
report after a successful sending or receiving job.

Send fax only
Receive fax
Every fax
Fax Error report

Every error

Sets whether or not the product prints a report after a
failed sending or receiving job.

Send Error
Receive Error
Never
Last Call report
Include 1st page

Prints a detailed report of the last fax operation, either
sent or received.
On

Sets whether or not the product includes a thumbnail
image of the first page of the fax on the report.

Off
Fax Activity log

Print log now

Print log now: Prints a list of the last 50 faxes that have
been sent from or received by this product.

Auto Log Print
Auto Log Print: Select On to automatically print a report
after every fax job. Select Off to turn off the automatic
print feature.
PhoneBook report

Prints a list of the speed dials that have been set up for
this product.

Block Fax list

Prints a list of phone numbers that are blocked from
sending faxes to this product.

All fax reports

Prints all fax-related reports.

Menu structure

Prints a control-panel menu layout map. The active
settings for each menu are listed.

Config report

Prints a list of all the product settings.

Table 2-5 Fax setup menu
Menu Item

Sub-menu item

Fax header

Your fax number

Sub-menu item

Description
Sets the identifying information that is sent to the receiving
product.

Company name
Phone Book

Individual setup

Add/Edit
Delete

Group setup

Edits the fax phone book speed dials and group-dial entries.
The product supports up to 120 phone book entries, which
can be either individual or group entries.

Add/Edit group
Delete group
Del. # in group

Delete all

ENWW
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Table 2-5 Fax setup menu (continued)
Menu Item

Sub-menu item

Sub-menu item

Description

Fax Send setup

Def. Resolution

Fine

Sets the resolution for sent documents. Higher resolution
images have more dots per inch (dpi), so they show more
detail. Lower resolution images have fewer dots per inch and
show less detail, but the file size is smaller.

Superfine
Photo
Standard
Def. light/dark
Dialing Mode

Changing the resolution setting might affect the fax speed.
Sets the darkness of outgoing faxes.

Tone

Sets whether the product should use tone or pulse dialing.

Pulse
Redial if busy

On

Sets whether or not the product should attempt to redial if
the line is busy.

Off
Redial-no answer

On

Sets whether the product should attempt to dial if the
recipient fax number does not answer.

Off
Redial Comm Err.

On

Sets whether the product should attempt to redial the
recipient fax number if a communication error occurs.

Off
Dial Prefix

On

Specifies a prefix number that must be dialed when sending
faxes from the product.

Off
Detect dial tone

On

Sets whether the product should check for a dial tone before
sending a fax.

Off

14

Chapter 2 Control panel

ENWW

Table 2-5 Fax setup menu (continued)
Menu Item

Sub-menu item

Sub-menu item

Description

Fax Recv. setup

Answer mode

Automatic

Sets the type of answer mode. The following options are
available:

Manual
●

Automatic: The product automatically answers an
incoming call on the configured number of rings.

●

Manual : The user must press the Start Fax button or
use an extension phone to make the product answer
the incoming call.

Rings to answer

(Range of 1-9)

Sets the number of rings that must occur before the fax
modem answers.

Answer Ring Type

All Rings
Single

Allows a user to have two or three phone numbers on a
single line, each with a different ring pattern (on a phone
system with distinctive-ring service).

Double

●

All Rings: The product answers any calls that come
through the telephone line.

●

Single: The product answers any calls that produce a
single-ring pattern.

●

Double: The product answers any calls that produce a
double-ring pattern.

●

Triple: The product answers any calls that produce a
triple-ring pattern.

●

Double&Triple: The product answers any calls that
produce a double-ring or triple-ring pattern.

Triple
Double&Triple

Extension Phone

On
Off

Silence Detect

On
Off

Fit to page

On
Off

Stamp faxes

On
Off

Forward fax

On

When this feature is enabled, the user can press the 1-2-3
buttons on the extension phone to cause the product to
answer an incoming fax call.
Sets whether the product can receive faxes from older
model fax machines that do not emit the initial fax tones used
during fax transmission.
Shrinks faxes that are larger than Letter-size or A4-size so
that they can fit onto a Letter-size or A4-size page. If this
feature is set to Off, faxes larger than Letter or A4 will print
on multiple pages.
Sets product to add the date, time, sender's phone number,
and page number to each page of the faxes that this product
receives.
Sets product to send all received faxes to another fax
machine.

Off

ENWW
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Table 2-5 Fax setup menu (continued)
Menu Item

Sub-menu item

Sub-menu item

Description

Block faxes

Add entry

Modifies the blocked fax list. The blocked fax list can contain
up to 30 numbers. When the product receives a call from
one of the blocked fax numbers, it deletes the incoming fax.
It also logs the blocked fax in the activity log along with jobaccounting information.

Delete entry
Clear all
Reprint faxes

On

Sets whether all received faxes stored in available memory
can be reprinted.

Off
Private receive

On
Off

All faxes

Error correction

On

Setting Private receive to On requires the user to have set
a password in product security. After the password is set,
the following options are set:
●

Private receive is turned on.

●

All old faxes are deleted from memory.

●

Fax forwarding or Receive to PC are set to On and
are not allowed to be set.

●

All incoming faxes are stored in memory.

Sets whether the product sends or receives the error portion
again when a fax transmission error occurs.

Off
Fax Speed

Fast(V.34)

Increases or decreases the allowed fax communication
speed.

Medium(V.17)
Slow(V.29)

Table 2-6 System setup menu
Menu Item

Sub-menu item

Language

(List of available
control-panel
display languages.)

Paper setup

Def. paper size

Sub-menu item

Description
Sets the language in which the control panel displays
messages and product reports.

Letter

Sets the size for printing internal reports or any print job that
does not specify a size.

A4
Legal
Def. paper type
Print Density

16

(Range of 1-5)
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Lists available
media types.

Sets the type for printing internal reports or any print job that
does not specify a type.
Sets how much toner the product should use to darken lines
and edges.
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Table 2-6 System setup menu (continued)
Menu Item

Sub-menu item

Sub-menu item

Description

Volume settings

Alarm volume

Soft

Sets the volume levels for the product.

Ring volume

Medium

Key-press volume

Loud

Phoneline volume

Off

Handset volume
Time/Date

(Settings for time
format, current time,
date format, and
current date.)

Sets the time and date setting for the product.

Table 2-7 Service menu
Menu item

Sub-menu item

Description

Restore defaults

Sets all customized settings to the factory default values.

Cleaning Mode

Cleans the product when specks or other marks appear on printed
output. The cleaning process removes dust and excess toner from
the paper path.
When selected, the product prompts you to load plain Letter or A4
paper in tray 1. Press OK to begin the cleaning process. Wait until
the process completes. Discard the page that prints.

USB speed

High

Sets the USB speed.

Full
Less paper curl

On

When printed pages are consistently curled, this option sets the
product to a mode that reduces curl.

Off
The default setting is Off.
Archive print

On
Off

When printing pages that will be stored for a long time, this option
sets the product to a mode that reduces toner smearing and
dusting.
The default setting is Off.

Print T.30 trace

Never

Prints or schedules a report that is used to troubleshoot fax
transmission issues.

Now
If error
At end of call
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Supported operating systems for Windows
The product supports the following Windows operating systems:
Full software installation

Print and scan drivers only

●

Windows XP (32-bit)

●

Windows XP (64-bit)

●

Windows Vista (32-bit)

●

Windows Vista (64-bit)

●

Windows 2000

●

Windows 2003 Server (32-bit and 64-bit)

Printer driver
Printer drivers provide access to product features, such as printing on custom-sized paper, resizing
documents, and inserting watermarks.
NOTE: The most recent drivers are available at www.hp.com/support/ljm1319. Depending on the
configuration of Windows-based computers, the installation program for the product software
automatically checks the computer for Internet access in order to obtain the latest drivers.

Priority for print settings
Changes to print settings are prioritized depending on where the changes are made:
NOTE: The names of commands and dialog boxes might vary depending on your software program.

20

●

Page Setup dialog box: Click Page Setup or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed here override settings changed
anywhere else.

●

Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed in the Print dialog box have a lower
priority and do not override changes made in the Page Setup dialog box.

●

Printer Properties dialog box (printer driver): Click Properties in the Print dialog box to open
the printer driver. Settings changed in the Printer Properties dialog box do not override settings
anywhere else in the printing software.

●

Default printer driver settings: The default printer driver settings determine the settings used in
all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties dialog
boxes.

Chapter 3 Software for Windows
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Open the printer driver and change the print settings
Operating System

To change the settings for all
print jobs until the software
program is closed

To change the default settings To change the device
for all print jobs
configuration settings

Windows 2000, XP,
Server 2003, and
Vista

1.

On the File menu in the
software program, click
Print.

1.

2.

Select the driver, and then
click Properties or
Preferences.

The steps can vary; this
procedure is most common.

Click Start, click Settings,
and then click Printers
(Windows 2000) or
Printers and Faxes
(Windows XP Professional
and Server 2003) or
Printers and Other
Hardware Devices
(Windows XP Home).

1.

For Windows Vista, click
Start, click Control Panel,
and then click Printer.
2.

ENWW

Right-click the driver icon,
and then select Printing
Preferences.

Click Start, click Settings,
and then click Printers
(Windows 2000) or
Printers and Faxes
(Windows XP Professional
and Server 2003) or
Printers and Other
Hardware Devices
(Windows XP Home).
For Windows Vista, click
Start, click Control Panel,
and then click Printer.

2.

Right-click the driver icon,
and then select
Properties.

3.

Click the Configure tab.

Open the printer driver and change the print settings
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Software installation types for Windows
The following software installation types are available:
●

Easy. Installs the full software solution.

●

Advanced. Use this option to select which software and drivers to install.

Remove software for Windows
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1.

Click Start, and then click All Programs.

2.

Click HP, and then click HP LaserJet M1319.

3.

Click Uninstall, and then follow the onscreen instructions to remove the software.

Chapter 3 Software for Windows
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Supported utilities for Windows
HP Toolbox software
HP Toolbox is a software program that you can use for the following tasks:
●

Check the product status.

●

Configure the product settings.

●

Configure pop-up-alert messages.

●

View troubleshooting information.

●

View online documentation.

Status Alerts software
The Status Alerts software provides information about the current status of the product.
The software also provides pop-up alerts when certain events occur, such as an empty tray or a problem
with the product. The alert includes information about solving the problem.

Other Windows components and utilities
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●

Software installer — automates the printing system installation

●

Online Web registration

Supported utilities for Windows
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Use the product with Macintosh

●

Software for Macintosh

●

Use features in the Macintosh printer driver

●

Scan from the product and HP Director (Macintosh)

●

Fax a document from a Macintosh computer

25

Software for Macintosh
Supported operating systems for Macintosh
The device supports the following Macintosh operating systems:
●

Mac OS X v10.3, v10.4 and later

NOTE: For Mac OS v10.4 and later, PPC and Intel Core Processor Macs are supported.

Supported printer drivers for Macintosh
The HP installer provides PostScript® Printer Description (PPD) files, Printer Dialog Extensions (PDEs),
and the HP Printer Utility for use with Macintosh computers.
The PPDs, in combination with the Apple PostScript printer drivers, provide access to device features.
Use the Apple PostScript printer driver that comes with the computer.

Priority for print settings for Macintosh
Changes to print settings are prioritized depending on where the changes are made:
NOTE: The names of commands and dialog boxes might vary depending on your software program.
●

Page Setup dialog box: Click Page Setup or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed here override settings changed
anywhere else.

●

Print dialog box: Click Print, Print Setup, or a similar command on the File menu of the program
you are working in to open this dialog box. Settings changed in the Print dialog box have a lower
priority and do not override changes made in the Page Setup dialog box.

●

Printer Properties dialog box (printer driver): Click Properties in the Print dialog box to open
the printer driver. Settings changed in the Printer Properties dialog box do not override settings
anywhere else in the printing software.

●

Default printer driver settings: The default printer driver settings determine the settings used in
all print jobs, unless settings are changed in the Page Setup, Print, or Printer Properties dialog
boxes.

●

Printer control panel settings: Settings changed at the printer control panel have a lower priority
than changes made anywhere else.

Change printer-driver settings for Macintosh
To change the settings for all print
jobs until the software program is
closed

To change the default settings for all
print jobs

To change the device configuration
settings

1.

On the File menu, click Print.

1.

On the File menu, click Print.

1.

In the Finder, on the Go menu, click
Applications.

2.

Change the settings that you want
on the various pop-up menus.

2.

Change the settings that you want
on the various pop-up menus.

2.

Open Utilities, and then open
Printer Setup Utility.

3.

Click on the print queue.

3.
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On the Presets pop-up menu, click
Save as and type a name for the
preset.
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To change the settings for all print
jobs until the software program is
closed

To change the default settings for all
print jobs

To change the device configuration
settings

These settings are saved in the
4.
Presets menu. To use the new settings,
you must select the saved preset option
every time you open a program and print. 5.

On the Printers menu, click Show
Info.
Click the Installable Options
menu.

NOTE: Configuration settings might
not be available in Classic mode.

Software installation types for Macintosh
Install Macintosh software for direct connections (USB)
1.

Connect a USB cable between the device USB port and the computer USB port. Use a standard
2-meter (6.56-foot) USB cable.

2.

Insert the device CD into the CD-ROM drive and run the installer. If the CD menu does not run
automatically, double-click the CD icon on the desktop.

3.

Double-click the Installer icon in the HP LaserJet Installer folder.

4.

Follow the instructions on the computer screen.
USB printer queues are created automatically when the product is attached to the computer.
However, the queue will use a generic PPD if the installer has not been run before the USB cable
is connected. Complete the following steps to change the queue PPD.

5.

On the computer hard drive, open Applications, open Utilities, and then open Printer Setup
Utility.

6.

Select the correct printer queue, and then click Show Info to open the Printer Info dialog box.

7.

In the pop-up menu, select Printer Model, and then, in the pop-up menu in which Generic is
selected, select the correct PPD for the device.

8.

Print a test page from any software program to make sure that the software is correctly installed.
If installation fails, reinstall the software. If this fails, see the installation notes or late-breaking
readme files on the device CD or the flyer that came in the box for help.

ENWW

Software for Macintosh
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Use features in the Macintosh printer driver
Print
Create and use printing presets in Macintosh
Use printing presets to save the current printer driver settings for reuse.
Create a printing preset
1.

On the File menu, click Print.

2.

Select the driver.

3.

Select the print settings.

4.

In the Presets box, click Save As..., and type a name for the preset.

5.

Click OK.

Use printing presets
1.

On the File menu, click Print.

2.

Select the driver.

3.

In the Presets box, select the printing preset that you want to use.

NOTE: To use printer-driver default settings, select Factory Default.

Resize documents or print on a custom paper size
You can scale a document to fit on a different size of paper.
1.

On the File menu, click Print.

2.

Open the Paper Handling menu.

3.

In the area for Destination Paper Size, select Scale to fit paper size, and then select the size
from the drop-down list.

4.

If you want to use only paper that is smaller than the document, select Scale down only.

Print a cover page
You can print a separate cover page for your document that includes a message (such as “Confidential”).
1.

On the File menu, click Print.

2.

Select the driver.

3.

Open the Cover Page pop-up menu, and then select whether to print the cover page Before
Document or After Document.

4.

In the Cover Page Type pop-up menu, select the message that you want to print on the cover
page.
NOTE: To print a blank cover page, select Standard as the Cover Page Type.
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Use watermarks
A watermark is a notice, such as “Confidential,” that is printed in the background of each page of a
document.
1.

On the File menu, click Print.

2.

Open the Watermarks menu.

3.

Next to Mode, select the type of watermark to use. Select Watermark to print a semi-transparent
message. Select Overlay to print a message that is not transparent.

4.

Next to Pages, select whether to print the watermark on all pages or on the first page only.

5.

Next to Text, select one of the standard messages, or select Custom and type a new message in
the box.

6.

Select options for the remaining settings.

Print multiple pages on one sheet of paper in Macintosh
You can print more than one page on a single sheet of paper. This feature provides a cost-effective way
to print draft pages.

1.

On the File menu, click Print.

2.

Select the driver.

3.

Open the Layout pop-up menu.

4.

Next to Pages per Sheet, select the number of pages that you want to print on each sheet (1, 2,
4, 6, 9, or 16).

5.

Next to Layout Direction, select the order and placement of the pages on the sheet.

6.

Next to Borders, select the type of border to print around each page on the sheet.

Print on both sides of the page (duplex printing)

ENWW

1.

On the Print dialog, select Manual Duplex.

2.

In the Manual Duplex area, select Print on Both Sides (Manually).

3.

Print the document.

Use features in the Macintosh printer driver
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4.

After one side has been printed, remove the remaining media from the input tray, and set it aside
until after you finish the duplexing job.

5.

Without changing the orientation, remove the printed stack from the output bin, and then straighten
the stack.

6.

Maintaining the same orientation, place the stack of media in the input tray again. The printed side
should be facing down.

7.

On the product control panel, press OK and wait for the second side to print.

Chapter 4 Use the product with Macintosh
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Scan from the product and HP Director (Macintosh)
For more information about tasks and settings described in this section, see the HP Director online Help.

Scanning tasks
To scan to a software program, scan an item using the program itself. Any TWAIN-compliant program
can scan an image. If the program is not TWAIN-compliant, save the scanned image to a file then place,
open, or import the file in the software program.
Use page-by-page scanning
1.

Load the original that is to be scanned face-down in the ADF.

2.

Double-click the HP Director desktop alias.

3.

Click the HP Director, and then click Scan to open the HP dialog box.

4.

Click Scan.

5.

To scan multiple pages, load the next page and click Scan. Repeat until all pages are scanned.

6.

Click Finish, and then click Destinations.

Scan to file
1.

In Destinations, choose Save To File(s).

2.

Name the file and specify the destination location.

3.

Click Save. The original is scanned and saved.

Scan to e-mail
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1.

In Destinations, choose E-mail.

2.

A blank e-mail opens with the scanned document as an attachment.

3.

Enter an e-mail recipient, add text, or other attachments, then click Send.

Scan from the product and HP Director (Macintosh)
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Fax a document from a Macintosh computer
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1.

In the software program, on the File menu, select Print.

2.

Click PDF, and then select Fax PDF.

3.

Enter a fax number in the To field.

4.

To include a fax cover page, select Use Cover Page, and then enter the cover page subject and
message (optional).

5.

Click Fax.

Chapter 4 Use the product with Macintosh
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Connectivity

●
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Connect the product directly to a computer with USB
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Connect the product directly to a computer with USB
NOTE: Do not connect the USB cable from the product to the computer until the installer prompts you
to do so.
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1.

Insert the product CD into your computer. If the software installer does not start, navigate to the
setup.exe file on the CD and double-click the file.

2.

Follow the installer instructions.

3.

Allow the installation process to complete, and then restart the computer.
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Paper and print media

●

Understand paper and print media use

●

Supported paper and print media sizes

●

Special paper or print media guidelines

●

Load paper and print media

●

Configure trays
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Understand paper and print media use
This product supports a variety of paper and other print media in accordance with the guidelines in this
user guide. Paper or print media that does not meet these guidelines might cause the following problems:
●

Poor print quality

●

Increased jams

●

Premature wear on the product, requiring repair

For best results, use only HP-brand paper and print media designed for laser printers. Do not use paper
or print media made for inkjet printers. Hewlett-Packard Company cannot recommend the use of other
brands of media because HP cannot control their quality.
It is possible for paper to meet all of the guidelines in this user guide and still not produce satisfactory
results. This might be the result of improper handling, unacceptable temperature and/or humidity levels,
or other variables over which Hewlett-Packard has no control.
CAUTION: Using paper or print media that does not meet Hewlett-Packard's specifications might
cause problems for the product, requiring repair. This repair is not covered by the Hewlett-Packard
warranty or service agreements.
CAUTION: To prevent damage to the product, do not use an original that contains correction tape,
correction fluid, paper clips, or staples. Also, do not load photographs, small originals, or fragile originals
into the ADF.
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Supported paper and print media sizes
This product supports a number of paper sizes, and it adapts to various media.
NOTE: To obtain best print results, select the appropriate paper size and type in the print driver before
printing.
Table 6-1 Supported paper and print media sizes

1

Size

Dimensions

Letter

216 x 279 mm (8.5 x 11 inches)

Legal

216 x 356 mm (8.5 x 14 inches)

A4

210 x 297 mm (8.27 x 11.69 inches)

Executive

184 x 267 mm (7.24 x 10.51 inches)

A3

297 x 420 mm (11.69 x 16.54 inches)

A5

148 x 210 mm (5.83 x 8.27 inches)

A6

105 x 148 mm (4.13 x 5.83 inches)

B5 (JIS)

182 x 257 mm (7.17 x 10.12 inches)

16k

197 x 273 mm (7.75 x 10.75 inches)

16k

195 x 270 mm (7.7 x 10.6 inches)

16k

184 x 260 mm (7.25 x 10.25 inches)

8.5 x 13

216 x 330 mm (8.5 x 13 inches)

4 x 61

107 x 152 mm (4 x 6 inches)

5 x 81

127 x 203 mm (5 x 8 inches)

10 x 15 cm1

100 x 150 mm (3.9 x 5.9 inches)

Custom

Priority input tray: Minimum—76 x127 mm (3 x
5 inches); Maximum—216 x 356 mm (8.5 x
14 inches)

Priority input tray

Tray 1

Priority input tray

Tray 1

These sizes are supported as custom sizes.

Table 6-2 Supported envelopes and postcards
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Size

Dimensions

Envelope #10

105 x 241 mm (4.13 x 9.49 inches)

Envelope DL

110 x 220 mm (4.33 x 8.66 inches)

Supported paper and print media sizes
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Table 6-2 Supported envelopes and postcards (continued)
Size

Dimensions

Priority input tray

Envelope C5

162 x 229 mm (6.93 x 9.84 inches)

Envelope B5

176 x 250 mm (6.7 x 9.8 inches)

Envelope Monarch

98 x 191 mm (3.9 x 7.5 inches)

Postcard

100 x 148 mm (3.94 x 5.83 inches)

Double postcard

148 x 200 mm (5.83 x 7.87 inches)

Tray 1

Special paper or print media guidelines
This product supports printing on special media. Use the following guidelines to obtain satisfactory
results. When using special paper or print media, be sure to set the type and size in your print driver to
obtain the best print results.
CAUTION: HP LaserJet printers use fusers to bond dry toner particles to the paper in very precise
dots. HP laser paper is designed to withstand this extreme heat. Using inkjet paper not designed for this
technology could damage your printer.
Media type

Do

Envelopes

●

Store envelopes flat.

●

Use envelopes where the seam
extends all the way to the corner of
the envelope.
●

●

Labels

Transparencies

Letterhead or preprinted forms
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Do not

Use peel-off adhesive strips that
are approved for use in laser
printers.

●

Do not use envelopes that are
wrinkled, nicked, stuck together, or
otherwise damaged.
Do not use envelopes that have
clasps, snaps, windows, or coated
linings.

●

Do not use self-stick adhesives or
other synthetic materials.

●

Use only labels that have no
exposed backing between them.

●

Do not use labels that have wrinkles
or bubbles, or are damaged.

●

Use Labels that lie flat.

●

Do not print partial sheets of labels.

●

Use only full sheets of labels.

●

Use only transparencies that are
approved for use in laser printers.

●

Do not use transparent print media
not approved for laser printers.

●

Place transparencies on a flat
surface after removing them from
the product.

●

Use only letterhead or forms
approved for use in laser printers.

●

Do not use raised or metallic
letterhead.

ENWW

Media type

Do

Do not

Heavy paper

●

Use only heavy paper that is
●
approved for use in laser printers
and meets the weight specifications
for this product.

Do not use paper that is heavier
than the recommended media
specification for this product unless
it is HP paper that has been
approved for use in this product.

Glossy or coated paper

●

Use only glossy or coated paper
that is approved for use in laser
printers.

●

Do not use glossy or coated paper
designed for use in inkjet products.

Load paper and print media
Priority input tray
The priority input tray is accessed from the front of the product. The product prints from the priority input
tray before attempting to print from tray 1.

The priority input tray holds up to 10 sheets of 75 g/m2 (20 lb) media or one envelope, one transparency,
or one card. You can use the priority input tray to print the first page on media different from the remainder
of the document.
Media guides ensure that the media is correctly fed into the product and that the print is not skewed
(crooked on the media). When loading media, adjust the media guides to match the width of the media
that you are using.

Tray 1
Tray 1 holds up to 250 pages of 75 g/m2 (20 lb) paper, or fewer pages of heavier media (25 mm (0.9 in)
or less stack height). Load media with the top forward and the side to be printed on facing down.
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Load paper and print media
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Media guides ensure that the media feeds correctly into the product and that the print is not skewed.
Tray 1 has side and rear media guides. When loading media, adjust the media guides to match the
length and width of the media that you are using.

NOTE: When you add new media, make sure that you remove all of the media from the input tray and
straighten the stack of new media. Do not fan the media. This reduces jams by preventing multiple
sheets of media from feeding through the product at one time.
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Configure trays
To set the default paper size or type from the control panel, complete the following steps.
Configure trays for copy jobs
1.

On the product control panel, press Setup.

2.

Use the arrow buttons to select System setup, and then press OK.

3.

Use the arrow keys to select Paper setup, and then press OK.

4.

Use the arrow keys to select either Def. paper size or Def. paper type, and then press OK.

5.

Use the arrow keys to select a default type or size for the tray, and then press OK.

NOTE: To configure the product trays for print jobs, use the printer driver.
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Configure trays
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7

Print tasks

This section provides information about common printing tasks.

ENWW

●

Change the print driver to match the media type and size

●

Get help for any print option

●

Cancel a print job

●

Change the default settings

●

Create booklets

●

Change print-quality settings

●

Change print density

●

Print on special media

●

Use different paper and print covers

●

Print a blank first page

●

Resize documents

●

Select a paper size

●

Select a paper source

●

Select a paper type

●

Set the print orientation

●

Use watermarks

●

Save toner

●

Print on both sides of the paper (duplex printing)

●

Print multiple pages on one sheet of paper in Windows

●

Economy settings
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Change the print driver to match the media type and size
Selecting media by type and size results in significantly better print quality for heavy paper, glossy paper,
and overhead transparencies. Using the wrong setting can result in unsatisfactory print quality. Always
print by Type for special print media, such as labels or transparencies. Always print by Size for
envelopes.
1.

On the File menu in the software program, click Print.

2.

Select the driver, and then click Properties or Preferences.

3.

Click the Paper/Quality tab.

4.

In the Paper Type or Paper Size list box, select the correct media type or size.

5.

Click OK.

Supported paper types and tray capacity
This product has the following tray priority for feeding print media:
1.

Priority input tray

2.

Tray 1

Minimum media dimensions are 76 x 127 mm (3 x 5 in).
Maximum media dimensions are 216 x 356 mm (8.5 x 14 in).
To obtain the best print results, change the paper size and paper type settings in the printer driver before
printing.
Type is

Media specifications

Priority input tray

Tray 1 capacity2

Plain

75 g/m2 (20 lb) to 104 g/m2 (27 lb)

Up to 10 sheets

Up to 250 sheets

Light

60 g/m2 (16 lb) to 75 g/m2 (20 lb)

Up to 10 sheets

Up to 260 sheets

Envelopes

Less than 90 g/m2 (24 lb)

1 envelope

Up to 10 envelopes.

Labels

Standard

1 sheet

Not supported.

Bond

75 g/m2 (20 lb) to 104 g/m2 (27 lb)

1 sheet

Up to 250 sheets

Rough

75 g/m2 (20 lb) to 104 g/m2 (27 lb)

1 sheet

Up to 200 sheets

Transparencies

4 mm (0.1 inches) Monochrome
Overhead

1 sheet

Up to 200 sheets.

Heavy

110 g/m2 (29 lb) to 125 g/m2
(33 lb)

Up to 10 sheets

Not supported.

Color
Preprinted
Prepunched
Recycled
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Type is

Media specifications

Priority input tray

Tray 1 capacity2

Letterhead

75 g/m2 (20 lb) to 104 g/m2 (27
lb)

Up to 10 sheets

Up to 250 sheets

The maximum stack height for tray 1 is 25 mm (1 inch).

2

Get help for any print option
Printer-driver Help is separate from program Help. The printer-driver help provides explanations for the
buttons, check boxes, and drop-down lists that are in the printer driver. It also includes instructions for
performing common printing tasks, such as printing on both sides, printing multiple pages on one sheet,
and printing the first page or covers on different paper.
Activate the printer-driver Help screens in one of the following ways:

ENWW

Windows

Macintosh

●

In the printer driver Properties dialog box, click the
Help button.

In the Print dialog box, click the ? button.

●

Press the F1 key on the computer keyboard.

●

Click the question-mark symbol in the upper-right corner
of the printer driver.

●

Right-click on any item in the driver, and then click What's
This?.

Get help for any print option
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Cancel a print job
If the print job is currently printing, cancel it by pressing Cancel on the product control panel.
NOTE: Pressing Cancel clears the job that the product is currently processing. If more than one
process is running, pressing Cancel clears the process that currently appears on the product control
panel.
You can also cancel a print job from a software program or a print queue.
To stop the print job immediately, remove the remaining print media from the product. After printing
stops, use one of the following options:
●

Device control panel: To cancel the print job, press and release Cancel on the product control
panel.

●

Software program: Typically, a dialog box appears briefly on the computer screen, allowing you
to cancel the print job.

●

Windows print queue: If a print job is waiting in a print queue (computer memory) or print spooler,
delete the job there.

●

46

◦

Windows 2000: Go to the Printer dialog box. Click Start, click Settings, and then click
Printers. Double-click the product icon to open the window, select the print job, and then click
Delete.

◦

Windows XP or Server 2003: Click Start, click Settings, and then click Printers and
Faxes. Double-click the product icon to open the window, right-click the print job that you want
to cancel, and then click Cancel.

◦

Windows Vista: Click Start, click Control Panel, and then, under Hardware and Sound,
click Printer. Double-click the product icon to open the window, right-click the print job that
you want to cancel, and then click Cancel.

Macintosh print queue: Open the print queue by double-clicking the product icon in the dock.
Highlight the print job, and then click Delete.
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Change the default settings
1.

Click Start, click Settings, and then click Printers (Windows 2000) or Printers and Faxes
(Windows XP Professional and Server 2003) or Printers and Other Hardware Devices (Windows
XP Home).
For Windows Vista, click Start, click Control Panel, and then click Printer.
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2.

Right-click the driver icon, and then select Properties.

3.

Click the Configure tab.

4.

Change the settings, and then click OK.

Change the default settings
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Create booklets
You can copy two pages on one sheet of paper so you can fold the pages in the center to form a booklet.
The device arranges the pages in the correct order. For example, if the original document has eight
pages, the device prints pages 1 and 8 on the same sheet.
1.

On the File menu in the software program, click Print.

2.

Select the driver, and then click Properties or Preferences.

3.

Click the Finishing tab.

4.

Select Print On Both Sides.

5.

In the drop-down box for Booklet Layout, select either Left Edge Binding or Right Edge
Binding. The Pages per Sheet setting automatically changes to 2 pages per sheet.

6.

Click OK.

Change print-quality settings
1.

On the File menu in the software program, click Print.

2.

On the Paper/Quality tab, select the resolution or print-quality settings that you want from the Print
Quality drop-down menu.

3.

Click OK.

Change print density
Increasing the print density darkens the print on the page.
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1.

On the File menu in the software program, click Print.

2.

Select the driver, and then click Properties or Preferences.

3.

Click the Device Settings tab.

4.

Use the Print Density slider to change the setting.

5.

Click OK.
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Print on special media
Make sure that the paper or print media that you are using meets HP specifications. Generally, smoother
paper provides better results.
1.

Open the media input tray and remove any media.

2.

Load the media. Make sure that the top of the media is forward and the side to be printed on is
facing up.

3.

Adjust the media guides to the length and width of the media.

4.

On the printer driver, on the Paper tab or the Paper/Quality tab, select the media type from the
Paper Type drop-down list.
CAUTION: Be sure to set the correct media type in the product settings. The product adjusts the
fuser temperature according to the media type setting. When printing on special media such as
transparencies or labels, this adjustment prevents the fuser from damaging the media as it passes
through the product.

5.

ENWW

Print the document.

Print on special media
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Use different paper and print covers
1.

On the File menu in the software program, click Print.

2.

Select the driver, and then click Properties or Preferences.

3.

On the Paper/Quality tab, select the appropriate paper.

4.

Click Use different paper.

5.

Select the pages that you want to use to print specific pages on different paper.

6.

To print front or back covers, select Add Blank or Preprinted Cover.

7.

Click OK.

NOTE: The paper size must be the same for all pages of the print job.

Print a blank first page
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1.

On the File menu in the software program, click Print.

2.

Select the driver, and then click Properties or Preferences.

3.

On the Paper/Quality tab, click Use different paper.

4.

In the list box, click Front or Back Cover.

5.

Click Add Blank or Preprinted Cover.

6.

Click OK.
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Resize documents
Use the document resizing options to scale a document to a percentage of its normal size. You can also
choose to print a document on a different size paper, with or without scaling.
Reduce or enlarge a document
1.

On the File menu in the software program, click Print.

2.

Select the driver, and then click Properties or Preferences.

3.

On the Effects tab, select % of normal size, and then type the percentage by which you want to
reduce or enlarge the document.
You can also use the scroll bar to adjust the percentage.

4.

Click OK.

Print a document onto a different paper size
1.

On the File menu in the software program, click Print.

2.

Select the driver, and then click Properties or Preferences.

3.

On the Effects tab, click Print Document On.

4.

Select the paper size to print on.

5.

To print the document without scaling it to fit, make sure that the Scale to Fit option is not selected.

6.

Click OK.

Select a paper size
1.

On the File menu in the software program, click Print.

2.

Select the driver, and then click Properties or Preferences.

3.

On the Paper/Quality tab, select the size from the Size is drop-down list.

4.

Click OK.

Select a paper source
1.

On the File menu in the software program, click Print.

2.

Select the driver, and then click Properties or Preferences.

3.

On the Paper/Quality tab, select the source from the Source is drop-down list.

4.

Click OK.

Select a paper type
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1.

On the File menu in the software program, click Print.

2.

Select the driver, and then click Properties or Preferences.
Resize documents
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3.

On the Paper/Quality tab, select the type from the Type is drop-down list.

4.

Click OK.

Set the print orientation
1.

On the File menu in the software program, click Print.

2.

Select the driver, and then click Properties or Preferences.

3.

On the Finishing tab, select either Portrait or Landscape in the Orientation section.

4.

Click OK.

Use watermarks
A watermark is a notice, such as "Confidential," that is printed in the background of each page of a
document.
1.

On the File menu in the software program, click Print.

2.

Select the driver, and then click Properties or Preferences.

3.

From the Effects tab, click the Watermarks drop-down list.

4.

Click the watermark that you want to use.

5.

If you want the watermark to appear only on the first page of the document, click First Page
Only.

6.

Click OK.

To remove the watermark, click (none) in the Watermarks drop-down list.

Save toner
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1.

On the File menu in the software program, click Print.

2.

Select the driver, and then click Properties or Preferences.

3.

On the Paper/Quality tab, click EconoMode.

4.

Click OK.
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Print on both sides of the paper (duplex printing)
NOTE: The printer driver also contains instructions and graphics for manually duplexing.
1.

In the software program, open the properties (printer driver).

2.

On the Finishing tab, select Print on Both Sides (Manually).
NOTE: If the Print on Both Sides option is dimmed or unavailable, open the properties (printer
driver). On the Device Settings tab or the Configure tab, select Allow Manual Duplexing, and
then click OK. Repeat steps 1 and 2.

ENWW

3.

Print the document.

4.

After one side has been printed, remove the remaining media from the input tray, and set it aside
until after you finish the duplexing job.

5.

Without changing the orientation, remove the printed stack from the output bin, and then straighten
the stack.

Print on both sides of the paper (duplex printing)
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6.

Maintaining the same orientation, place the stack of media in the input tray again. The printed side
should be facing down.

7.

On the product control panel, press OK and wait for the second side to print.
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Print multiple pages on one sheet of paper in Windows
You can print more than one page on a single sheet of paper.

1.

On the File menu in the software program, click Print.

2.

Select the driver, and then click Properties or Preferences.

3.

Click the Finishing tab.

4.

In the Document Options drop-down list, select the number of pages that you want to print on
each sheet (1, 2, 4, 6, 9, or 16).

5.

If the number of pages is greater than 1, select the correct options for Print page borders and
Page order.
●

6.
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If you need to change the page orientation, click Portrait or Landscape.

Click OK. The product is now set to print the number of pages per sheet that you have selected.

Print multiple pages on one sheet of paper in Windows
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Economy settings
EconoMode
The EconoMode setting in the product printer driver conserves toner.

Archive print
Archive print produces output that is less susceptible to toner smearing and dusting. Use archive print
to create documents that you want to preserve or archive.
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1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Service, and then press OK.

3.

Use the arrow buttons to select Archive print, select On or Off, and then press OK.
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Copy

●

Load originals

●

Use copy

●

Copy settings

●

Duplex (two-sided) copy jobs
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Load originals
NOTE: The ADF capacity is up to 30 sheets of 80 g/m2 or 20 lb media.
CAUTION: To prevent damage to the product, do not use an original that contains correction tape,
correction fluid, paper clips, or staples. Also, do not load photographs, small originals, or fragile originals
into the ADF.
1.

Insert the top-end of the stack of originals into the ADF input tray, with the media stack face-down
and the first page to be copied at the bottom of the stack.

2.

Make sure that the ADF media lever is set correctly for single-page or multiple-page documents.

3.

Slide the stack into the ADF until it does not move any farther.

Document loaded appears on the control-panel display.
4.
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Adjust the media guides until they are snug against the media.
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Use copy
One-touch copy
1.

Load the document into the ADF input tray.

2.

Press Start Copy on the product control panel to start copying.

3.

Repeat the process for each copy.

Multiple copies
Change the number of copies for the current job
1.

On the product control panel, use the alphanumeric buttons to set the number of copies (between
1 and 99) that you want to make for the current job.

2.

Press Start Copy to begin copying your job.
NOTE: The change in the setting remains active for about 2 minutes after the copy job has been
completed. During this time, Custom settings appears on the product control-panel display.

Change the default number of copies
1.

On the product control panel, press Setup.

2.

Use the arrow buttons to select Copy setup, and then press OK.

3.

Use the arrow buttons to select Def. # of copies, and then press OK.

4.

Use the arrow buttons to set the number of copies (between 1 and 99) that you want as the default.

5.

Press OK to save your selection.

Cancel a copy job
To cancel a copy job, press Cancel on the product control panel. If more than one process is running,
pressing Cancel clears the process that currently appears on the product control-panel display.

Reduce or enlarge copies
Reduce or enlarge copies for the current job
1.

On the product control panel, press Reduce/Enlarge.

2.

Select the size to which you would like to reduce or enlarge the copies in this job.
NOTE: If you select Custom: 25-400%, use the arrow keys to set a percentage.
If you select 2 pages/sheet or 4 pages/sheet, select the orientation (portrait or landscape).

3.
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Press Start Copy to save the selection and immediately start the copy job, or press OK to save the
selection without starting the job.

Use copy
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NOTE: The change in the setting remains active for about 2 minutes after the copy job has been
completed. During this time, Custom settings appears on the product control-panel display.
You must change the default media size in the media input tray to match the output size, or part of your
copy might be cut off.
Adjust the default copy size
NOTE: The default copy size is the size to which copies are normally reduced or enlarged. If you keep
the factory default size setting of Original=100%, all copies will be the same size as the original
document.
1.

Press Setup.

2.

Use the arrow buttons to select Copy setup, and then press OK.

3.

Use the arrow buttons to select Def. Redu/Enlrg, and then press OK.

4.

Use the arrow buttons to select the option for how you normally want to reduce or enlarge copies.
NOTE: If you select Custom: 25-400%, use the arrow keys to set the percentage of the original
size that you normally want for copies.
If you select 2 pages/sheet or 4 pages/sheet, select the orientation (portrait or landscape).

5.

Press OK to save the selection.

The product can reduce copies to as little as 25% of the original size or enlarge copies to as much as
400% of the original size.
Reduction/enlargement settings
●

Original=100%

●

A4 > Ltr=94%

●

Ltr > A4=97%

●

Full Page=91%

●

2 pages/sheet

●

4 pages/sheet

●

Custom: 25-400%

NOTE: When using the 2 pages/sheet or 4 pages/sheet setting, select the page orientation (portrait
or landscape).

Copy settings
Copy quality
Five copy-quality settings are available: Text, Draft, Mixed, Film photo, and Picture.
The factory-set default for copy quality is Text. This setting is the best for items that contain mostly text.

60

Chapter 8 Copy

ENWW

When making a copy of a photo or graphic, you can select the Film photo setting for photos or the
Picture setting for other graphics to increase the quality of your copy. Select the Mixed setting for
documents that include both text and graphics.
Adjust the copy quality for the current job
1.

On the product control panel, press More Copy Settings twice to see the current quality setting for
the copy.

2.

Use the arrow buttons to scroll through the quality setting options.

3.

Select a setting, and then press Start Copy to save the selection and immediately start the copy
job, or press OK to save the selection without starting the job.
NOTE: The change in the setting remains active for about 2 minutes after the copy job has been
completed. During this time, Custom settings appears on the product control-panel display.

Adjust the default copy quality
1.

On the product control panel, press Setup.

2.

Use the arrow buttons to select Copy setup, and then press OK.

3.

Use the arrow buttons to select Default quality, and then press OK.

4.

Use the arrow buttons to select the copy quality, and then press OK to save the selection.

Adjust the lighter/darker (contrast) setting
The lighter/darker setting affects the lightness or darkness (contrast) of the copy. Use the following
procedure to change the contrast for the current copy job only.
Adjust the lighter/darker setting for the current job
1.

On the product control panel, press Lighter/Darker to see the current contrast setting.

2.

Use the arrow buttons to adjust the setting. Move the slider to the left to make the copy lighter than
the original, or move the slider to the right to make the copy darker than the original.

3.

Press Start Copy to save the selection and immediately start the copy job, or press OK to save the
selection without starting the job.
NOTE: The change in the setting remains active for about 2 minutes after the copy job has been
completed. During this time, Custom settings appears on the product control-panel display.

Adjust the default lighter/darker setting
NOTE: The default lighter/darker setting affects all copy jobs.
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1.

On the product control panel, press Setup.

2.

Use the arrow buttons button to select Copy setup, and then press OK.

3.

Use the arrow buttons button to select Def. Light/dark, and then press OK.

Copy settings
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4.

Use the arrow buttons button to adjust the setting. Move the slider to the left to make all of the
copies lighter than the original, or move the slider to the right to make all of the copies darker than
the original.

5.

Press OK to save the selection.

Change copy job print density
Increasing the print density at the product control panel darkens the print on the page.
1.

On the control panel, press Setup.

2.

Use the arrow buttons to select System setup, and then press OK.

3.

Use the arrow buttons to select Paper setup, and then press OK.

4.

Use the arrow buttons to select Print Density, and then press OK.

5.

Use the arrow buttons to increase or decrease the density setting, and then press OK.

Define custom copy settings
When you change the copy settings at the control panel, Custom settings appears on the control-panel
display. The custom settings remain in effect for approximately 2 minutes, and then the product returns
to the default settings. To immediately return to the default settings, press Cancel.

Print or copy edge-to-edge
The product cannot print fully edge-to-edge. The maximum printing area is 203.2 x 347 mm (8 x 13.7 in),
leaving a 4 mm unprintable border around the page.

Copy onto media of different types and sizes
The product is set to copy on either letter- or A4-size paper, depending on the country/region in which
it was purchased. You can change the size and type of media that you copy to for the current copy job
or for all copy jobs.
Media-size settings
●

Letter

●

Legal

●

A4

Media-type settings
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●

Plain

●

Preprinted

●

Letterhead

●

Transparency

●

Prepunched

●

Labels
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●

Bond

●

Recycled

●

Color

●

Light

●

Heavy

●

Cardstock

●

Envelope #10

●

Rough

Change the default media-size setting
1.

On the product control panel, press Setup.

2.

Use the arrow buttons to select System setup, and then press OK.

3.

Use the arrow buttons to select Paper setup, and then press OK.

4.

Use the arrow buttons to select Def. paper size, and then press OK.

5.

Use the arrow buttons to select a media size, and then press OK.

6.

Press OK to save the selection.

Change the default media-type setting
1.

On the product control panel, press Setup.

2.

Use the arrow buttons to select System setup, and then press OK.

3.

Use the arrow buttons to select Paper setup, and then press OK.

4.

Use the arrow buttons to select Def. paper type, and then press OK.

5.

Use the arrow buttons to select a media type, and then press OK.

6.

Press OK to save the selection.

Restore the copy-settings defaults
Use the control panel to restore the copy settings to the factory-set default values.
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1.

On the product control panel, press Setup.

2.

Use the arrow buttons to select Copy setup, and then press OK.

3.

Use the arrow buttons to select Restore defaults, and then press OK.

Copy settings
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Duplex (two-sided) copy jobs
Copy a two-sided original to a one-sided document
Copies resulting from these procedures are printed on one side, and need to be hand-collated.
1.

Load the first page of the document to be copied face-down into the ADF.

2.

Press Start Copy.

3.

Flip the original, and then reload it into the ADF.

4.

Press Start Copy.

5.

Repeat steps 1 through 4 for each page until all of the original document pages have been copied.

Copying a two-sided original to a two-sided document
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1.

Load the first page of the document to be copied face-down into the ADF.

2.

Press Start Copy.

3.

Flip the original, and then reload it into the ADF.
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4.

Remove the copied page from the output bin and place it face down into the priority input tray.

5.

Press Start Copy.

6.

Remove the copied page from the output bin, and then set it aside for manual collating.

7.

Repeat steps 1 through 6, following the original document page order, until all pages of the original
are copied.

Duplex (two-sided) copy jobs
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●
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Load originals for scanning
NOTE: The ADF capacity is up to 30 sheets of 80 g/m2 or 20 lb media.
CAUTION: To prevent damage to the product, do not use an original that contains correction tape,
correction fluid, paper clips, or staples. Also, do not load photographs, small originals, or fragile originals
into the ADF.
1.

Insert the top-end of the stack of originals into the ADF input tray, with the media stack face-down
and the first page to be copied at the bottom of the stack.

2.

Make sure that the ADF media lever is set correctly for single-page or multiple-page documents.

3.

Slide the stack into the ADF until it does not move any farther.

Document loaded appears on the control-panel display.
4.

68

Adjust the media guides until they are snug against the media.
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Use scan
Scan methods
Scan jobs can be performed in the following ways.
●

Scan from the computer by using HP LaserJet Scan (Windows)

●

Scanning by using HP Director (Macintosh). See Scan from the product and HP Director
(Macintosh) on page 31.

●

Scan from TWAIN-compliant or Windows Imaging Application (WIA)-compliant software

NOTE: To learn about and use text-recognition software, install the Readiris program from the
software CD-ROM. Text-recognition software is also known as optical character recognition (OCR)
software.

Scan by using HP LaserJet Scan (Windows)
1.

In the HP program group, select Scan to to start HP LaserJet Scan.

2.

Select a scanning destination.

3.

Click Scan.
NOTE: OK should indicate the action that you want to accomplish.

Scan by using other software
The product is TWAIN-compliant and Windows Imaging Application (WIA)-compliant. The product works
with Windows-based programs that support TWAIN-compliant or WIA-compliant scanning devices and
with Macintosh-based programs that support TWAIN-compliant scanning devices.
While you are in a TWAIN-compliant or WIA-compliant program, you can gain access to the scanning
feature and scan an image directly into the open program. For more information, see the Help file or the
documentation that came with your TWAIN-compliant or WIA-compliant software program.
Scan from a TWAIN-compliant program
Generally, a software program is TWAIN-compliant if it has a command such as Acquire, File
Acquire, Scan, Import New Object, Insert from, or Scanner. If you are unsure whether the program
is compliant or you do not know what the command is called, see the software program Help or
documentation.
When scanning from a TWAIN-compliant program, the HP LaserJet Scan software program might start
automatically. If the HP LaserJet Scan program starts, you can make changes while previewing the
image. If the program does not start automatically, the image goes to the TWAIN-compliant program
immediately.
Start the scan from within the TWAIN-compliant program. See the software program Help or
documentation for information about the commands and steps to use.
Scan from a WIA-compliant program (Windows XP and Vista only)
WIA is another way to scan an image directly into a software program, such as Microsoft Word. WIA
uses Microsoft software to scan, instead of HP LaserJet Scan software.
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Generally, a software program is WIA-compliant if it has a command such as Picture/From Scanner
or Camera in the Insert or File menu. If you are unsure whether the program is WIA-compliant, see the
software program Help or documentation.
Start the scan from within the WIA-compliant program. See the software program Help or documentation
for information about the commands and steps to use.
-OrIn the Cameras and Scanner folder, double-click the product icon. This opens the standard Microsoft
WIA Wizard, which enables you to scan to a file.

Scanning by using optical character recognition (OCR) software
You can use third-party OCR software to import scanned text into your preferred word-processing
program for editing.
Readiris
The Readiris OCR program is included on a separate CD-ROM that shipped with the product. To use
the Readiris program, install it from the appropriate software CD-ROM, and then follow the instructions
in the online Help.

Canceling a scan job
To cancel a scan job, use one of the following procedures.
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●

On the product control panel, press Cancel.

●

Click the Cancel button in the onscreen dialog box.
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Scan settings
Scan file format
The default file format of a scanned document or photo depends on the scan type as well as the object
being scanned.
●

Scanning a document or a photo to a computer results in the file being saved as a .TIF file.

●

Scanning a document to email results in the file being saved as a .PDF file.

●

Scanning a photo to e-mail results in the file being saved as a .JPEG file.

NOTE: Different file types can be selected when using the scan software program.

Scanner resolution and color
If you are printing a scanned image, and the quality is not what you expected, you might have selected
a resolution or color setting in the scanner software that does not match your needs. Resolution and
color affect the following features of scanned images:
●

Image clarity

●

Texture of gradations (smooth or rough)

●

Scan time

●

File size

Scanning resolution is measured in pixels per inch (ppi).
NOTE: Scanning ppi levels are not interchangeable with printing dpi (dots per inch) levels.
Color, grayscale, and black and white define the number of colors possible. You can adjust the scanner
hardware resolution to up to 1200 ppi. The software can perform an enhanced resolution up to
19,200 ppi. You can set color and grayscale at 1 bit (black and white), or at 8 bit (256 levels of gray or
color) to 24 bit (true color).
The resolution and color guidelines table lists simple tips that you can follow to meet your scanning
needs.
NOTE: Setting the resolution and color to a high value can create large files that take up disk space
and slow the scanning process. Before setting the resolution and color, determine how you are going
to use the scanned image.
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Resolution and color guidelines
The following table describes the recommended resolution and color settings for different types of scan
jobs.
Intended use

Recommended resolution

Recommended color settings

Fax

150 ppi

●

Black and White

E-mail

150 ppi

●

Black and White, if the image does not require
smooth gradation

●

Grayscale, if the image requires smooth gradation

●

Color, if the image is in color

Edit text

300 ppi

●

Black and White

Print (graphics or text)

600 ppi for complex graphics, or if you
want to significantly enlarge the
document

●

Black and White for text and line art

●

Grayscale for shaded or colored graphics and
photos

●

Color, if the image is in color

●

Black and White for text

●

Grayscale for graphics and photos

●

Color, if the image is in color

300 ppi for normal graphics and text
150 ppi for photos
Display on screen

75 ppi

Color
You can set the color values to the following settings when scanning.
Setting

Recommended use

Color

Use this setting for high-quality color photos or documents in which the color is important.

Black and White

Use this setting for text documents.

Grayscale

Use this setting when file size is an issue or when you want a document or photograph to
be scanned quickly.

Scan quality
Clean the scanner glass strip and platen
Over time, specks of debris might collect on the scanner glass and white platen, which can affect
performance. Use the following procedure to clean the scanner glass and white platen.
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1.

Use the power switch to turn off the product, and then unplug the power cord from the electrical
socket.

2.

Tilt the control panel forward.
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3.

Clean the glass strip and the white platen with a soft cloth or sponge that has been moistened with
nonabrasive glass cleaner.

CAUTION: Do not use abrasives, acetone, benzene, ammonia, ethyl alcohol, or carbon
tetrachloride on any part of the product; these can damage the product. Do not place liquids directly
on the glass or platen. They might seep and damage the product.

ENWW

4.

Dry the glass and platen with a chamois or a cellulose sponge to prevent spotting.

5.

Plug in the product, and then use the power switch to turn on the product.

Scan settings
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●

Fax features

●

Setup

●

Change fax settings

●

Use fax

●

Solve fax problems

For information about the fax controls on the control panel, see Control panel on page 9.
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Fax features
The product has the following fax features, which are available from the control panel or from the product
software.
●

Integrated telephone handset

●

Fax Setup Wizard for easy fax configuration

●

Plain-paper analog fax with 30-page automatic document feeder (ADF) and output tray of up to
100-page paper capacity

●

120-entry phone book and 10 speed dials from the control panel

●

Automatic redial

●

Digital storage of up to 500 fax pages

●

Fax forwarding

●

Delayed sending of faxes

●

Ring features: Configure rings to answer and distinctive ring compatibility (service required through
local telecommunications company)

●

Fax confirmation report

●

Junk fax blocking

●

Eight cover page templates available

NOTE: Not all features are listed. The product software might need to be installed for some features
to be available.
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Setup
Install and connect the hardware
Connect to a telephone line
The product is an analog device. HP recommends using the product on a dedicated analog telephone
line. For information about using the product with other telephone environments, see Use fax on a DSL,
PBX, ISDN, or VoIP system on page 98.

Connect additional devices
The product includes two fax ports:
●
●

The “line out” port (
The “telephone” port (

), which connects the product to the wall telephone jack.
), which connects additional devices to the product.

Telephones used in conjunction with the product can be employed in two ways:
●

An extension phone is a phone plugged into the same phone line at another location.

●

A downstream phone is one that is plugged into the product or a device that is plugged into the
product.

Connect additional devices in the order that is described in the following steps. The output port for each
device is connected to the input port of the next, forming a "chain". If you do not want to connect a
specific device, skip the step that explains it and continue to the next device.
NOTE: Do not connect more than three devices to the telephone line.
NOTE: Voicemail is not supported with this product.
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1.

Unplug the power cords for all of the devices that you want to connect.

2.

If the product is not yet connected to a telephone line, see the getting started guide before
proceeding. The product should already be connected to a telephone jack.

3.

Remove the plastic insert from the "telephone" port (the port that is marked with the telephone
icon).

Setup
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4.

To connect an internal or external modem on a computer, plug one end of a telephone cord into
the product “telephone” port (
port.

). Plug the other end of the telephone cord into the modem “line”

NOTE: Some modems have a second “line” port to connect to a dedicated voice line. If you have
two “line” ports, see your modem documentation to make sure that you connect to the correct “line”
port.
5.
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To connect a caller-ID box, plug a telephone cord into the previous device’s “telephone” port. Plug
the other end of the telephone cord into the caller-ID box “line” port.
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6.

To connect an answering machine, plug a telephone cord into the previous device’s “telephone”
port. Plug the other end of the telephone cord into the answering machine “line” port.

7.

To connect a telephone, plug a telephone cord into the previous device’s “telephone” port. Plug
the other end of the telephone cord into the telephone “line” port.

8.

After you have finished connecting additional devices, plug all of the devices into their power
sources.

Set up fax with a telephone answering machine
●

Set the product rings-to-answer setting for at least one ring more than the number of rings for which
the answering machine is set.

●

If an answering machine is connected to the same telephone line but on a different jack (in another
room, for example), it might interfere with the product's ability to receive faxes.

Setup for stand-alone fax
1.

Unpack and set up the product.

2.

Set the time, date, and fax header. See Configure fax settings on page 79.

3.

Set other settings as necessary to configure for the product environment.

Configure fax settings
The product fax settings can be set from the control panel, from HP Toolbox, or from HP Director. At
the initial set-up process, the HP Fax Setup Wizard can be used to configure the settings.
In the United States and many other countries/regions, setting the time, date, and other fax header
information is a legal requirement.
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Use the control panel to set the fax time, date, and header
To use the control panel to set the date, time, and header, complete the following steps:
1.

At the control panel, press Setup.

2.

Use the arrow buttons to select System setup, and then press OK.

3.

Use the arrow buttons to select Time/Date. Press OK.

4.

Use the arrow buttons to select the 12-hour clock or 24-hour clock, and then press OK.

5.

Use the alphanumeric buttons to enter the current time.

6.

Complete one of the following:
●

For the 12-hour clock, use the arrow buttons to move past the fourth character. Select 1 for
a.m. or 2 for p.m. Press OK.

●

For the 24-hour clock, press OK.

7.

Use the alphanumeric buttons to enter the current date. Use two digits to specify the month, day,
and year. Press OK.

8.

Use the arrow buttons to select Fax setup, then press OK.

9.

Use the arrow buttons to select Fax Header, then press OK.

10. Use the alphanumeric buttons to enter your fax number and your company name or header, and
then press OK.
NOTE: The maximum number of characters for the fax number is 20; use up to 25 characters for
the company name.

Use HP Fax Setup Wizard to set the fax time, date, and header
If you completed the software installation, you are ready to send faxes from your computer. If you did
not complete the fax setup process at the time you installed the software, you can complete it at any
time by using the Fax Setup Wizard.
1.

Click Start, and then click Programs.

2.

Click HP, click the name of the product, and then click HP Fax Setup Wizard.

3.

Follow the onscreen instructions in the HP Fax Setup Wizard to set the time, date, and fax header,
as well as several other settings.

Use of common localized letters in fax headers
When using the control panel to enter your name in the header or to enter a name for a one-touch key,
speed-dial entry, or group-dial entry, press the appropriate alphanumeric button repeatedly until the
letter that you need appears. Then, press the > button to select that letter and move to the next space.
The following table shows which letters and numbers appear on each alphanumeric button.
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Key number

Characters

1

1

2

ABCabc2

3

DEFdef3

4

GHIghi4

5

JKLjkl5

6

MNOmno6

7

PQRSpqrs7

8

TUVtuv8

9

WXYZwxyz9

0

0

*

()+-./,“*&@RW

#

space # ,

NOTE: Use > to move the cursor on the control panel and use < to delete characters.

Manage the phone book
You can store frequently dialed fax numbers or groups of fax numbers as speed dials or group-dial
entries.
In the product phone book, a total of 120 entries are available for speed dials and group-dial entries.
For example, if you program 100 of the entries as speed-dials, the remaining 20 can be used for groupdials.

Use phone-book data from other programs
NOTE: Before a phone book from another program can be imported, you must use the export feature
in that other program.
HP Toolbox can import contact information from other software program phone books. The following
table shows which programs are supported for HP Toolbox.
Program

Description

Microsoft Outlook

Personal Address Book (PAB) entries, Contacts entries, or both combined may be selected.
Individuals and groups from the PAB are combined with individuals from Contacts only if the
combined option is selected.
If a Contacts entry has both a home and a business fax number, two entries will be displayed. The
“name” of these two entries will be modified. “:(B)” will be added to the name in the business entry
and “:(H)” will be added to the name in the home entry.
If a duplicate entry occurs (one from Contacts and one from the PAB with the same name and fax
number), a single entry will be displayed. However, if an entry exists in the PAB with a duplicate in
Contacts, and the Contacts entry has both a business and a home fax number, all three entries will
be displayed.

Windows Address Book
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The Windows Address Book (WAB), used by Outlook Express and Internet Explorer, is supported.
If an individual has both a home and a business fax number, two entries will be displayed. The
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Program

Description
“name” of these two entries will be modified. “:(B)” will be added to the name in the business entry
and “:(H)” will be added to the name in the home entry.

Goldmine

Goldmine version 4.0 is supported. HP Toolbox imports the file last used by Goldmine.

Symantec Act!

Act! versions 4.0 and 2000 are supported. HP Toolbox imports the database last used by Act!.

Complete the following steps to import a phone book:
1.

Open HP Toolbox.

2.

Click Fax, and then click Fax Phone Book.

3.

Browse to the program phone book, and then click Import.

Delete phone book
You can delete all speed dials and group-dial entries that are programmed in the product.
CAUTION: After speed dials and group-dial entries are deleted, they cannot be recovered.
1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Fax setup, and then press OK.

3.

Press OK to select Phone Book.

4.

Use the arrow buttons to select Delete All, and then press OK.

5.

Press OK to confirm the deletion.

Special dialing symbols and options
You can insert pauses into a fax number that you are dialing or programming to a one-touch key, speeddial entry, or group-dial entry. Pauses are often needed when dialing internationally or connecting to an
outside line.
●

Insert a dialing pause: Press # (Pause) repeatedly until a comma (,) appears on the control-panel
display, indicating that the pause will occur at that point in the dialing sequence.

●

Insert a pause for dial tone: Press * (Symbols) repeatedly until W appears on the control-panel
display to have the product wait for a dial tone before dialing the remainder of the telephone
number.

●

Insert a hook flash: Press * (Symbols) repeatedly until R appears on the control-panel display to
have the product perform a hook flash.

Manage speed dials
Create and edit speed dials
Speed dials 1 through 10 are also associated with their corresponding one-touch keys on the control
panel. The one-touch keys can be used for speed dials or group-dial entries. A maximum of 50
characters can be entered for a single fax number.

82

Chapter 10 Fax

ENWW

NOTE: To gain access to all of the speed dials, you must use the Shift button. Speed dials 6 through
10 are all available by pressing Shift and the associated one-touch key on the control panel.
Complete the following steps to program speed dials from the control panel:
1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Fax setup, and then press OK.

3.

Press OK to select Phone Book.

4.

Press OK to select Individual Setup.

5.

Press OK to select Add.

6.

Use the alphanumeric buttons to specify the speed-dial entry number that you want to associate
with this fax number, and then press OK. Selecting a number from 1 to 10 also associates the fax
number with the corresponding one-touch key.

7.

Use the alphanumeric buttons to enter the fax number. Include any pauses or other needed
numbers, such as an area code, an access code for numbers outside a PBX system (usually a 9
or 0), or a long distance prefix.
NOTE: When entering a fax number, press Pause until a comma (,) appears if you want to insert
a pause in the dialing sequence, or press * until W appears if you want the product to wait for a
dial tone.

8.

Press OK.

9.

Use the alphanumeric buttons to enter a name for the fax number. To do so, repeatedly press the
alphanumeric button for the letter that you need until the letter appears. (For a list of characters,
see Use of common localized letters in fax headers on page 80.)
NOTE: To insert punctuation, press the asterisk (*) button repeatedly until the character that you
want appears, and then press the > button to go to the next space.

10. Press OK to save the information.
11. If you have more speed dials to program, repeat steps 1 through 10.
Delete speed dials
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1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Fax setup, and then press OK.

3.

Press OK to select Phone Book.

4.

Press OK to select Individual setup.

5.

Use the arrow buttons button to select Delete, and then press OK.

6.

Use the alphanumeric buttons to enter the number of the speed-dial entry you want to delete, and
then press OK.

7.

Press OK to confirm the deletion.
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Manage group-dial entries
Create and edit group-dial entries
1.

Assign a speed-dial entry to each fax number that you want in the group. (For instructions, see
Create and edit speed dials on page 82.)

2.

On the control panel, press Setup.

3.

Use the arrow buttons to select Fax setup, and then press OK.

4.

Press OK to select Phone Book.

5.

Use the arrow buttons to select Group setup, and then press OK.

6.

Use the arrow buttons to select Add/Edit group, and then press OK.

7.

Use the alphanumeric buttons to enter the number that you want to associate with this group, and
then press OK. Selecting 1 through 10 also associates the group with the corresponding one-touch
key.

8.

Use the alphanumeric buttons to enter a name for the group, and then press OK.

9.

Press a one-touch key, and then press OK again to confirm the addition. Repeat this step for each
group member you want to add.
-orSelect Phone Book, and then select the speed-dial entry for the group member you want to add.
Press OK to confirm the addition. Repeat this step for each group member you want to add.

10. When you are finished, press OK.
11. If you have more group-dial entries to assign, press OK, and then repeat steps 1 through 10.
Delete group-dial entries
1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Fax setup, and then press OK.

3.

Press OK to select Phone Book.

4.

Use the arrow buttons to select Group setup, and then press OK.

5.

Use the arrow buttons to select Delete group, and then press OK.

6.

Using the alphanumeric buttons, enter the number of the group-dial that you want to delete, and
then press OK.

7.

Press OK to confirm the deletion.

Delete an individual from a group-dial entry
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1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Fax setup, and then press OK.

3.

Press OK to select Phone Book.

4.

Use the arrow buttons to select Group setup, and then press OK.
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5.

Use the arrow buttons to select Del. # in group, and then press OK.

6.

Use the arrow buttons to select the individual that you want to delete from the group.

7.

Press OK to confirm the deletion.

8.

Repeat steps 6 and 7 to delete other individuals from the group.
-orPress Cancel if you are finished.

NOTE: Deleting a speed-dial entry also deletes that entry from any group-dial entries that included
that speed-dial entry.

Set fax polling
If someone else has set up a fax to be polled, you can request that the fax be sent to your product. (This
is known as polling another machine).
1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Fax functions, and then press OK.

3.

Use the arrow buttons to select Polling receive, and then press OK.

The product dials the other fax machine and requests the fax.
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Change fax settings
Set the sound-volume settings
Control the volume of the fax sounds from the control panel. You can make changes to the following
sounds:
●

The fax sounds that are associated with incoming and outgoing faxes

●

The ring for incoming faxes

The factory-set default for the fax-sounds volume is Soft.

Set the alert volume
1.

Press Setup.

2.

Use the arrow buttons to select System setup, and then press OK.

3.

Use the arrow buttons to select Volume settings, and then press OK.

4.

Use the arrow buttons to select Alarm volume, and then press OK.

5.

Use the arrow buttons to select Off, Soft, Medium, or Loud.

6.

Press OK to save the selection.

Set the fax-sounds (phone-line) volume
Complete the following steps to change the fax-sounds volume.
1.

Press Setup.

2.

Use the arrow buttons to select System setup, and then press OK.

3.

Use the arrow buttons to select Volume settings, and then press OK.

4.

Use the arrow buttons to select Phoneline volume, and then press OK.

5.

Use the arrow buttons to select Off, Soft, Medium, or Loud.

6.

Press OK to save the selection.

Set the ring volume
When the product is initially receiving a call, a ring alert is audible. The ring duration length is based on
the local telephone company ring-pattern length. The factory-set default for the ring volume is Soft.
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1.

Press Setup.

2.

Use the arrow buttons to select System setup, and then press OK.

3.

Use the arrow buttons to select Volume settings, and then press OK.

4.

Use the arrow buttons to select Ring volume, and then press OK.

5.

Use the arrow buttons to select Off, Soft, Medium, or Loud.

6.

Press OK to save the selection.
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Set the handset volume
1.

Press Setup.

2.

Use the arrow buttons to select System setup, and then press OK.

3.

Use the arrow buttons to select Volume settings, and then press OK.

4.

Use the arrow buttons to select Handset volume, and then press OK.

5.

Use the arrow buttons to select Off, Soft, Medium, or Loud.

6.

Press OK to save the selection.

Send fax settings
Set a dial prefix
A dial prefix is a number or group of numbers that are automatically added to the beginning of every fax
number you enter at the control panel or from the software. The maximum number of characters for a
dial prefix is 50.
The default setting is Off. You might want to turn this setting on and enter a prefix if, for example, you
have to dial a number such as 9 to get a telephone line outside of your company telephone system.
While this setting is activated, you can dial a fax number without the dial prefix by using manual dial.
For instructions, see Manual dial faxing on page 101.
1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Fax setup, and then press OK.

3.

Use the arrow buttons to select Fax Send setup, and then press OK.

4.

Use the arrow buttons to select Dial Prefix, and then press OK.

5.

Use the arrow buttons to select On or Off, and then press OK.

6.

If you selected On, use the alphanumeric buttons to enter the prefix, and then press OK. You can
use numbers, pauses, and dialing symbols.

Set the dial-tone detection
Normally, the product begins dialing a fax number immediately. If you are using the product on the same
line as your telephone, turn on the detect-dial-tone setting. This prevents the product from sending a
fax while someone is on the telephone.
The factory-set default for detect dial tone is On for France and Hungary, and Off for all other countries/
regions.

ENWW

1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Fax setup, and then press OK.

3.

Use the arrow buttons to select Fax Send setup, and then press OK.

4.

Use the arrow buttons to select Detect dial tone, and then press OK.

5.

Use the arrow buttons to select On or Off, and then press OK.
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Set autoredial
If the product was unable to send a fax because the receiving fax machine did not answer or was busy,
the product attempts to redial based on the redial-on-busy, redial-on-no-answer, and redial-oncommunication-error options. Use the procedures in this section to turn these options on or off.
Set the redial-on-busy option
If this option is turned on, the product redials automatically if it receives a busy signal. The factory-set
default for the redial-on-busy option is On.
1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Fax setup, and then press OK.

3.

Use the arrow buttons to select Fax Send setup, and then press OK.

4.

Use the arrow buttons to select Redial if busy, and then press OK.

5.

Use the arrow buttons to select On or Off, and then press OK.

Set the redial-on-no-answer option
If this option is turned on, the product redials automatically if the receiving machine does not answer.
The factory-set default for the redial-on-no-answer option is Off.
1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Fax setup, and then press OK.

3.

Use the arrow buttons to select Fax Send setup, and then press OK.

4.

Use the arrow buttons to select Redial-no answer, and then press OK.

5.

Use the arrow buttons to select On or Off, and then press OK.

Set the redial-on-communication-error option
If this option is turned on, the product redials automatically if some sort of communication error occurs.
The factory-set default for the redial-on-communication-error option is On.
1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Fax setup, and then press OK.

3.

Use the arrow buttons to select Fax Send setup, and then press OK.

4.

Use the arrow buttons to select Redial Comm Err., and then press OK.

5.

Use the arrow buttons to select On or Off, and then press OK.

Set light/dark and resolution
Set the default light/dark (contrast) setting
The contrast affects the lightness and darkness of an outgoing fax as it is being sent.
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The default light/dark setting is the contrast that is normally applied to items that are being faxed. The
slider is set to the middle as the default setting.
1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Fax setup, and then press OK.

3.

Use the arrow buttons to select Fax Send setup, and then press OK.

4.

Use the arrow buttons to select Def. Light/dark, and then press OK.

5.

Use the < button to move the slider to the left to make the fax lighter than the original, or use the
> button to move the slider to the right to make the fax darker than the original.

6.

Press OK to save the selection.

Set resolution settings
NOTE: Increasing the resolution increases the fax size. Larger faxes increase the send time and could
exceed the available memory in the product.
The factory-set default resolution setting is Fine.
Use this procedure to change the default resolution for all fax jobs to one of the following settings:
●

Standard: This setting provides the lowest quality and the fastest transmission time.

●

Fine: This setting provides a higher resolution quality than Standard that is usually appropriate for
text documents.

●

Superfine: This setting is best used for documents that mix text and images. The transmission
time is slower than Fine but faster than Photo.

●

Photo: This setting produces the best images, but greatly increases the transmission time.

Set the default resolution setting
1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Fax setup, and then press OK.

3.

Use the arrow buttons to select Fax Send setup, and then press OK.

4.

Use the arrow buttons to select Def. Resolution, and then press OK.

5.

Use the arrow buttons to change the resolution setting.

6.

Press OK to save the selection.

Set the resolution for the current fax job
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1.

On the control panel, press Resolution to show the current resolution setting.

2.

Use the arrow buttons to select the appropriate resolution setting.

3.

Press OK to save the selection.
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Set tone-dialing or pulse-dialing
Use this procedure to set the product to tone-dialing or pulse-dialing mode. The factory-set default is
Tone. Do not change this setting unless you know that the telephone line cannot use tone dialing.
1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Fax setup, and then press OK.

3.

Use the arrow buttons to select Fax Send setup, and then press OK.

4.

Use the arrow buttons to select Dialing Mode, and then press OK.

5.

Use the arrow buttons to select Tone or Pulse, and then press OK to save the selection.

NOTE: The pulse-dialing option is not available in all countries/regions.

Receive fax settings
Set or change number of rings-to-answer
When the answer mode is set to Automatic, the product rings-to-answer setting determines the number
of times the telephone rings before the product answers an incoming call.
If the product is connected to a line that receives both fax and voice calls (a shared line) and that also
uses an answering machine, you might need to adjust the rings-to-answer setting. The number of ringsto-answer for the product must be greater than the rings-to-answer on the answering machine. This
allows the answering machine to answer the incoming call and record a message if it is a voice call.
When the answering machine answers the call, the product listens to the call and automatically answers
it if it detects fax tones.
The default setting for rings-to-answer is five for the U.S. and Canada, and two for other countries/
regions.
Use the rings-to-answer setting
Use the following table to determine the number of rings-to-answer to use.
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Type of telephone line

Recommended rings-to-answer setting

Dedicated fax line (receiving only fax calls)

Set to a number of rings within the range shown on the controlpanel display. (The minimum and maximum number of rings
allowed varies by country/region.)

One line with two separate numbers and a ring-pattern service

One or two rings. (If you have an answering machine or
computer voicemail for the other telephone number, make sure
that the product is set to a greater number of rings than the
answering system. Also, use the distinctive-ring feature to
differentiate between voice and fax calls. See Set up distinctive
ring on page 92.)

Shared line (receiving both fax and voice calls) with only an
attached telephone

Five rings or more.

Shared line (receiving both fax and voice calls) with an
attached answering machine or computer voicemail

Two rings more than the answering machine or computer
voicemail.
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Set the number of rings-to-answer
To set or change the number of rings-to-answer, use the following steps:
1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Fax setup, and then press OK.

3.

Use the arrow buttons to select Fax Recv. setup, and then press OK.

4.

Use the arrow buttons to select Rings to answer, and then press OK.

5.

Use the alphanumeric buttons to enter the number of rings-to-answer, and then press OK.

Set the answer mode
Depending on the situation, set the product answer mode to Automatic or Manual. The factory-set
default is Automatic.
●

Automatic: In this answer mode, the product answers incoming calls after a specified number of
rings or upon recognition of special fax tones. To specify the number of rings, see Set the number
of rings-to-answer on page 91.

●

Manual: In this answer mode, the product never answers calls. You must start the fax-receiving
process yourself, either by pressing Start Fax on the control panel or by picking up a telephone
that is connected to that line and dialing 1-2-3.

To set or change the answer mode, complete the following steps:
1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Fax setup, and then press OK.

3.

Use the arrow buttons to select Fax Recv. setup, and then press OK.

4.

Press OK to select Answer mode.

5.

Use the arrow buttons to select the answer mode, and then press OK.

The control-panel display shows the answer mode setting that you specified.

Set fax forwarding
You can set your product to forward incoming faxes to another fax number. When the fax arrives at your
product, it is stored in the memory. The product then dials the fax number that you have specified and
sends the fax. If the product cannot forward a fax because of an error (for example, the number is busy)
and repeated redial attempts are unsuccessful, your product prints the fax.
If the product runs out of memory while receiving a fax, it terminates the incoming fax and only forwards
the pages and partial pages that have been stored in the memory.
When it is using the fax-forwarding feature, the product (rather than the computer) must be receiving
the faxes, and the answer mode must be set to Automatic.
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1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Fax setup, and then press OK.

3.

Use the arrow buttons to select Fax Recv. setup, and then press OK.
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4.

Use the arrow buttons to select Forward fax, and then press OK.

5.

Use the arrow buttons to select On or Off, and then press OK.

6.

If you turn on the fax-forwarding feature, use the alphanumeric buttons to specify the fax number
where the fax is to be sent, and then press OK to save the selection.

Set up distinctive ring
Ring-pattern or distinctive-ring service is available through some local telephone companies. The
service allows you to have more than one telephone number on a single line. Each telephone number
has a unique ring pattern, so that you can answer voice calls and the product can answer fax calls.
If you subscribe to a ring-pattern service with a telephone company, you must set the product to answer
the correct ring pattern. Not all countries/regions support unique ring patterns. Contact the telephone
company to determine if this service is available in your country/region.
NOTE: If you do not have ring-pattern service and you change the ring-pattern settings to something
other than the default, All Rings, the product might not be able to receive faxes.
The settings are as follows:
●

All Rings: The product answers any calls that come through the telephone line.

●

Single: The product answers any calls that produce a single-ring pattern.

●

Double: The product answers any calls that produce a double-ring pattern.

●

Triple: The product answers any calls that produce a triple-ring pattern.

●

Double&Triple: The product answers any calls that produce a double-ring or triple-ring pattern.

To change ring patterns for call answering, complete the following steps:
1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Fax setup, and then press OK.

3.

Use the arrow buttons to select Fax Recv. setup, and then press OK.

4.

Use the arrow buttons to select Answer Ring Type, and then press OK.

5.

Use the arrow buttons to select the ring pattern that you want, and then press OK.

6.

After product installation is complete, ask someone to send a fax to you in order to verify that the
ring-pattern service is working correctly.

Use the private receive feature
NOTE: The private receive feature does not affect the reprint last fax feature. To limit access to all
received faxes, make sure that the Reprint faxes setting is set to Off.
Turn on the private receive feature
When the private-receive feature is activated, received faxes are stored in memory. A personal
identification number (PIN) is required to print the stored faxes.
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1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Fax setup, and then press OK.
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3.

Use the arrow buttons to select Fax Recv. setup, and then press OK.

4.

Use the arrow buttons to select Private Receive, and then press OK.

5.

Use the arrow buttons to select On, and then press OK.

6.

Use the alphanumeric buttons to enter the product security password, and then press OK.

7.

To confirm the product security password, use the alphanumeric buttons to re-enter the product
security password, and then press OK.

Turn off the private receive feature
1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Fax setup, and then press OK.

3.

Use the alphanumeric buttons to enter the product security password, and then press OK.

4.

Use the arrow buttons to select Fax Recv. setup, and then press OK.

5.

Use the arrow buttons to select Private Receive, and then press OK.

6.

Use the arrow buttons to select Off, and then press OK.
If any unprinted faxes exist in the fax memory, the product will print the faxes and then erase them
from memory.

Set up the computer to receive faxes
NOTE: Receiving faxes by using a computer is not supported for Macintosh.
Receiving faxes to a computer is available only if a full software installation was performed during initial
product setup.
To receive faxes to your computer, turn on the receive-to-PC setting in the software.
1.

Open HP Toolbox.

2.

Select the product.

3.

Click Fax.

4.

Click Fax Tasks.

5.

Under Fax Receive Mode, select Receive faxes to this computer.

Turn off the receive-to-PC setting from the control panel
The receive-to-PC setting can be activated only from one computer. If for any reason that computer is
no longer available, you can use the following procedure to turn the receive-to-PC setting off from the
control panel.

ENWW

1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Fax functions, and then press OK.

3.

Use the arrow buttons to select Stop Recv to PC, and then press OK.

Change fax settings

93

Use autoreduction for incoming faxes
If the fit-to-page option is turned on, the product automatically reduces long faxes up to 75% to fit the
information on the default paper size (for example, the fax is reduced from legal to letter size).
If the fit-to-page option is turned off, long faxes print at full size on multiple pages. The factory-set default
for incoming fax autoreduction is On.
If you have the stamp-received faxes option turned on, you might also want to turn on autoreduction.
This reduces the size of the incoming faxes slightly, and prevents the page-stamp from forcing a fax
onto two pages.
NOTE: Make sure that the default media size setting matches the size of the media that is loaded in
the tray.
1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Fax setup, and then press OK.

3.

Use the arrow buttons to select Fax Recv. setup, and then press OK.

4.

Use the arrow buttons to select Fit to page, and then press OK.

5.

Use the arrow buttons to select On or Off, and then press OK to save the selection.

Set the silence-detect mode
This setting controls whether or not you can receive faxes from older-model fax machines that do not
emit a fax signal during fax transmissions. At the time of this publication, these silent-model fax machines
represented very few of the fax machines in use. The default setting is Off. The silence-detect mode
setting should be changed only if you regularly receive faxes from someone who uses an older-model
fax machine.
1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Fax setup, and then press OK.

3.

Use the arrow buttons to select Fax Recv. setup, and then press OK.

4.

Use the arrow buttons to select Silence Detect, and then press OK.

5.

Use the arrow buttons to select On or Off, and then press OK to save the selection.

Set the default fax reprint settings
The default fax reprint setting is On. To change this setting from the control panel, complete the following
steps:
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1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Fax setup, and then press OK.

3.

Use the arrow buttons to select Fax Recv. setup, and then press OK.

4.

Use the arrow buttons to select Reprint faxes, and then press OK.

5.

Use the arrow buttons to select On or Off, and then press OK.
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Create stamp-received faxes
The product prints the sender identification information at the top of each received fax. You can also
choose to stamp the incoming fax with your own header information to confirm the date and time that
the fax was received. The factory-set default for stamp-received faxes is Off.
NOTE: Turning on the stamp-received setting might increase the page size and cause the product to
print a second page.
NOTE: This option applies only to received faxes that the product prints.
1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Fax setup, and then press OK.

3.

Use the arrow buttons to select Fax Recv. setup, and then press OK.

4.

Use the arrow buttons to select Stamp faxes, and then press OK.

5.

Use the arrow buttons to select On or Off, and then press OK to save the selection.

Block or unblock fax numbers
If you do not want to receive faxes from specific people or businesses, you can block as many as 30
fax numbers by using the control panel. When you block a fax number and someone from that number
sends you a fax, the control-panel display indicates that the number is blocked, the fax does not print,
and the fax is not saved in memory. Faxes from blocked fax numbers appear in the fax activity log with
a “discarded” designation. You can unblock blocked fax numbers individually or all at one time.
NOTE: The sender of a blocked fax is not notified that the fax failed.
To print a list of numbers that you have blocked or the fax activity log, see Print individual fax reports
on page 113.
Complete the following steps to block or unblock fax numbers by using the control panel:
1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Fax setup, and then press OK.

3.

Use the arrow buttons to select Fax Recv. setup, and then press OK.

4.

Use the arrow buttons to select Block faxes, and then press OK.

5.

To block a fax number, use the arrow buttons to select Add entry, and then press OK. Enter the
fax number exactly as it appears in the header (including spaces), and then press OK. Enter a
name for the blocked number, and then press OK.
To unblock a single fax number, use the arrow buttons to select Delete entry, and then press
OK. Use the arrow buttons to select the fax number that you want to delete, and then press OK to
confirm the deletions.
-orTo unblock all blocked fax numbers, use the arrow buttons to select Clear all, and then press
OK. Press OK again to confirm the deletions.
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Make an extension telephone available to receive faxes
With this setting turned on, you can alert the product to pick up the incoming fax call by pressing 1-2-3
sequentially on the telephone keypad. The default setting is On. Turn this setting off only if you use
pulse dialing or if you have a service from your telephone company that also uses the 1-2-3 sequence.
The telephone company service does not work if it conflicts with the product.
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1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Fax setup, and then press OK.

3.

Use the arrow buttons to select Fax Recv. setup, and then press OK.

4.

Use the arrow buttons to select Extension Phone, and then press OK.

5.

Use the arrow buttons to select On or Off, and then press OK to save the selection.
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Fax software
Supported fax programs
The PC fax program that came with the product is the only PC fax program that works with the product.
In order to continue to use a PC fax program previously installed on the computer, it must be used with
the modem that is already connected to the computer; it will not function through the product modem.

Available cover-page templates
Several business and personal fax cover-page templates are available in the PC Fax Send software
program.
NOTE: Cover-sheet templates cannot be altered. While fields within the templates may be edited, the
templates themselves are fixed forms.

Customize a fax cover sheet
1.

Open the PC Fax Send software program.

2.

In the Fax To section, provide the recipient fax number, name, and company.

3.

In the Resolution section, select a resolution setting.

4.

In the Include With Fax section, select Cover Page.

5.

Add more information in the Notes and Subject text boxes.

6.

In the Cover Page Template drop-down box, select a template, and then select Pages in
Document Tray.

7.

Do one of the following:
●

Click Send Now to send the fax without previewing the cover page.

●

Click Preview to view the cover page prior to sending the fax.

Cancel a fax
Use these instructions to cancel a single fax that is currently dialing or a fax that is being transmitted or
received.

Cancel the current fax
Press Cancel on the control panel. Any pages that have not been transmitted are canceled. Pressing
Cancel also stops group-dial jobs.
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Cancel a pending fax job
Use this procedure to cancel a fax job in the following situations:
●

The product is waiting to redial after encountering a busy signal, an unanswered call, or a
communication error.

●

The fax is scheduled to be sent at a future time.

Use the following steps to cancel a fax job by using the Fax Job status menu:
1.

On the control panel, press Setup.

2.

Press OK to select Fax Job status.

3.

Use the arrow buttons to scroll through pending jobs until you reach the job that you want to clear.

4.

Press OK to select the job that you want to cancel.

5.

Press OK to confirm that you want to cancel the job.

Delete faxes from memory
Use this procedure only if you are concerned that someone else has access to your product and might
try to reprint faxes from the memory.
CAUTION: In addition to clearing the reprint memory, this procedure clears any fax that is currently
being sent, unsent faxes that are pending redial, faxes that are scheduled to be sent at a future time,
and faxes that are not printed or forwarded.
1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Fax functions, and then press OK.

3.

Use the arrow buttons to select Clear saved faxes, and then press OK.

4.

Press OK to confirm the deletion.

Use fax on a DSL, PBX, ISDN, or VoIP system
HP products are designed specifically for use with traditional analog phone services. They are not
designed to work on DSL, PBX, ISDN lines, or VoIP services, but they might work with the proper setup
and equipment.
NOTE: HP recommends discussing DSL, PBX, ISDN, and VoIP setup options with the service
provider.
The HP LaserJet product is an analog device that is not compatible with all digital phone environments
(unless a digital-to-analog converter is used). HP does not guarantee that the product will be compatible
with digital environments or digital-to-analog converters.

DSL
A digital subscriber line (DSL) uses digital technology over standard copper telephone wires. This
product is not directly compatible with digital signals. However, if the configuration is specified during
DSL setup, the signal can be separated so that some of the bandwidth is used to transmit an analog
signal (for voice and fax) while the remaining bandwidth is used to transmit digital data.
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NOTE: Not all faxes are compatible with DSL services. HP does not guarantee that the product will
be compatible with all DSL service lines or providers.
The DSL modem requires a high-pass filter. The service provider typically provides a low-pass filter, for
normal telephone wiring.
NOTE: Contact the DSL provider for more information or for assistance.

PBX
The product is an analog device that is not compatible in all digital phone environments. Digital-to-analog
filters or converters may be needed for faxing functionality. If faxing issues occur in a PBX environment,
it might be necessary to contact the PBX provider for assistance. HP does not guarantee that the product
will be compatible with digital environments or digital-to-analog converters.
Contact the PBX provider for more information and for assistance.

ISDN
Contact the ISDN provider for more information and for assistance.

VoIP
Voice over internet protocol (VoIP) services are often not compatible with fax machines unless the
provider explicitly states that it supports fax over IP services.
If the product experiences problems getting a fax to work on a VoIP network, verify that all cables and
settings are correct. Decreasing the fax-speed setting might allow the product to send a fax over a VoIP
network.
If faxing problems continue, contact the VoIP provider.

Send a fax
Fax from the automatic document feeder (ADF)
NOTE: The ADF capacity is up to 30 sheets of 80 g/m2 or 20 lb media.
CAUTION: To prevent damage to the product, do not use an original that contains correction tape,
correction fluid, paper clips, or staples. Also, do not load photographs, small originals, or fragile originals
into the ADF.
1.
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Insert the top-end of the stack of originals into the ADF input tray, with the media stack face-down
and the first page to be copied at the bottom of the stack.
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2.

Make sure that the ADF media lever is set correctly for single-page or multiple-page documents.

3.

Slide the stack into the ADF until it does not move any farther.

Document loaded appears on the control-panel display.
4.

Adjust the media guides until they are snug against the media.

5.

Use the alphanumeric buttons on the control panel to dial the number.
-orIf the fax number you are calling has been assigned to a one-touch key, press that key.
-orIf the fax number you are calling has a speed dial or group-dial entry, press Phone Book, use the
alphanumeric buttons to specify the speed dial or group-dial entry, and then press OK.

6.

On the control panel, press Start Fax. The product starts the fax job.
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Manual dial faxing
Usually, the product dials after you press Start Fax. At times, however, you might want the product to
dial each number as you press it. For example, if you are charging your fax call to a calling card, you
might need to dial the fax number, wait for the acceptance tone of your telephone company, and then
dial the calling card number. When dialing internationally, you might need to dial part of the number and
then listen for dial tones before continuing to dial.
Dial manually from the handset
1.

Load the document into the ADF.

2.

Call the recipient on the handset.

3.

When the recipient is ready, press Start Fax on the product control panel.

Send a fax to a group manually (ad hoc faxing)
Use the following instructions to send a fax to a group of recipients that has not been assigned a groupdial entry:
1.

Load the document into the automatic document feeder (ADF) input tray.

2.

Use the alphanumeric buttons.
-orIf the fax number that you are calling has been assigned a speed-dial entry, press Phone Book,
use the alphanumeric buttons to specify the speed-dial entry, and then press OK.

3.

Press OK.

4.

To continue dialing numbers, repeat steps 2 and 3.
-orIf you are finished dialing numbers, go to the next step.

5.

Press Start Fax.

6.

If you have more pages to scan, press 1 to select Yes, and then repeat step 5 for each page of the
fax job.
-orIf you are finished, press 2 to select No.

The product sends the fax to each fax number. If a number in the group is busy or does not answer, the
product redials that number based on the redial setting. If all redial attempts fail, the product updates
the fax activity log by adding the error, and then it proceeds to the next number in the group.
Redial manually
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1.

Load the document into the automatic document feeder (ADF) input tray.

2.

On the control panel, press Redial.
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3.

Press Start Fax.

4.

If you have more pages to scan, press 1 to select Yes, and then repeat step 3 for each page of the
fax job.
-orIf you are finished, press 2 to select No.

The product sends the fax to the number that it redialed. If the number is busy or does not answer, the
product redials the number based on its redial setting. If all redial attempts fail, the product updates the
fax activity log by adding the error.

Use speed dials and group-dial entries
Send a fax by using a speed dial
1.

Load the document into the automatic document feeder (ADF) input tray.

2.

Press the one-touch key for the speed dial.
-orPress Phone Book, use the alphanumeric buttons to specify the speed-dial entry, and then press
OK.

3.

Press Start Fax.

4.

If you have more pages to scan, press 1 to select Yes, and then repeat step 3 for each page of the
fax job.
-orIf you are finished, press 2 to select No.

When the last page of the fax has exited the product, you can start sending another fax, copying, or
scanning.
You can assign a speed dial to numbers that you use regularly. See Create and edit speed dials
on page 82. If you have electronic phone books available, you might be able to use them to select
recipients. Electronic phone books are generated by using third-party software programs.
Send a fax by using a group-dial entry
1.

Load the document into the automatic document feeder (ADF) input tray.

2.

Press the one-touch key for the group.
-orPress Phone Book, use the alphanumeric buttons to specify the group-dial entry, and then press
OK.

3.

Press Start Fax.

4.

If you have more pages to scan, press 1 to select Yes, and then repeat step 3 for each page of the
fax job.
-or-
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If you are finished, press 2 to select No.
The product scans the document into memory and sends the fax to each number specified. If a number
in the group is busy or does not answer, the product redials the number based on its redial setting. If all
redial attempts fail, the product updates the fax activity log with the error and proceeds to the next
number in the group.
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Send a fax from the software
This section contains basic instructions for sending faxes by using the software that came with the
product. All other software-related topics are covered in the software Help, which can be opened from
the software-program Help menu.
You can fax electronic documents from a computer if you meet the following requirements:
●

The product is connected directly to the computer.

●

The product software is installed on the computer.

●

The computer operating system is Microsoft Windows XP, Windows Vista, Mac OS X v10.3, or
Mac OS X v10.4.

Send a fax from the software (Windows XP or Vista)
The procedure to send a fax varies according to your specifications. The most typical steps follow.
1.

Click Start, click Programs (or All Programs in Windows XP), and then click Hewlett-Packard.

2.

Click the product name, and then click Send fax. The fax software appears.

3.

Enter the fax number of one or more recipients.

4.

Load the document in the automatic document feeder (ADF) input tray.

5.

Include a cover page. (This step is optional.)

6.

Click Send Now.

Send a fax from the software (Mac OS X v10.3)
1.

Load the document into the automatic document feeder (ADF) input tray.

2.

Open HP Director and click Fax. The fax software appears.

3.

Select Fax from the Print dialog.

4.

Enter the fax number of one or more recipients.

5.

Include a cover page (this step is optional).

6.

Click Fax.

Send a fax from the software (Mac OS X v10.4)
Using Mac OS X v10.4, you can choose between two methods of sending faxes from the product
software.
To send a fax by using HP Director complete the following steps:
1.

Load the document into the automatic document feeder (ADF) input tray.

2.

Open HP Director by clicking the icon in the dock, and then click Fax. The Apple print dialog
appears.

3.

Select Fax PDF from the PDF pop-up menu.

4.

Enter the fax number of one or more recipients under To.
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5.

Select the product under Modem.

6.

Click Fax.

To send a fax by printing to a fax driver, complete the following steps:
1.

Open the document that you want to fax.

2.

Click File and then click Print.

3.

Select Fax PDF from the PDF pop-up menu.

4.

Enter the fax number of one or more recipients under To.

5.

Select the product under Modem.

6.

Click Fax.

Send a fax from a third-party software program, such as Microsoft Word (all operating systems)
1.

Open a document in a third-party program.

2.

Click the File menu, and then click Print.

3.

Select the fax print driver from the printer driver drop-down list. The fax software appears.

4.

Complete one of the following procedures:
●

●

Windows
a.

Enter the fax number of one or more recipients.

b.

Include a cover page. (This step is optional.)

c.

Include any pages loaded at the product. (This step is optional.)

d.

Click Send Now.

Macintosh
a.

Mac OS X v10.3: Select Fax from the Print dialog.
-orMac OS X v10.4: Select Fax PDF from the PDF pop-up menu.

b.

Enter the fax number of one or more recipients.

c.

Mac OS X v10.3: Include a cover page (this step is optional).
-orMac OS X v10.4: Select the product under Modem.

d.
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Click Fax.
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Send a fax by dialing from a downstream phone
Occasionally, you might want to dial a fax number from a telephone that is connected to the same line
as the product. For example, if you are sending a fax to a person whose device is in the manual receive
mode, you can precede the fax with a voice call to let that person know that the fax is coming.
NOTE: The telephone must be connected to the product "telephone" port (

).

1.

Load the document into the automatic document feeder (ADF) input tray.

2.

Pick up the handset of a telephone that is connected to the same line as the product. Dial the fax
number by using the telephone keypad.

3.

When the recipient answers, instruct the person to start the fax machine.

4.

When you hear the fax tones, press Start Fax, wait until Connecting appears on the control-panel
display, and then hang up the telephone.

Send a delayed fax
Use the product control panel to schedule a fax to be sent automatically at a future time to one or more
people. When this procedure is completed, the product scans the document into memory and then
returns to the Ready state.
NOTE: If the product cannot transmit the fax at the scheduled time, that information is indicated on
the fax error report (if that option is turned on) or recorded in the fax activity log. The transmittal might
not be initiated because the fax-sending call is not answered, or because a busy signal stops the redial
attempts.
If a fax has been scheduled to be sent at a future time but it requires updating, send the additional
information as another job. All faxes that are scheduled to go to the same fax number at the same time
are delivered as individual faxes.
1.

Load the document into the automatic document feeder (ADF) input tray.

2.

On the control panel, press Setup.

3.

Use the arrow buttons until Fax functions appears, and then press OK.

4.

Use the arrow buttons until Send fax later appears, and then press OK.

5.

Use the alphanumeric buttons to enter the time.

6.

If the product is set to the 12-hour time mode, use the arrow buttons to move the cursor past the
fourth character to set A.M. or P.M. Select 1 for A.M. or select 2 for P.M., and then press OK.
-orIf the product is set to the 24-hour time mode, press OK.

7.

Use the alphanumeric buttons to enter the date, and then press OK.
-orAccept the default date by pressing OK.

8.

Enter the fax number, enter the speed dial, or press the one-touch key.
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NOTE: This feature does not support undefined (ad hoc) groups.
9.

Press OK or Start Fax. The product scans the document into memory and sends it at the designated
time.

Use access codes, credit cards, or calling cards
To use access codes, credit cards, or calling cards, dial manually to allow for pauses and dialing codes.
See Manual dial faxing on page 101.
Send faxes internationally
To send a fax to an international destination, dial manually to allow for pauses and international dialing
codes. See Manual dial faxing on page 101.

Receive a fax
When the product receives a fax transmission, it prints the fax (unless the private-receive feature is
enabled) and also stores it automatically to flash memory.

Print a stored fax (when private receive feature is on)
To print stored faxes, you must provide the private-receive PIN. Once the product prints the stored faxes,
the faxes are deleted from memory.
1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Fax setup, and then press OK.

3.

Use the alphanumeric buttons to enter the product security PIN, and then press OK.

4.

Use the arrow buttons to select Fax Recv. setup, and then press OK.

5.

Use the arrow buttons to select Private receive, and then press OK.

6.

Use the arrow buttons to select Print faxes, and then press OK.

Reprint a fax
If you want to reprint a fax because the print cartridge was empty or if the fax was printed on the wrong
type of media, you can try to reprint it. The amount of memory that is available determines the actual
number of faxes that are stored for reprinting. The most recent fax prints first; the oldest fax that is in
storage prints last.
These faxes are stored continuously. Reprinting them does not clear them from the memory. To clear
these faxes from the memory, see Delete faxes from memory on page 98.
1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Fax functions, and then press OK.

3.

Use the arrow buttons to select Reprint last, and then press OK. The product begins reprinting
the most recently printed fax.

NOTE: To stop the printing at any time, press Cancel.
CAUTION: If the Reprint faxes setting is set to Off, misprinted or faded faxes cannot be reprinted.
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Receive a fax when the handset rings
1.

Answer the phone.

2.

If you hear fax tones, wait for the product to pick up the fax.

3.

After the line becomes silent, hang up the handset.

Receive faxes when fax tones are audible on the phone line
If you have a telephone line that receives both fax and telephone calls, and you hear fax tones when
you answer the telephone, you can start the receiving process in one of two ways:
●

If you are close to the product, press Start Fax on the control panel.

●

If not, press 1-2-3 in sequence on the telephone keypad, listen for fax transmission sounds, and
then hang up.

NOTE: In order for the second method to work, the extension telephone setting must be set to Yes.
See Make an extension telephone available to receive faxes on page 96 to check or change the setting.

View a fax that was sent to your computer
In order to view faxes on a computer, the product must be configured to receive faxes to the computer.
See Set up the computer to receive faxes on page 93.
1.

Open HP Toolbox.

2.

Select the product.

3.

Click Fax.

4.

Click Fax Receive Log.

5.

In the Fax Image column, click the “view” link of the fax that you want to view.

NOTE: Receiving faxes by using a computer is not supported for Macintosh.

108 Chapter 10 Fax

ENWW

Solve fax problems
Fax error messages
Alert and warning messages appear temporarily and might require the user to acknowledge the
message by pressing OK to resume or by pressing Cancel to cancel the job. With certain warnings, the
job might not complete or the print quality might be affected. If the alert or warning message is related
to printing and the auto-continue feature is on, the product will attempt to resume the printing job after
the warning has appeared for 10 seconds without acknowledgement.

Alert and warning message tables
Table 10-1 Alert and warning messages
Control panel message

Description

Recommended action

Comm. error

A fax communication error occurred between Allow the product to retry sending the fax.
the product and the sender or receiver.
Unplug the product telephone cord from the
wall, plug in a telephone, and try making a
call. Plug the product phone cord into a jack
for another phone line.
Try a different phone cord.
If the error persists, contact HP. See
www.hp.com/support/ljm1319 or the support
flyer that came in the product box.

Fax delayed – Send memory full

Fax memory is full.

Cancel the fax by pressing OK or Cancel.
Resend the fax. You might need to send the
fax in multiple sections if the error occurs
again.

Fax is busy Canceled send

The fax line to which you were sending a fax Call the recipient to ensure that the fax
was busy. The product has canceled sending machine is on and ready.
the fax.
Check that you are dialing the correct fax
number.
Check that the Redial if busy option is
enabled.
Check for a dial tone on the phone line by
pressing Start Fax.
Make sure that the phone is working by
disconnecting the product, plugging in a
telephone to the phone line, and making a
voice call.
Plug the product phone cord into a jack for
another phone line, and then try sending the
fax again.
Try a different phone cord.
If the error persists, contact HP. See
www.hp.com/support/ljm1319 or the support
flyer that came in the product box.

Fax is busy Redial pending
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The fax line to which you were sending a fax
was busy. The product automatically redials
the busy number. See Set autoredial
on page 88.

Allow the product to retry sending the fax.
Call the recipient to ensure that the fax
machine is on and ready.
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Table 10-1 Alert and warning messages (continued)
Control panel message

Description

Recommended action
Check that you are dialing the correct fax
number.
Check for a dial tone on the phone line by
pressing Start Fax.
Make sure that the phone is working by
disconnecting the product, plugging in a
telephone to the phone line, and making a
voice call.
Plug the product phone cord into a jack for
another phone line, and try sending the fax
again.
Try a different phone cord.
If the error persists, contact HP. See
www.hp.com/support/ljm1319 or the support
flyer that came in the product box.

Fax memory full Canceling recv.

During the fax transmission, the product ran
out of memory. Only the pages that fit into
memory will be printed.

Print all of the faxes, and then have the
sender resend the fax. Have the sender
divide the fax job into multiple jobs before
resending. Cancel all fax jobs or clear the
faxes from memory. See Delete faxes from
memory on page 98.

Fax memory full Canceling send

During the fax job, the memory filled. All
Print all received faxes or wait until all
pages of the fax have to be in memory for a pending faxes are sent.
fax job to work correctly. Only the pages that
Ask the sender to send the fax again.
fit into memory were sent.
Cancel all fax jobs or clear the faxes from
memory. See Delete faxes from memory
on page 98.

Fax recv. error

An error occurred while trying to receive a fax. Ask the sender to resend the fax.
Try faxing back to the sender or another fax
machine.
Check for a dial tone on the phone line by
pressing Start Fax.
Check that the telephone cord is securely
connected by unplugging and replugging the
cord.
Make sure that you are using the telephone
cord that came with the product.
Make sure that the phone is working by
disconnecting the product, plugging in a
telephone to the phone line, and making a
voice call.
Decrease the fax speed. See Change the fax
speed on page 116. Ask the sender to
resend the fax.
Turn off error-correction mode. See Set the
fax-error-correction mode on page 115. Ask
the sender to resend the fax.
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Table 10-1 Alert and warning messages (continued)
Control panel message

Description

Recommended action
Connect the product to a different phone line.
If the error persists, contact HP. See
www.hp.com/support/ljm1319 or the support
flyer that came in the product box.

Fax Send error

An error occurred while trying to send a fax.

Try resending the fax.
Try faxing to another fax number.
Check for a dial tone on the phone line by
pressing Start Fax.
Check that the telephone cord is securely
connected by unplugging and replugging the
cord.
Make sure that you are using the telephone
cord that came with the product.
Make sure that the phone is working by
disconnecting the product, plugging in a
telephone to the phone line, and making a
voice call.
Connect the product to a different phone line.
Set the fax resolution to Standard instead of
the default of Fine. See Set resolution
settings on page 89.
If the error persists, contact HP. See
www.hp.com/support/ljm1319 or the support
flyer that came in the product box.

Group dial not allowed in group

The speed-dial code that you typed is
Add one-touch buttons (programmed as an
programmed for a group. Adding a group-dial individual speed dial) or speed-dial codes to
to another group-dial is not allowed.
a group-dial.

Invalid entry

Invalid data or response.

Correct the entry.

No Dial Tone

The product could not detect a dial tone.

Check for a dial tone on the phone line by
pressing Start Fax.
Unplug the telephone cord from both the
product and the wall and replug the cord.
Make sure that you are using the telephone
cord that came with the product.
Unplug the product telephone cord from the
wall, plug in a telephone, and try making a
voice call.
Make sure that the phone cord from the wall
telephone jack is plugged into the line out
(

) port.

Plug the product phone cord into a jack for
another phone line. See Connect to a
telephone line on page 77.
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Table 10-1 Alert and warning messages (continued)
Control panel message

Description

Recommended action
If the error persists, contact HP. See
www.hp.com/support/ljm1319 or the support
flyer that came in the product box.

No document sent

The product did not scan any pages, or it did
not receive any pages from the computer to
transmit a fax.

Try sending the fax again.

No fax answer Redial pending

The receiving fax line did not answer. The
product attempts to redial after a few minutes.

Allow the product to retry sending the fax.
Call the recipient to ensure that the fax
machine is on and ready.
Check that you are dialing the correct fax
number.
If the product continues to redial, unplug the
product telephone cord from the wall, plug in
a telephone, and try making a voice call.
Make sure that the phone cord from the wall
telephone jack is plugged into the line out
(

) port.

Plug the product phone cord into a jack for
another phone line.
Try a different phone cord.
If the error persists, contact HP. See
www.hp.com/support/ljm1319 or the support
flyer that came in the product box.
No fax answer. Canceled send

Attempts to redial a fax number failed, or the
“Redial-no answer” option was turned off.

Call the recipient to ensure that the fax
machine is on and ready.
Check that you are dialing the correct fax
number.
Check that the redial option is enabled.
Unplug the telephone cord from both the
product and the wall and replug the cord.
Unplug the product telephone cord from the
wall, plug in a telephone, and try making a
voice call.
Make sure that the phone cord from the wall
telephone jack is plugged into the line out
(

) port.

Plug the product phone cord into a jack for
another phone line.
If the error persists, contact HP. See
www.hp.com/support/ljm1319 or the support
flyer that came in the product box.
No fax detected

The product answered the incoming call but
did not detect that a fax machine was calling.

Allow the product to retry receiving the fax.
Try a different phone cord.
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Table 10-1 Alert and warning messages (continued)
Control panel message

Description

Recommended action
Plug the product phone cord into a jack for
another phone line.
If the error persists, contact HP. See
www.hp.com/support/ljm1319 or the support
flyer that came in the product box.

Fax memory is retained when there is a loss of power
The HP LaserJet M1319 MFP flash memory protects against data loss when a power failure occurs.
Other fax devices store fax pages in either normal RAM or short-term RAM. Normal RAM immediately
loses data when power is lost, while short-term RAM loses data about 60 minutes after a power failure
occurs. Flash memory can maintain its data for years without power applied.

Fax logs and reports
Use the following instructions to print fax logs and reports:

Print all fax reports
Use this procedure to print all of the following reports at one time:
●

Fax activity log

●

Phone book report

●

Configuration report

●

Block-fax list

1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Reports, and then press OK.

3.

Use the arrow buttons to select Fax Reports, and then press OK.

4.

Use the arrow buttons to select All fax reports, and then press OK. The product exits the menu
settings and prints the reports.

Print individual fax reports
Use the control panel to print the following fax logs and reports:
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●

Last call report: Provides information about the last fax sent from or received at the product.

●

Fax activity log: Provides a chronological history of the last 40 faxes that were received, sent, or
deleted, and any errors that occurred.

●

Phone book report: Lists the fax numbers that are assigned to the phone book entries, including
speed dials and group-dial entries.

●

Block-fax list: Lists the fax numbers that are blocked from sending faxes to the product.
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1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Reports, and then press OK.

3.

Use the arrow buttons to select Fax Reports, and then press OK.

4.

Use the arrow buttons to select the report to be printed, and then press OK. The product exits the
menu settings and prints the report.
NOTE: If you selected Fax Activity log and pressed OK, press OK again to select Print log
now. The product exits the menu settings and prints the log.

Set the fax activity log to print automatically
You can decide whether or not you want the fax log to print automatically after every 40 entries. The
factory-set default is On. Use the following steps to set the fax activity log to print automatically:
1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Reports, and then press OK.

3.

Use the arrow buttons to select Fax Reports, and then press OK.

4.

Use the arrow buttons to select Fax Activity log, and then press OK.

5.

Use the arrow buttons to select Auto Log Print, and then press OK.

6.

Use the arrow buttons to select On, and then press OK to confirm the selection.

Set the fax error report
A fax error report is a brief report that indicates the product experienced a fax job error. It can be set to
print after the following events:
●

Every fax error (the factory-set default)

●

Send fax error

●

Receive fax error

●

Never

NOTE: If you select Never, you will have no indication that a fax failed to be transmitted unless you
print a fax activity log.
1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Reports, and then press OK.

3.

Use the arrow buttons to select Fax Reports, and then press OK.

4.

Use the arrow buttons to select Fax Error report, and then press OK.

5.

Use the arrow buttons to select the option for when you want the fax error reports to be printed.

6.

Press OK to save the selection.
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Set the fax confirmation report
A confirmation report is a brief report that indicates the product successfully sent or received a fax job.
It can be set to print after the following events:
●

Every fax job

●

Send fax

●

Receive fax

●

Never (the factory-set default)

1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Reports, and then press OK.

3.

Use the arrow buttons to select Fax Reports, and then press OK.

4.

Use the arrow buttons to select Fax Confirmation, and then press OK.

5.

Use the arrow buttons to select the option for when you want the fax error reports to be printed.

6.

Press OK to save the selection.

Include the first page of each fax on the fax confirmation, fax error, and last call reports
If this option is turned on and the page image still exists in the product memory, the fax configuration,
fax error, and last call reports include a thumbnail (50% reduction) of the first page of the most recent
fax that was sent or received. The factory-set default for this option is On.
1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Reports, and then press OK.

3.

Use the arrow buttons to select Fax Reports, and then press OK.

4.

Use the arrow buttons to select Include 1st page, and then press OK.

5.

Use the arrow buttons to select On, and then press OK to confirm the selection.

Change error correction and fax speed
Set the fax-error-correction mode
Usually, the product monitors the signals on the telephone line while it is sending or receiving a fax. If
the product detects an error during the transmission and the error-correction setting is On, the product
can request that the portion of the fax be resent. The factory-set default for error correction is On.
You should turn off error correction only if you are having trouble sending or receiving a fax, and you
are willing to accept the errors in the transmission. Turning off the setting might be useful when you are
trying to send a fax overseas or receive one from overseas, or if you are using a satellite telephone
connection.
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1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Fax setup, and then press OK.
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3.

Use the arrow buttons to select All faxes, and then press OK.

4.

Use the arrow buttons to select Error correction, and then press OK.

5.

Use the arrow buttons to select On or Off, and then press OK to save the selection.

Change the fax speed
The fax-speed setting is the modem protocol that the product uses to send faxes. It is the worldwide
standard for full-duplex modems that send and receive data across telephone lines at up to 33,600 bits
per second (bps). The factory-set default for the fax-speed setting is High (V.34).
You should change the setting only if you are having trouble sending a fax to or receiving a fax from a
particular device. Decreasing the fax speed might be useful when you are trying to send a fax overseas,
or receive one from overseas, or if you are using a satellite telephone connection.
1.

On the control panel, press Setup.

2.

Use the arrow buttons to select Fax setup, and then press OK.

3.

Use the arrow buttons to select All faxes, and then press OK.

4.

Use the arrow buttons to select Fax Speed, and then press OK.

5.

Use the arrow buttons to select a speed setting, and then press OK.

Problems sending faxes
Problem

Cause

Solution

The document stops feeding in the
middle of faxing.

The maximum length of a page that you
can load is 381 mm (15 inches). Faxing
of a longer page stops at 381 mm (15
inches).

Print the document on shorter media.

If the item is too small, it can jam inside
the automatic document feeder (ADF).

The minimum page size for the ADF is
148 x 105 mm (5.83 x 4.13 inches).

If no jam exists and less than one minute
has elapsed, wait a moment before
pressing Cancel. If a jam exists, remove
the jam. Then, resend the job.

If a jam exists, remove the jam. Then,
resend the job.
Faxes stop during sending.

The receiving fax machine might be
malfunctioning.

Try sending to another fax machine.

The telephone line might not be working.

Do one of the following:

A communication error might be
interrupting the fax job.
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●

Turn up the volume on the product,
and then press Start Fax on the
control panel. If you hear a dial tone,
the telephone line is working.

●

Disconnect the product from the
jack in the wall, and then connect a
telephone to the jack. Try to make a
telephone call to verify that the
telephone line is working.

Change the redial-on-communicationerror setting to On.
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Problem

Cause

Solution

The product is receiving faxes but is not
sending them.

If the product is on a digital system, the
system might be generating a dial tone
that the product cannot detect.

Disable the detect-dial-tone setting.
If the error persists, contact the system
service provider.

A poor telephone connection might exist. Try again later.
The receiving fax machine might be
malfunctioning.

Try sending to another fax machine.

The telephone line might not be working.

Do one of the following:
●

Turn up the volume on the product
and press Start Fax on the control
panel. If a dial tone exists, the
telephone line is working.

●

Disconnect the product from the
telephone jack and connect a
telephone. Try to make a telephone
call to verify that the telephone line
is working.

Outgoing fax calls continue to be dialed.

The product automatically redials a fax
number if the redial options are set to
On.

To stop the product from redialing a fax,
press Cancel. Or change the redial
setting.

Sent faxes are not arriving at the
receiving fax machine.

The receiving fax machine might be off
or might have an error condition, such as
being out of paper.

Call the recipient to verify that the fax
machine is on and ready to receive
faxes.

The originals might be incorrectly loaded.

Verify that the original documents are
correctly loaded into the ADF input tray.

A fax might be in memory because it is
waiting to redial a busy number, other
jobs that are ahead of it are waiting to be
sent, or the fax is set up for a delayed
send.

If a fax job is in memory for any of these
reasons, an entry for the job appears in
the fax log. Print the fax activity log and
check the Status column for jobs that
show a Pending designation.

The fax might be too large, or the
resolution might be too high.

Try one of the following:

The control panel shows a low-memory
error.

●

Divide a large fax into smaller
sections, and then fax them
individually.

●

Clear stored faxes to make more
memory available for outgoing
faxes.

●

Configure the outgoing fax as a
delayed fax, and then verify that it
will send completely.

●

Make sure that the product is using
the lowest resolution setting
(Standard).

Problems receiving faxes
Use the table in this section to solve problems that might occur when receiving faxes.
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NOTE: Use the fax cord that came with the product in order to ensure that the product functions
correctly.
Problem

Cause

Solution

The product cannot receive faxes from
an extension telephone.

The extension-telephone setting might
be disabled.

Change the extension-telephone setting.

The fax cord might not be securely
connected.

Verify that the fax cord is securely
connected between the telephone jack
and the product (or another device that is
connected to the product). Press 1-2-3 in
sequence, wait for three seconds, and
then hang up.

The product dialing mode might be
incorrectly set, or the extension phone
might be incorrectly set.

Verify that the product dialing mode is set
to Tone. Verify that the extension phone
is set up for tone dialing as well.

The answer mode might be set to
Manual.

If the answer mode is set to Manual, the
product does not answer calls. Start the
fax-receiving process manually.

The rings-to-answer setting might not be
set correctly.

Check the rings-to-answer setting to
verify that it is set properly.

The answer-ring pattern feature might be
turned on, but you do not have the
service, or you do have the service and
the feature is not set correctly.

Check the answer-ring pattern feature to
verify that it is set properly.

The product is not answering incoming
fax calls.

The fax cord might not be correctly
See the getting started guide to check
connected, or the fax cord is not working. the installation. Verify that you are using
the fax cord that came with the product.
The product might not be able to detect
incoming fax tones because the
answering machine is playing a voice
message.

Re-record the answering machine
message, leaving at least two seconds of
silence at the beginning of the message.

Too many devices might be connected to
the telephone line.

Do not attach more than three devices to
the line. Remove the last device that was
connected and determine whether the
product works. If not, continue removing
devices one at a time and retry after
removing each one.

The telephone line might not be working. Do one of the following:
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●

Increase the volume on the product,
and then press Start Fax on the
control panel. If a dial tone exists,
the telephone line is working.

●

Disconnect the product from the
telephone jack, and then connect a
telephone. Try to make a telephone
call to verify that the telephone line
is working.
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Problem

Cause

The product is not answering incoming
fax calls.

A voice-messaging service might be
Do one of the following:
interfering with the product as it attempts
Disable the messaging service.
●
to answer calls.

Faxes are not printing.

Faxes are printing on two pages instead
of one.

Received faxes are too light, are blank,
or have poor print quality.
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Solution

●

Get a telephone line that is
dedicated to fax calls.

●

Set the product answer mode to
Manual. In manual mode, you must
start the fax-receive process
yourself.

●

Leave the product set to automatic
mode and lower the rings-toanswer setting for the product to a
number less than the rings-toanswer setting for the voice mail.
The product will answer all
incoming calls.

The product might be out of paper and
the memory is full.

Refill the media input tray. Press OK. The
product prints all of the faxes it has saved
in memory and then resumes answering
fax calls.

The media input tray is empty.

Load media. Any faxes that are received
while the input tray is empty are stored in
memory and will print after the tray has
been refilled.

The receive-to-PC option might be
selected, and faxes are being received
by the computer.

Check to determine whether the
computer is receiving faxes.

The product has encountered an error.

Check the control panel for an error
message, and then see Fax error
messages on page 109.

The autoreduction setting might not be
set correctly.

Turn on the autoreduction setting.

The incoming faxes might have been
sent on larger media.

Adjust the autoreduction setting to allow
larger pages to be printed on one page.

The product ran out of toner while
printing a fax.

The product stores the most recently
printed faxes. (The amount of memory
that is available determines the actual
number of faxes stored for reprinting.) As
soon as possible, replace the print
cartridge, and then reprint the fax.

The fax that was sent was too light.

Contact the sender and have the sender
resend the fax after altering the contrast
settings.
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Performance problems
Problem

Cause

Solution

Faxes are transmitting or being received
very slowly.

The fax might be very complex, such as
one with many graphics.

Complex faxes take longer to be sent or
received. Breaking longer faxes into
multiple jobs and decreasing the
resolution can increase the transmission
speed.

The receiving fax machine might have a
slow modem speed.

The product sends the fax only at the
fastest modem speed that the receiving
fax machine can accept.

The resolution at which the fax was sent
or is being received might be very high.

To receive the fax, call and ask the
sender to lower the resolution and
resend the fax. To send the fax, lower the
resolution and resend the fax.

The telephone line might be
experiencing line noise.

Hang up and resend the fax. Have the
telephone company check the telephone
line.
If the fax is being sent via a digital phone
line, contact the service provider.

The fax is being sent via an international
call.

Allow more time to transmit fax jobs
internationally.

The original document has a colored
background.

Reprint the original document with a
white background, and then resend the
fax.

The fax activity logs or fax call reports are
printing at inappropriate times.

The fax activity log or fax call reports
settings are not correct.

Print a configuration page and check
when the reports print.

The product sounds are too loud or too
soft.

The volume setting might not be adjusted
correctly.

Adjust the product volume setting.
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●

Information pages

●

Use the HP Toolbox software

●

Manage supplies
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Information pages
Information pages reside within the product memory. These pages help diagnose and solve problems
with the product.
NOTE: If the product language was not correctly set during installation, you can set the language
manually so the information pages print in one of the supported languages. Change the language by
using the System setup menu on the control panel. See Control panel on page 9.
Page description

How to print the page

Configuration page

1.

On the product control panel, press Setup.

Shows the current settings and product properties.

2.

Use the arrow buttons to select Reports, and then press
OK.

3.

Use the arrow buttons to select Config report, and then
press OK.

A second page also prints. On that page, the Fax Settings
section provides details about the product fax settings.
Demo page

1.

On the product control panel, press Setup.

Contains examples of text and graphics.

2.

Use the arrow buttons to select Reports, and then press
OK.

3.

Use the arrow buttons to select Demo page, and then
press OK.

Menu map

1.

On the product control panel, press Setup.

Shows the control-panel menus and available settings.

2.

Use the arrow buttons to select Reports, and then press
OK.

3.

Use the arrow buttons to select Menu structure, and then
press OK.

Fax reports
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For information about fax logs and reports, see Fax logs and
reports on page 113.
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Use the HP Toolbox software
Perform a full software installation in order to use the HP Toolbox.
HP Toolbox is a software program that you can use for the following tasks:
●

Check the product status.

●

Configure the product settings.

●

Configure pop-up-alert messages.

●

View troubleshooting information.

●

View online documentation.

View HP Toolbox
Open HP Toolbox in one of these ways:
●

In the Windows system tray, double-click the product icon (

●

On the Windows Start menu, click Programs (or All Programs in Windows XP), click HP, click
HP LaserJet M1319, and then click HP Toolbox.

).

The HP Toolbox software contains the following sections for each product in the Devices window:
●

Status

●

Fax

In addition to these sections, every page contains the following common elements:
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●

Shop for Supplies.

●

Other links.
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Status
The Status folder contains links to the following main pages:
●

Device Status. View product status information. This page indicates product conditions such as
a jam or an empty tray. After you correct a product problem, click Refresh status to update the
product status.
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Fax
Use the HP Toolbox Fax tab to perform fax tasks from your computer. The Fax tab contains links to the
following main pages:
●

Fax Tasks. Perform such tasks as sending a fax or clearing the fax memory, or set the fax receive
mode.

●

Fax Phone Book. Add, edit, or delete entries in the all-in-one phone book.

●

Fax Send Log. View all of the recent faxes that have been sent from the all-in-one.

●

Fax Receive Log. View all of the recent faxes that have been received by the all-in-one.

●

Fax Data Properties. Manage the space used to store faxes on a computer. These settings apply
only if you have chosen to send or receive faxes remotely from a computer.

Fax tasks
The following three options are available when receiving a fax:
●

Print the fax. You can also select an option to have a message appear on your computer to notifying
you when the fax was printed.

●

Receive the fax on your computer. You can also select an option to have a message appear on
your computer to notifying you when the fax arrives. If the fax machine is connected to multiple
computers, only one computer can be designated to receive faxes.

●

Forward the fax to another fax machine.

NOTE: You must click Apply before the changes take effect.

Fax phone book
Use the HP Toolbox Fax phone book to add and remove individuals or groups on your speed-dial list,
import phone books from a variety of sources, and update and maintain your contact list.
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●

To add an individual contact to your speed-dial list, select the check box next to the speed dial
number that you want to specify. Type the contact name in the Contact name window. Type the
fax number in the Fax number window. Click Add/Edit.

●

To add a group of contacts to your speed-dial list, select the check box next to the speed-dial
number that you want to specify. Click New/Edit Group. Double-click a contact name from the list
on the left to move it to the group list on the right, or select a name on the left and then click the
appropriate arrow to move it to the group list on the right. You can also use those two methods to
move names from right to left. When you have created a group, type a name in the Group name
window, and then click OK.

●

To edit an existing individual speed-dial entry, click anywhere on the row containing the contact
name to select it, type changes in the appropriate windows, and then click Add/Edit. You can also
make changes directly in the phone book directory list by clicking the entry and typing your changes.
Make sure that you do not have a check mark in the Select column.

●

To edit an existing group-speed-dial entry, click anywhere on the row containing the group name
to select it, and then click New/Edit Group. Make any required changes, and then click OK. You
can make changes to the name of the group directly in the phone book directory list by clicking the
entry and typing your changes. Make sure that you do not have a check mark in the Select column.
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●

To delete an entry from the speed-dial list, select the item and then click Delete.

●

To move speed dial entries, you can select the entry and then click Move, or you can select
Move and then specify the entry in the dialog box. Either select Next empty row or specify the
number of the row where you want to move the entry.
NOTE: If you specify a row that is occupied, the new entry will overwrite the existing entry.

●

To import contacts from a phone book that exists in Lotus Notes, Outlook, or Outlook Express, click
Import Phone Book. Select the appropriate software program, navigate to the appropriate file,
and then click OK. You can also select individual entries from the phone book instead of importing
the entire phone book.

●

To select all of the entries in your speed-dial list, click the Select column heading.

In addition to numerical digits, the following are valid characters for fax numbers:
●

(

●

)

●

+

●

-

●

*

●

#

●

R

●

W

●

.

●

,

●

<space>

NOTE: You must click Apply before the changes take effect.
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Fax send log
The HP Toolbox Fax send log lists all recently sent faxes and information about them, including the date
and time sent, job number, fax number, page count, and the results.
When you send a fax from a computer that is connected to the all-in-one, the fax contains a View link.
Clicking this link opens a new page that provides information about the fax.
Click any column heading in the Fax send log to re-sort the information in that column in ascending or
descending order.
The Results column provides the status of the fax. If the fax attempt was unsuccessful, this column
provides a description of why the fax was not sent.
NOTE: You must click Apply before the changes take effect.

Fax receive log
The HP Toolbox Fax receive log provides a list of all recently received faxes and information about them
including the date and time received, job number, fax number, page count, results, and an abbreviated
fax image.
When you receive a fax on a computer that is connected to the all-in-one, the fax contains a View link.
Clicking this link opens a new page that provides information about the fax.
Click on any column heading in the Fax receive log to re-sort the information in that column in ascending
or descending order.
The Results column provides the status of the fax. If the fax attempt was unsuccessful, this column
provides a description of why the fax was not received.
NOTE: You must click Apply before the changes take effect.
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Shop for Supplies
This button, at the top of each page, links to a Web site where you can order replacement supplies. You
must have Internet access to use this feature.

Other Links
This section contains links that connect you to the Internet. You must have Internet access in order to
use any of these links. If you use a dial-up connection and did not connect when you first opened the
HP Toolbox, you must connect before you can visit these Web sites. Connecting might require that you
close the HP Toolbox and reopen it.
●

HP Instant Support. Connects to the HP Instant Support Web site.

●

Product Support. Connects to the support site for the product where you can search for help with
a specific problem.

●

Shop for Supplies. Order supplies at the HP Web site.

●

Product Registration. Connects to the HP product registration Web site.
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Manage supplies
Check and order supplies
You can check the supplies status by using the product control panel, printing a supplies status page,
or viewing HP Toolbox. Hewlett-Packard recommends that you place an order for a replacement print
cartridge when Low message for a print cartridge first appears. Use a new, authentic HP print cartridge
to obtain the following types of supplies information:
●

Amount of cartridge life remaining

●

Estimated number of pages remaining

●

Number of pages printed

●

Other supplies information

NOTE: You can set HP Toolbox to notify you when supplies are low.

Check supplies status by using the control panel
Check the product control panel, which indicates when a print cartridge is low or empty. The control
panel also indicates when a non-HP print cartridge is first installed.
If the supplies levels are low, you can order supplies through a local HP dealer, by telephone, or online.
See Accessories and ordering information on page 167 for part numbers. Go to www.hp.com/go/
ljsupplies to order online.
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Store supplies
Follow these guidelines for storing print cartridges:
●

Do not remove the print cartridge from its package until you are ready to use it.
CAUTION: To prevent damage, do not expose the print cartridge to light for more than a few
minutes.

●

See Environmental specifications on page 175 for operating and storage temperature ranges.

●

Store the supply in a horizontal position.

●

Store the supply in a dark, dry location away from heat and magnetic sources.

HP policy on non-HP supplies
Hewlett-Packard Company cannot recommend the use of non-HP supplies, either new or
remanufactured. Because they are not HP products, HP cannot influence their design or control their
quality. Service or repairs required as a result of using a non-HP supply will not be covered under the
warranty.

HP fraud hotline
Call the HP fraud hotline if the product or HP Toolbox indicates that the print cartridge is not an HP print
cartridge and you think that it is genuine. HP will help determine if the product is genuine and take steps
to resolve the problem.
The print cartridge might not be a genuine HP one if you notice the following issues:
●

You are experiencing a large number of problems with the print cartridge.

●

The print cartridge does not look like it usually does (for example, the pull tab or the box is different).

In the United States, call toll-free: 1-877-219-3183.
Outside the United States, you can call collect. Dial the operator and ask to place a collect call to this
telephone number: 1-770-263-4745. If you do not speak English, a representative at the HP fraud hotline
who speaks your language will assist you. Or, if someone who speaks your language is not available,
a language line interpreter will connect approximately one minute after the beginning of the call. The
language line interpreter is a service that will translate between you and the representative for the HP
fraud hotline.

Recycle supplies
To install a new HP print cartridge, follow the instructions that are included in the box that contains the
new supply, or see the getting started guide.
To recycle supplies, place the used supply in the box in which the new supply arrived. Use the enclosed
return label to send the used supply to HP for recycling. For complete information, see the recycling
guide that is included with each new HP supply item. See HP LaserJet print supplies on page 179 for
more information about HP's recycling program.
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Redistribute toner
If faded or light areas appear on the printed page, you might be able to temporarily improve print quality
by redistributing the toner.
1.

Remove the print cartridge from the printer.

2.

To redistribute the toner, gently rock the print cartridge from front to back.
CAUTION: If toner gets on your clothing, wipe it off with a dry cloth and wash the clothing in cold
water. Hot water sets toner into the fabric.

3.

Reinsert the print cartridge into the printer, and close the print cartridge door. If the print is still light
or unacceptable, install a new print cartridge.

Replace supplies
Print cartridge
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1.

Open the print-cartridge door.

2.

Grasp the handle on the print cartridge and then pull the cartridge straight out to remove it. See
the recycling information inside the print cartridge box.
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3.

Remove the new print cartridge from its packaging, rock the cartridge, remove the orange cover,
and then pull the orange tab straight out to remove the sealing tape.

4.

Insert the cartridge into the product until it is firmly in place.

5.

Close the print-cartridge door.

CAUTION: If toner gets on any clothing, wipe it off with a dry cloth and wash the clothing in cold water.
Hot water sets toner into the fabric.

Clean the product
Clean the paper path
During the printing process, paper, toner, and dust particles can accumulate inside the product. Over
time, this buildup can cause print-quality problems such as toner specks or smearing. This product has
a cleaning mode that can correct and prevent these types of problems.
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Specks

Smearing

1.

Press Setup.

2.

Use the arrow buttons to find the Service menu, and then press OK.

3.

Use the arrow buttons to find Cleaning mode, and then press OK.

4.

Load plain letter or A4 paper when you are prompted.

5.

Press OK again to confirm and begin the cleaning process.
A page feeds through the product slowly. Discard the page when the process is completed.

Clean the exterior
Use a soft, damp, lint-free cloth to wipe dust, smudges, and stains off of the exterior of the product.

Firmware updates
Firmware updates and installation instructions for this product are available at www.hp.com/support/
ljm1319. Click Downloads and drivers, click the operating system, and then select the firmware
download for the product.
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Problem-solving checklist

●

Restore the factory-set defaults

●

Control-panel messages

●

Control-panel display problems

●

Clear jams

●

Solve image-quality problems

●

Solve connectivity problems

●

Solve software problems
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Problem-solving checklist
Follow these steps when trying to solve a problem with the product.
Step
number

Verification step

Possible problems

Solutions

1

Is the power on?

No power due to failed power source, cable,
switch, or fuse.

1.

Verify that the product is plugged in.

2.

Verify that the power cable is functional
and that the power switch is on.

3.

Check the power source by plugging
the product directly into the wall or into
a different outlet.

2

Does Ready appear in the
product control panel?

Control panel shows an error.

See Control-panel messages on page 138
for a list of common messages that will help
you correct the error.

An error message appears on the controlpanel display.

See Control-panel messages on page 138
for a list of common messages that will help
you correct the error.

The control panel should
function without error
messages.
3

Do information pages print?

Print a configuration page. See
Information pages
Paper jams when printing.
on page 122.

Make sure that media that meets
HP specifications. See Paper and print
media on page 35
Clean the paper path. See Clean the paper
path on page 132.

4

Does the product copy?

Poor copy quality from the ADF.

Place the configuration page
into the ADF and make a copy.
Paper jams when printing.
The report should feed
smoothly through the ADF, and
copies should print without
print-quality problems.

Clean the ADF scanning strip. See Clean
the scanner glass strip and platen
on page 72.
Make sure that media that meets
HP specifications. See Paper and print
media on page 35
Clean the paper path. See Clean the paper
path on page 132.

5

Does the product send a fax? The telephone line is not operational or the
Verify that the product is plugged into a
product is not plugged into the telephone line. telephone line that you know works.
Press Start Fax to verify that a
The telephone cord is faulty or is plugged into 1. Try plugging the telephone cord into
dial tone exists (using a hand
the wrong connector.
the other connector.
set, if necessary). Attempt to
send a fax.
2. Try a new telephone cord.

6

Does the product receive a
fax?
Use another fax machine to
send a fax to the product, if
available.
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Too many telephone devices are plugged in, Make sure that the HP LaserJet M1319 MFP
or telephone devices are not connected in the is the only device on the telephone line and
correct order.
try again to receive the fax.
The product fax settings are set incorrectly.

Review and reset the product fax settings.
See Change fax settings on page 86
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Step
number

Verification step

Possible problems

Solutions

7

Does the product print from
the computer?

Software is not installed correctly or an error
occurred during software installation.

Use a word-processing
program to send a print job to
the product.

Uninstall and then reinstall the product
software. Verify that you are using the
correct installation procedure and the
correct port setting.

The cable is not connected correctly.

Reconnect the cable.

An incorrect driver is selected.

Select the proper driver.

There is a port driver problem in Microsoft
Windows.

Uninstall and then reinstall the product
software. Verify that you are using the
correct installation procedure and the
correct port setting.

The cable is not connected correctly.

Reconnect the cable.

Software is not installed correctly or an error
occurred during software installation.

Uninstall and then reinstall the product
software. Verify that you are using the
correct installation procedure and the
correct port setting.

8

Does the product scan to the
computer?
Initiate a scan from the basic
desktop software at your
computer.

If the error persists, turn off the product and then turn on the product.

Restore the factory-set defaults
Restoring the factory-set defaults returns all of the settings to the factory defaults, and it also clears the
fax header name, phone number, speed dials, and any stored faxes in the product memory.
CAUTION: This procedure also clears all fax numbers and names that are associated with one-touch
keys and speed-dial codes, and deletes any pages that are stored in the memory. The procedure then
automatically restarts the product.
1.

On the product control panel, press Setup.

2.

Use the arrows buttons to select Service, and then press OK.

3.

Use the arrows buttons to select Restore defaults, and then press OK.
The product automatically restarts.
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Control-panel messages
The majority of the control-panel messages are intended to guide the user through typical operation.
The control-panel messages indicate the status of the current operation, and include a page count on
the second line of the display, if appropriate. When the product is receiving print data or scanning
commands, control-panel messages indicate this status. In addition, alert messages, warning
messages, and critical error messages indicate situations that might require some action.

Alert and warning messages
Alert and warning messages appear temporarily and might require the user to acknowledge the
message by pressing OK to resume or by pressing Cancel to cancel the job. With certain warnings, the
job might not complete or the print quality might be affected. If the alert or warning message is related
to printing and the auto-continue feature is on, the product will attempt to resume the printing job after
the warning has appeared for 10 seconds without acknowledgement.

Alert and warning message tables
Control panel message

Description

Recommended action

Device error

The product experienced an internal
communication error.

This is a warning message only. Job output
might be affected.

The product has detected a jam in the paper
path.

Clear the jam from the area indicated on the
product control panel, and then follow the
control-panel instructions. See Clear jams
on page 141.

The product could not print the current page
because of its complexity.

Press OK to clear the message.

Press [OK]
Jam in print paper path
alternates with
Open door and clear jam
Page too complex
Press [OK]
Printer jam

Allow the product to finish the job, or press
Cancel to cancel the job.
The product has detected a jam in the input
trays.

Clear the jam from the area indicated on the
product control panel, and then follow the
control panel instructions. See Clear jams
on page 141.

The product has cleared job settings.

Re-enter any appropriate job settings.

clear paper path

Settings cleared
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Critical error messages
Critical error messages can indicate some kind of failure. Turning off and then turning on the power
might fix the problem. If a critical error persists, the product might require service.

Critical error message-tables
Control panel message

Description

Recommended action

50.1 Fuser Error

The product has experienced an internal
hardware error.

1.

Turn off the power by using the power
switch, and then wait at least 30
seconds.

2.

If a surge protector is being used,
remove it. Plug the product directly into
the wall socket.

3.

Turn on the power and wait for the
product to initialize.

Turn off then on

If the error persists, contact HP. See
www.hp.com/support/ljm1319 or the support
flyer that came in the product box.
50.2 Fuser Error

The product has experienced an internal
hardware error.

Turn off then on

Turn off the power by using the power switch,
wait at least 30 seconds, and then turn on the
power and wait for the product to initialize.
If a surge protector is being used, remove it.
Plug the product directly into the wall socket.
Use the power switch to turn the product on.
If the error persists, contact HP. See
www.hp.com/support/ljm1319 or the support
flyer that came in the product box.

50.3 Fuser Error

The product has experienced an internal
hardware error.

Turn off then on

Turn off the power by using the power switch,
wait at least 30 seconds, and then turn on the
power and wait for the product to initialize.
If a surge protector is being used, remove it.
Plug the product directly into the wall socket.
Use the power switch to turn the product on.
If the error persists, contact HP. See
www.hp.com/support/ljm1319 or the support
flyer that came in the product box.

50.8 Fuser Error

The product has experienced an internal
hardware error.

Turn off then on

Turn off the power by using the power switch,
wait at least 30 seconds, and then turn on the
power and wait for the product to initialize.
If a surge protector is being used, remove it.
Plug the product directly into the wall socket.
Use the power switch to turn the product on.
If the error persists, contact HP. See
www.hp.com/support/ljm1319 or the support
flyer that came in the product box.

50.9 Fuser Error
Turn off then on
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The product has experienced an internal
hardware error.

Turn off the power by using the power switch,
wait at least 30 seconds, and then turn on the
power and wait for the product to initialize.
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Control panel message

Description

Recommended action
If a surge protector is being used, remove it.
Plug the product directly into the wall socket.
Use the power switch to turn the product on.
If the error persists, contact HP. See
www.hp.com/support/ljm1319 or the support
flyer that came in the product box.

52 Scanner Error

The product has experienced a scanner
error.

Turn off then on

Turn off the power by using the power switch,
wait at least 30 seconds, and then turn on the
power and wait for the product to initialize.
If a surge protector is being used, remove it.
Plug the product directly into the wall socket.
Use the power switch to turn the product on.
If the error persists, contact HP. See
www.hp.com/support/ljm1319 or the support
flyer that came in the product box.

54.1C Error

The product has experienced an internal
hardware error.

Turn off then on

Turn off the power by using the power switch,
wait at least 30 seconds, and then turn on the
power and wait for the product to initialize.
If a surge protector is being used, remove it.
Plug the product directly into the wall socket.
Use the power switch to turn the product on.
If the error persists, contact HP. See
www.hp.com/support/ljm1319 or the support
flyer that came in the product box.

Engine comm. Error

The product has experienced an internal
hardware error.

1.

Turn off the power by using the power
switch, and then wait at least 30
seconds.

2.

If a surge protector is being used,
remove it. Plug the product directly into
the wall socket.

3.

Turn on the power and wait for the
product to initialize.

If the error persists, contact HP. See
www.hp.com/support/ljm1319 or the support
flyer that came in the product box.
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Control-panel display problems
CAUTION: Static electricity can cause unexpected black lines or dots to appear on the product controlpanel display. Do not touch the product control-panel display if there is a chance that you have collected
a static electric charge (for example, by walking on carpet in a low-humidity environment).
Unexpected lines or dots might appear on the product control-panel display, or the display might become
blank if the product is exposed to an electric or magnetic field. To resolve this problem, perform the
following procedure:
1.

Turn the product off.

2.

Remove the product from the electric or magnetic field.

3.

Turn the product on again.

Clear jams
Causes of jams
Occasionally, paper or other print media can become jammed during a print job. Some causes include
the following events:
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●

The input trays are loaded improperly or overfilled, or the media guides are not set properly.

●

Media is added to or removed from an input tray during a print job or an input tray is removed from
the product during a print job.

●

The cartridge door is opened during a print job.

●

Too many sheets have accumulated in an output area, or sheets are blocking an output area.

●

The print media that is being used does not meet HP specifications. See Paper and print media
on page 35.

●

The media is damaged or has foreign objects attached to it, such as staples or paper clips.

●

The environment in which the print media was stored is too humid or too dry. See Paper and print
media on page 35.
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Where to look for jams
Jams can occur in these locations:
●

In the automatic document feeder (ADF)

●

In input areas

●

In output areas

●

Inside the product

Find and remove the jam by using the instructions on the following pages. If the location of the jam is
not obvious, first look inside the product.
Loose toner might remain in the product after a jam. This problem typically resolves itself after a few
sheets have been printed.

Clear jams from the ADF
Occasionally, media becomes jammed during a fax, copy, or scan job.
CAUTION: To prevent damage to the product, do not use an original that contains correction tape,
correction fluid, paper clips, or staples. Also, do not load photographs, small originals, or fragile originals
into the ADF.
1.

Open the ADF lid.

2.

Carefully remove jammed media. Gently try to remove the page without tearing it.
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3.

Close the ADF lid.

Clear jams from the input-tray areas
CAUTION: Do not use sharp objects, such as tweezers or needle-nose pliers, to remove jams.
Damage caused by sharp objects will not be covered by the warranty.
When removing jammed media, pull the jammed media straight away from the product. Pulling jammed
media out of the product at an angle can damage the product.
NOTE: Depending on where the jam is located, some of the following steps might not be necessary.
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1.

Open the print-cartridge door.

2.

Do one of the following:
●

If media is visible, use both hands to grasp the side of the media that is most visible (this
includes the middle), and carefully pull it free from the product.

●

If no media is visible, remove the print cartridge, and rotate the upper media guide. Carefully
pull the media up and out of the product.
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3.

Close the print-cartridge door.

4.

Open tray 1.
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5.

With both hands, grasp the side of the media that is most visible (this includes the middle), and
carefully pull it free from the product.

6.

Close tray 1.

Clear jams from the output bin
CAUTION: Do not use sharp objects, such as tweezers or needle-nose pliers, to remove jams.
Damage caused by sharp objects will not be covered by the warranty.
With both hands, grasp the side of the jammed media that is most visible (this includes the middle), and
carefully pull it free from the product.
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Clear jams from the print-cartridge area
CAUTION: Do not use sharp objects, such as tweezers or needle-nose pliers, to remove jams.
Damage caused by sharp objects will not be covered by the warranty.
When removing jammed media, pull the jammed media straight away from the product. Pulling jammed
media out of the product at an angle can damage the product.
1.

Open the print-cartridge door, and remove the print cartridge.

CAUTION: To prevent damage to the print cartridge, minimize its exposure to direct light.
2.

With both hands, grasp the side of the media that is most visible (this includes the middle), and
carefully pull it free from the product.

3.

Replace the print cartridge, and then close the print-cartridge door.
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Avoid repeated jams
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●

Verify that the input tray is not overfilled. The input tray capacity varies depending on the type of
print media that you are using.

●

Verify that the media guides are properly adjusted.

●

Check that the input tray is securely in place.

●

Do not add print media into the input tray while the product is printing.

●

Use only HP-recommended media types and sizes. See Paper and print media on page 35 for
more information about print media types.

●

Do not fan media prior to loading it in a tray. To loosen the ream, hold it firmly in both hands and
twist the media by rotating your hands in the opposite direction.

●

Do not let print media stack up in the output bin. The print media type and the amount of toner used
affect the output bin capacity.

●

Check the power connection. Make sure that the power cord is firmly connected to both the product
and the power supply box. Plug the power cord into a grounded power outlet.

●

Make sure that the ADF media lever is set correctly for single-page or multiple-page documents.

●

To prevent damage to the product, do not use an original that contains correction tape, correction
fluid, paper clips, or staples. Also, do not load photographs, small originals, or fragile originals into
the ADF.
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Solve image-quality problems
Print problems
Print quality problems
Occasionally, you might encounter problems with print quality. The information in the following sections
helps you identify and resolve these issues.
NOTE: If you are having copy problems, see Copy problems on page 155.
General print-quality issues
The following examples depict letter-size paper that has passed through the product short-edge-first.
These examples illustrate problems that would affect all of the pages that you print. The topics that follow
list the typical cause and solution for each of these examples.
Problem

Cause

Solution

Print is light or faded.

The media might not meet HP specifications.

Use media that meets HP specifications.
See Paper and print media on page 35.

The print cartridge might be defective or low.
If you use a non-HP print cartridge, no
messages appear on the product control
panel.

Replace the print cartridge. See Print
cartridge on page 131.

Toner specks appear.

Dropouts appear.

If the print cartridge is not low or empty,
inspect the toner roller to see if the roller is
damaged. If it is, replace the print cartridge.

If the whole page is light, the print density
adjustment is too light or EconoMode might
be turned on.

Adjust the print density, and disable
EconoMode in the product Properties.

The media might not meet HP specifications.

Use media that meets HP specifications.
See Paper and print media on page 35.

The paper path might need cleaning.

Clean the paper path. See Clean the paper
path on page 132.

A single sheet of print media might be
defective.

Try reprinting the job.

The moisture content of the paper is uneven
or the paper has moist spots on its surface.

Try different paper, such as high-quality
paper that is intended for laser printers. See
Paper and print media on page 35.

The paper lot is flawed. The manufacturing
processes can cause some areas to reject
toner.
The print cartridge might be defective or low.

Replace the print cartridge. See Print
cartridge on page 131.
If the error persists, contact HP. See
www.hp.com/support/ljm1319 or the
support flyer that came in the product box.
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Problem

Cause

Solution

Vertical streaks or bands appear
on the page.

The print cartridge might be defective. If you
are using a non-HP print cartridge, no
messages appear on the product control
panel.

Replace the print cartridge. See Print
cartridge on page 131.

Aa BbCc
Aa BbCc
Aa BbCc
Aa BbCc
Aa BbCc
The amount of background toner
shading becomes unacceptable.

The media might not meet HP specifications. Use a different paper with a lighter basis
weight. See Paper and print media
on page 35.
The single-sheet priority input tray might be
installed incorrectly.

Make sure that the single-sheet priority
input tray is in place.

The print-density setting is too high.

Decrease the print-density setting. This
decreases the amount of background
shading.

Very dry (low humidity) conditions can
increase the amount of background shading.

Check the product environment.

The print cartridge might be defective or low. Replace the print cartridge. See Print
If you are using a non-HP print cartridge, no cartridge on page 131.
messages appear on the product control
panel.
Toner smears appear on the
media.

The media might not meet HP specifications. Use media that meets HP specifications.
See Paper and print media on page 35.
If toner smears appear on the leading edge
of the paper, the media guides are dirty, or
debris has accumulated in the print path.

Clean the media guides and the paper path.
See Clean the paper path on page 132.

The print cartridge might be defective. If you
are using a non-HP print cartridge, no
messages appear on the product control
panel.

Replace the print cartridge. See Print
cartridge on page 131.

The fuser temperature might be too low.

In the printer driver, make sure the
appropriate media type is selected.
Use the archive print feature to improve
toner fusing. See Archive print on page 56.
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Problem

Cause

Solution

The toner smears easily when
touched.

The product is not set to print on the type of
media on which you want to print.

In the printer driver, select the Paper/
Quality tab and set Paper Type to match
the type of media on which you are printing.
Print speed might be slower if you are using
heavy paper.

The media might not meet HP specifications.

Use media that meets HP specifications.
See Paper and print media on page 35.

The paper path might need cleaning.

Clean the product. See Clean the paper
path on page 132.

The power source might be defective.

Plug the product directly into an AC outlet
instead of into a power strip.

The fuser temperature might be too low.

Use the archive print feature to improve
toner fusing. See Archive print on page 56.

The product is not set to print on the type of
media on which you want to print.

In the printer driver, make sure that the
appropriate media type is selected. Print
speed might be slower if you are using
heavy paper.

Internal parts might have toner on them.

The problem typically corrects itself after a
few more pages.

The paper path might need cleaning.

Clean the product. See Clean the paper
path on page 132.

The print cartridge might be damaged.

If a repetitive mark occurs at the same spot
on the page, install a new HP print cartridge.
See Print cartridge on page 131.

The media might not meet HP specifications.

Use a different paper, such as high-quality
paper that is intended for laser printers. See
Paper and print media on page 35.

Marks repeatedly appear at even
intervals on the page.

The printed page contains
misformed characters.

If characters are incorrectly formed so that
Verify that the problem also occurs on the
they produce a wavy effect, the laser scanner configuration page. If so, contact HP. See
www.hp.com/support/ljm1319 or the
might need service.
support flyer that came in the product box.
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Problem

Cause

Solution

The printed page is curled or
wavy.

The product is not set to print on the type of
media on which you want to print.

In the printer driver, make sure the
appropriate media type is selected.
If the problem persists, select a media type
that uses a lower fuser temperature, such
as transparencies or light media.

The media might have been in the input tray
too long.

Turn over the stack of media in the tray.
Also, try rotating the media 180° in the input
tray.

The media might not meet HP specifications. Use a different paper, such as high-quality
paper that is intended for laser printers. See
Paper and print media on page 35.

Text or graphics are skewed on
the printed page.

Both high temperature and humidity can
cause paper curl.

Check the product environment.

The fuser temperature might be curling the
media.

At the product control panel, turn on the
Less paper curl setting in the Service
menu.

The media might be loaded incorrectly or the
input tray might be too full.

Verify that the media is loaded correctly and
that the media guides are not too tight or too
loose against the stack. See Load paper
and print media on page 39.

The media might not meet HP specifications. Use a different paper, such as high-quality
paper that is intended for laser printers. See
Paper and print media on page 35.

The printed page contains
wrinkles or creases.

The media might be loaded incorrectly or the
input tray might be too full.

Turn over the stack of paper in the input tray,
or try rotating the paper 180° in the input
tray.
Verify that the media is loaded correctly and
that the media guides are not too tight or too
loose against the stack. See Load paper
and print media on page 39.

There might be a jam in the paper path.

Clear any jams in the product. See Clear
jams on page 141.

The media might not meet HP specifications. Use a different paper, such as high-quality
paper that is intended for laser printers. See
Paper and print media on page 35.
Air pockets inside envelopes can cause them
to wrinkle.
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Remove the envelope, flatten it, and try
printing again.
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Problem

Cause

Solution

Toner appears around the printed
characters.

The media might be loaded incorrectly.

Turn over the stack of paper in the tray.

If large amounts of toner have scattered
around the characters, the paper might have
high resistivity.

Use a different paper, such as high-quality
paper that is intended for laser printers. See
Paper and print media on page 35.

An image that appears at the top Software settings might affect image
of the page (in solid black) repeats printing.
farther down the page (in a gray
field).

In your software program, change the tone
(darkness) of the field in which the repeated
image appears.
In your software program, rotate the whole
page 180° to print the lighter image first.

The order of images printed might affect
printing.

Change the order in which the images are
printed. For example, have the lighter image
at the top of the page, and the darker image
farther down the page.

A power surge might have affected the
product.

If the defect occurs later in a print job, turn
the product off for 10 minutes, and then turn
on the product to restart the print job.

Media-handling problems
Use the information in this section when the product experiences media-handling problems.
Print-media guidelines
●

For best results, make sure that the paper is of good quality, and free of cuts, nicks, tears, spots,
loose particles, dust, wrinkles, voids, staples, and curled or bent edges.

●

For best-quality printing, use a smooth type of paper. Generally, smoother media produces better
results.

●

If you are unsure what type of paper you are loading (such as bond or recycled), check the label
on the package of paper.

●

Do not use media that is designed for inkjet printers only. Use media that is designed for laser
printers.

●

Do not use letterhead paper that is printed with low-temperature inks, such as those used in some
types of thermography.

●

Do not use raised or embossed letterhead.

●

The product uses heat and pressure to fuse toner to the paper. Make sure that any colored paper
or preprinted forms use inks that are compatible with this fusing temperature (200°C or 392°F for
0.1 second).

CAUTION: Failure to follow these guidelines could cause jams or damage to the product.
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Solve print-media problems
The following problems with media cause print-quality deviations, jamming, or even damage to the
product.
Problem

Cause

Solution

Poor print quality or toner
adhesion

The paper is too moist, too rough, too heavy or
too smooth, or it is embossed or from a faulty
paper lot.

Try another kind of paper, between 100 and
250 Sheffield, with 4 to 6% moisture content.

Dropouts, jamming, or curl

The paper has been stored incorrectly.

Store paper flat in its moisture-proof wrapping.

The paper has variability from one side to the
other.

Turn the paper over.

The paper is too moist, has the wrong grain
direction, or is of short-grain construction

Use long-grain paper.

The paper varies from side-to-side.

Turn the paper over.

High fuser temperature is curling the paper.

Turn on the Less paper curl setting.

Excessive curl

At the control panel, press Setup, use the
arrow buttons to select Service, and then press
OK. Use the arrow buttons to select Less paper
curl, press OK, use the arrow buttons to select
On, and then press OK.
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Jamming, damage to
product

The paper has cutouts or perforations.

Use paper that is free of cutouts or
perforations.

Problems with feeding

The paper has ragged edges.

Use high-quality paper that is made for laser
printers.

The paper varies from side-to-side.

Turn the paper over.

The paper is too moist, too rough, too heavy or
too smooth, has the wrong grain direction, or is
of short-grain construction or it is embossed or
from a faulty paper lot.

Try another kind of paper, between 100 and
250 Sheffield, 4 to 6% moisture content.

Print is skewed (crooked).

The media guides might be incorrectly
adjusted.

Remove all media from the input tray,
straighten the stack, and then load the media
in the input tray again. Adjust the media guides
to the width and length of the media that you
are using and try printing again.

More than one sheet feeds at
one time.

The media tray might be overloaded.

Remove all media from the tray, and then
return some of the media to the tray. See Load
paper and print media on page 39.

The media might be wrinkled, folded, or
damaged.

Verify that the media is not wrinkled, folded, or
damaged. Try printing on media from a new or
different package.

The media might have been fanned before it
was loaded.

Load media that was not fanned. Loosen ream
by twisting paper stack.

Media might be too dry.

Load new paper that was stored properly.

Use long-grain paper.
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Problem

Cause

Solution

The product does not pull
media from the media input
tray.

The product might be in manual feed mode.

●

If Manual feed appears on the product
control-panel display, press OK to print
the job.

●

Verify that the product is not in manual
feed mode and print your job again.

The pickup roller might be dirty or damaged.

Contact HP. See www.hp.com/support/
ljm1319 or the support flyer that came in the
product box.

The paper-length adjustment control in tray 1
is set at a length that is greater than the media
size.

Adjust the paper-length adjustment control to
the correct length.

Performance problems
Try the tips in this section if pages exit the product, but have nothing printed on them, or when the product
does not print any pages.
Problem

Cause

Solution

Pages print but are totally
blank.

The sealing tape might still be in the print
cartridge.

Verify that the sealing tape has been
completely removed from the print cartridge.

The document might contain blank pages.

Check the document that you are printing to
see if content appears on all of the pages.

The product might be malfunctioning.

To check the product, print a configuration
page. See Information pages on page 122.

Certain media types can slow the print job.

Print on a different type of media.

154 Chapter 12 Problem solve

ENWW

Problem

Cause

Solution

Pages did not print.

The product might not be pulling media
correctly.

See Media-handling problems on page 152.

The media might be jamming in the product.

Clear the jam. See Clear jams on page 141.

The USB cable might be defective or
incorrectly connected.

●

Disconnect the cable at both ends and
reconnect it.

●

Try printing a job that has printed in the
past.

●

Try using a different USB cable.

The product might not be set up as the default
printer.

Open the Printers or Printers and Faxes
dialog box, right click the product, and then
click Set as Default Printer.

The product might have encountered an error.

Check the control panel for an error message.
See Control-panel messages on page 138.

The product might be paused or offline.

Open the Printers or Printers and Faxes
dialog box, and verify that the product status is
Ready. If it is Paused, right-click the product
and click Resume Printing.

The product might not be receiving power.

Check the power cord and verify that the
product is turned on.

Other devices are running on your computer.

The product might not share a USB port. If you
have an external hard drive or other device that
is connected to the same port as the product,
the other device might be interfering. To
connect and use the product, disconnect the
other device or use two USB ports on the
computer.

Copy problems
Prevent copy problems
The following are a few simple steps you can take to improve copy quality:
●

Use quality originals.

●

Load the media correctly. If the media is loaded incorrectly, it might skew, causing unclear images
and problems with the OCR program. See Load paper and print media on page 39 for instructions.

●

Use or make a carrier sheet to protect your originals.

NOTE: Verify that the media meets HP specifications. If the media meets HP specifications, recurring
feed problems indicate the pickup roller or separation pad is worn. Contact HP. See www.hp.com/
support/ljm1319 or the support flyer that came in the product box.
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Image problems
Problem

Cause

Solution

Images are missing or faded.

The print-cartridge might be defective or
empty.

Replace the print cartridge. See Print
cartridge on page 131.

The original might be of poor quality.

If your original is too light or damaged, the
copy might not be able to compensate, even
if you adjust the contrast. If possible, find an
original document in better condition.

The contrast settings might be set
incorrectly.

Use the control-panel Lighter/Darker button
to change the contrast setting.

The original might have a colored
background.

Colored backgrounds might cause images in
the foreground to blend into the background,
or the background might appear in a
different shade. If possible, use an original
document without a colored background.

The media might not meet
HP specifications.

Use media that meets HP specifications.
See Paper and print media on page 35.

The print-cartridge might be defective.

Replace the print cartridge. See Print
cartridge on page 131.

The ADF scanning strip might be dirty.

Clean the ADF scanning strip. See Clean the
scanner glass strip and platen on page 72.

The photosensitive drum inside the print
cartridge might have been scratched.

Install a new HP print cartridge. See Print
cartridge on page 131.

Ink, glue, correction fluid, or an unwanted
substance might be on the automatic
document feeder (ADF).

Clean the product. See Clean the product
on page 132.

The power to the product might have
fluctuated.

Reprint the job.

The printer driver or product software
settings may be incorrect.

Verify that the quality settings are correct.

Vertical white or faded stripes
appear on the copy.

Unwanted lines appear on the
copy.

Aa BbCc
Aa BbCc
Aa BbCc
Aa BbCc
Aa BbCc
Black dots or streaks appear on
the copy.

Copies are too light or dark.

See the product software Help for more
information about changing the settings.
Text is unclear.

The printer driver or product software
settings may be incorrect.

Verify that the quality settings are correct.
Verify that the EconoMode setting is off.
See the product software Help for more
information about changing the settings.
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Media-handling problems
Problem

Cause

Solution

Poor print quality or toner
adhesion

The paper is too moist, too rough, too heavy
or too smooth, or it is embossed or from a
faulty paper lot.

Try another kind of paper, between 100 and
250 Sheffield, 4 to 6% moisture content.

Dropouts, jamming, or curl

The paper has been stored incorrectly.

Store paper flat in its moisture-proof
wrapping.

The paper has variability from one side to the
other.

Turn the paper over.

The paper is too moist, has the wrong grain
direction, or is of short-grain construction

Use long-grain paper.

The paper varies from side-to-side.

Turn the paper over.

Jamming, damage to paper

The paper has cutouts or perforations.

Use paper that is free of cutouts or
perforations.

Problems with feeding

The paper has ragged edges.

Use high-quality paper that is made for laser
printers.

The paper varies from side-to-side.

Turn the paper over.

The paper is too moist, too rough, too heavy
or too smooth, has the wrong grain direction,
or is of short-grain construction or it is
embossed or from a faulty paper lot.

Try another kind of paper, between 100 and
250 Sheffield, 4 to 6% moisture content.

Print is skewed (crooked).

The media guides might be incorrectly
adjusted.

Remove all media from the input tray,
straighten the stack, and then load the
media in the input tray again. Adjust the
media guides to the width and length of the
media that you are using and try printing
again.

More than one sheet feeds at one
time.

The media tray might be overloaded.

Remove some of the media from the tray.
See Load paper and print media
on page 39.

The media might be wrinkled, folded, or
damaged.

Verify that the media is not wrinkled, folded,
or damaged. Try printing on media from a
new or different package.

Excessive curl

The product does not pull media
from the media input tray.
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Use long-grain paper.

The product might be in manual feed mode. ●

If Manual appears on the product
control-panel display, pressOK to print
the job.

●

Verify that the product is not in manual
feed mode and print your job again.

The pickup roller might be dirty or damaged.

Contact HP. See www.hp.com/support/
ljm1319 or the support flyer that came in the
product box.

The paper-length adjustment control in
tray 1 is set at a length that is greater than
the media size.

Adjust the paper-length adjustment control
to the correct length.
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Performance problems
Problem

Cause

Solution

No copy came out.

The input tray might be empty.

Load media in the product. See Load paper
and print media on page 39 for more
information.

The original might have been loaded
incorrectly.

In the automatic document feeder (ADF),
load the original with the narrow side forward
and the side to be scanned facing down.

The sealing tape might not have been
removed from the print cartridge.

Remove the print cartridge from the product,
pull out the sealing tape, and reinstall the
print cartridge.

The original might have been loaded
incorrectly.

In the ADF, load the original with the narrow
side leading into the ADF and the side to be
scanned facing down.

The media might not meet
HP specifications.

Use media that meets HP specifications.
See Paper and print media on page 35.

The print cartridge might be defective.

Replace the print cartridge. See Print
cartridge on page 131.

The product settings might be set to reduce
the scanned image.

On the control panel, press Reduce/
Enlarge and verify that it is set to
Original=100%.

Copies are blank.

Copies are reduced in size.
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Scan problems
Solve scanned-image problems
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Problem

Cause

Solution

The scanned image is of poor
quality.

The original might be a second-generation
photo or picture.

●

To eliminate the patterns, try reducing
the size of the image after scanning.

●

Print the scanned image to see if the
quality is better.

●

Verify that the resolution settings are
correct for the type of scan job that you
are performing. See Scanner
resolution and color on page 71.

The image that appears on the screen might ●
not be an accurate representation of the
quality of the scan.

Try adjusting your computer monitor
settings to use more colors (or levels of
gray). Typically, you make this
adjustment by opening Display in
Windows Control Panel.

●

Try adjusting the resolution settings in
the scanner software. See Scanner
resolution and color on page 71.

The original might have been loaded
incorrectly.

Use the media guides when you load the
originals into the ADF. See Load paper and
print media on page 39.

The scanner might be dirty.

Clean the scanner. See Clean the scanner
glass strip and platen on page 72.

The graphics settings might not be suitable
for the type of scan job that you are
performing.

Try changing the graphics settings. See
Scanner resolution and color on page 71.

A colored background might be causing
images in the foreground to blend into the
background.

Try adjusting the settings before you scan
the original or enhancing the image after you
scan the original.
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Problem

Cause

Solution

Part of the image did not scan.

The original might have been loaded
incorrectly.

Use the media guides when you load the
originals into the ADF. See Load originals for
scanning on page 68.

A colored background might be causing
images in the foreground to blend into the
background.

Try adjusting the settings before you scan
the original or enhancing the image after you
scan the original.

The original is longer than 381 mm (15
inches).

The maximum scannable length is 381 mm
(15 inches) when you use the automatic
document feeder (ADF) input tray. If the
page exceeds the maximum length, the
scanner stops. (Copies can be longer.)
CAUTION: Do not try to pull the original
from the ADF; you might damage the
scanner or your original. See Clear jams
from the ADF on page 142.

The scan takes too long
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The original is too small.

The minimum size that the ADF supports is
148 x 105 mm (5.83 x 4.13 inches). The
original might be jammed. See Clear jams
from the ADF on page 142.

The media size is incorrect.

In Scan settings, make sure that the input
media size is large enough for the document
that you are scanning.

The resolution or color level is set too high.

Change the resolution and color settings to
the correct settings for your job. See
Scanner resolution and color on page 71.

The software is set to scan in color.

The system default is color, which takes
longer to scan even when scanning a
monochrome original. If you acquire an
image through TWAIN or WIA, you can
change the settings so that the original
scans in grayscale or black-and-white. See
the product software Help for details.

A print job or copy job was sent before you
tried to scan.

If someone sent a print job or copy job before
you tried to scan, the scan will start if the
scanner is not busy. However, because the
product and scanner share memory, the
scan might be slower.
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Scan-quality problems
Prevent scan-quality problems
The following are a few simple steps you can take to improve copy and scan quality.
●

Use high-quality originals.

●

Load the media correctly. If the media is loaded incorrectly, it might skew, which causes unclear
images. See Load paper and print media on page 39 for instructions.

●

Adjust the software settings according to how you plan to use the scanned page. See Scanner
resolution and color on page 71 for more information.

●

If your product frequently feeds more than one page at a time, the separation pad might need to
be replaced. Contact HP. See www.hp.com/support/ljm1319 or the support flyer that came in the
product box.

●

Use or make a carrier sheet to protect your originals.

Solve scan-quality problems
Problem

Cause

Solution

Blank pages

The original might have been loaded upside
down.

In the automatic document feeder (ADF), put
the top end of the stack of originals into the
ADF input tray, with the media stack facedown and the first page to be scanned on the
bottom of the stack.

Too light or dark

The resolution and color levels may be set
incorrectly.

Verify that you have the correct resolution
and color settings. See Scanner resolution
and color on page 71.

Unwanted lines

The ADF glass might be dirty.

Clean the scanner strip. See Clean the
scanner glass strip and platen on page 72.

Black dots or streaks

The power to the product might have
fluctuated.

Reprint the job.

Unclear text

The resolution levels might be set
incorrectly.

Verify that the correct resolution settings are
correct. See Scanner resolution and color
on page 71.

Fax problems
To solve fax issues, see Solve fax problems on page 109.

Optimize and improve image quality
Print-quality checklist
General print-quality problems can be solved by using the following checklist:
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1.

Make sure that the paper or print media that you are using meets specifications. See Paper and
print media on page 35. Generally, smoother paper provides better results.

2.

If you are using a special print media such as labels, transparencies, glossy, or letterhead, ensure
that you have printed by type. See Select a paper type on page 51.
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3.

Print a configuration page and supplies status page at the product control panel. See Information
pages on page 122.
◦

Check the supplies status page to see if any supplies are low or empty. No information is
provided for non-HP print cartridges.

◦

If the pages do not print correctly, the problem is with the hardware. Contact HP. See
www.hp.com/support/ljm1319 or the support flyer that came in the product box.

4.

Try printing from a different program. If the page prints correctly, the problem is with the program
from which you were printing.

5.

Restart the computer and the product and try printing again. If the problem is not resolved, see
General print-quality issues on page 148.

Manage and configure printer drivers
Print-quality settings affect how light or dark the print is on the page and the style in which the graphics
are printed. You can also use the print-quality settings to optimize the print quality for a specific media
type.
You can change the settings in the product properties to accommodate the types of jobs that you are
printing. The following settings are available, depending on the printer driver that you are using:
●

600 dpi

●

Custom: This setting produces the same resolution as the default setting, but you can change the
scale patterns.

NOTE: Changing the resolution can change the formatting of your text.
Temporarily change print-quality settings
To change the print-quality settings only for the current software program, open the properties through
the Print Setup menu in the program that you are using to print.
Change print-quality settings for all future jobs
NOTE: For Macintosh instructions, see Change printer-driver settings for Macintosh on page 26.
For Windows 2000:
1.

In the Windows system tray, click Start, select Settings, and then click Printers.

2.

Right-click the product icon.

3.

Click Properties or Printing Preferences.

4.

Change the settings, and click OK.

For Windows XP:
1.

In the Windows system tray, click Start, click Control Panel, and then click Printers and Faxes.

2.

Right-click the product icon.

3.

Click Properties, or click Printing Preferences.

4.

Change the settings, and click OK.
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For Windows Vista:
1.

In the Windows system tray, click Start, click Control Panel, and then, under Hardware and
Sound, click Printer.

2.

Right-click the product icon.

3.

Click Properties, or click Printing Preferences.

4.

Change the settings, and click OK.

Solve connectivity problems
Solve direct-connection problems
If the product is experiencing connection issues while directly connected to a computer, complete the
following steps:
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1.

Make sure that USB cable is no longer than 2 meters (6 feet).

2.

Make sure that both ends of the USB cable are connected.

3.

Make sure that the cable is a USB 2.0 Hi-Speed-certified cable.

4.

If the error persists, use a different USB cable.
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Solve software problems
Solve common Windows problems
Error message:
"General Protection FaultException OE"
"Spool32"
"Illegal Operation"
Cause

Solution
Close all software programs, restart Windows, and try again.
Delete all temp files from the Temp subdirectory. Determine
the name of the directory by opening the AUTOEXEC.BAT file
and looking for the statement "Set Temp =". The name after
this statement is the Temp directory. It is usually C:\TEMP by
default, but can be redefined.
See the Microsoft Windows documentation that came with the
computer for more information about Windows error
messages.

Solve common Macintosh problems
Table 12-1 Problems with Mac OS X v10.3, Mac OS X v10.4, and later
The printer driver is not listed in Printer Setup Utility.
Cause

Solution

The product software might not have been installed or was installed
incorrectly.

Make sure that the PPD is in the following hard drive folder:
Library/Printers/PPDs/Contents/Resources/
<lang>.lproj, where “<lang>” represents the two-letter language
code for the language that you are using. If necessary, reinstall the
software. See the getting started guide for instructions.

The Postscript Printer Description (PPD) file is corrupt.

Delete the PPD file from the following hard drive folder: Library/
Printers/PPDs/Contents/Resources/<lang>.lproj,
where “<lang>” represents the two-letter language code for the
language that you are using. Reinstall the software. See the getting
started guide for instructions.

The product name does not appear in the printer list box in the Printer Setup Utility.
Cause

Solution

The product might not be ready.

Make sure that the cables are connected correctly, the product is on,
and the Ready light is on. Use a different computer port for the USB
cable.

The wrong product name is being used.

Check the product name by printing a configuration page. See
Information pages on page 122. Verify that the name on the
configuration page matches the product name in the Printer Setup
Utility.

The interface cable might be defective or of poor quality.

Replace the interface cable. Make sure to use a high-quality cable.
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Table 12-1 Problems with Mac OS X v10.3, Mac OS X v10.4, and later (continued)
A print job was not sent to the product that you wanted.
Cause

Solution

The print queue might be stopped.

Open the print queue, and then click Start Jobs.

The wrong product name is being used. Another product with the
same or similar name might have received your print job.

Check the product name by printing a configuration page. See
Information pages on page 122. Verify that the name on the
configuration page matches the product name in the Printer Setup
Utility.

An encapsulated PostScript (EPS) file does not print with the correct fonts.
Cause

Solution

This problem occurs with some programs.

●

Try downloading the fonts that are contained in the EPS file to
the product before printing.

●

Send the file in ASCII format instead of binary encoding.

You are unable to print from a third-party USB card.
Cause

Solution

This error occurs when the software for USB printers is not
installed.

When adding a third-party USB card, you might need the Apple USB
Adapter Card Support software. The most current version of this
software is available from the Apple Web site.

When connected with a USB cable, the product does not appear in the Macintosh Printer Setup Utility after the driver is selected.
Cause

Solution

This problem is caused by either a software or a hardware
component.

Software troubleshooting
●

Check that your Macintosh supports USB.

●

Verify that your Macintosh operating system is Mac OS X v10.3,
Mac OS X v10.4, or later.

●

Ensure that your Macintosh has the appropriate USB software
from Apple.

Hardware troubleshooting

ENWW

●

Check that the product is turned on.

●

Verify that the USB cable is connected correctly.

●

Check that you are using the appropriate high-speed USB cable.

●

Ensure that you do not have too many USB devices drawing
power from the chain. Disconnect all of the devices from the
chain, and connect the cable directly to the USB port on the host
computer.

●

Check to see if more than two nonpowered USB hubs are
connected in a row on the chain. Disconnect all of the devices
from the chain and connect the cable directly to the USB port on
the host computer.
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Table 12-1 Problems with Mac OS X v10.3, Mac OS X v10.4, and later (continued)
When connected with a USB cable, the product does not appear in the Macintosh Printer Setup Utility after the driver is selected.
Cause

Solution
NOTE:
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The iMac keyboard is a nonpowered USB hub.
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Accessories and ordering information

●

To order supplies in the U.S., go to www.hp.com/sbso/product/supplies.

●

To order supplies worldwide, go to www.hp.com/ghp/buyonline.html.

●

To order supplies in Canada, go to www.hp.ca/catalog/supplies.

●

To order supplies in Europe, go to www.hp.com/go/ljsupplies.

●

To order supplies in Asia-Pacific, go to www.hp.com/paper/.

●

To order accessories, go to www.hp.com/go/accessories.
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Supplies
Product name

Description

Part number

Replacement print cartridge

Average yield for the print cartridge is
approximately 2,000 pages.

Q2612A

Cable and interface accessories
Product name

Description

Part number

USB cable

2-meter standard USB-compatible
device connector

C6518A

3-meter standard USB-compatible
device connector

C6520A

Product fax cord

8121-0811

Fax cord
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Service and support

Hewlett-Packard limited warranty statement
HP PRODUCT

DURATION OF LIMITED WARRANTY

HP LaserJet M1319f

One-year limited warranty

HP warrants to you, the end-user customer, that HP hardware and accessories will be free from defects in materials
and workmanship after the date of purchase, for the period specified above. If HP receives notice of such defects
during the warranty period, HP will, at its option, either repair or replace products which prove to be defective.
Replacement products may be either new or equivalent in performance to new.
HP warrants to you that HP software will not fail to execute its programming instructions after the date of purchase,
for the period specified above, due to defects in material and workmanship when properly installed and used. If
HP receives notice of such defects during the warranty period, HP will replace software which does not execute
its programming instructions due to such defects.
HP does not warrant that the operation of HP products will be uninterrupted or error free. If HP is unable, within a
reasonable time, to repair or replace any product to a condition as warranted, you will be entitled to a refund of
the purchase price upon prompt return of the product.
HP products may contain remanufactured parts equivalent to new in performance or may have been subject to
incidental use.
Warranty does not apply to defects resulting from (a) improper or inadequate maintenance or calibration, (b)
software, interfacing, parts or supplies not supplied by HP, (c) unauthorized modification or misuse, (d) operation
outside of the published environmental specifications for the product, or (e) improper site preparation or
maintenance.
TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTIES ARE EXCLUSIVE AND NO OTHER
WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR IMPLIED AND HP
SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF MERCHANTABILITY,
SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE. Some countries/regions, states or
provinces do not allow limitations on the duration of an implied warranty, so the above limitation or exclusion might
not apply to you. This warranty gives you specific legal rights and you might also have other rights that vary from
country/region to country/region, state to state, or province to province. HP's limited warranty is valid in any country/
region or locality where HP has a support presence for this product and where HP has marketed this product. The
level of warranty service you receive may vary according to local standards. HP will not alter form, fit or function
of the product to make it operate in a country/region for which it was never intended to function for legal or regulatory
reasons.
TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES IN THIS WARRANTY STATEMENT ARE YOUR
SOLE AND EXCLUSIVE REMEDIES. EXCEPT AS INDICATED ABOVE, IN NO EVENT WILL HP OR ITS
SUPPLIERS BE LIABLE FOR LOSS OF DATA OR FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL
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(INCLUDING LOST PROFIT OR DATA), OR OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR
OTHERWISE. Some countries/regions, states or provinces do not allow the exclusion or limitation of incidental or
consequential damages, so the above limitation or exclusion may not apply to you.
THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT LAWFULLY
PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO THE MANDATORY
STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.

Customer self repair warranty service
HP products are designed with many Customer Self Repair (CSR) parts to minimize repair time and
allow for greater flexibility in performing defective parts replacement. If during the diagnosis period, HP
identifies that the repair can be accomplished by the use of a CSR part, HP will ship that part directly to
you for replacement. There are two categories of CSR parts: 1) Parts for which customer self repair is
mandatory. If you request HP to replace these parts, you will be charged for the travel and labor costs
of this service. 2) Parts for which customer self repair is optional. These parts are also designed for
Customer Self Repair. If, however, you require that HP replace them for you, this may be done at no
additional charge under the type of warranty service designated for your product.
Based on availability and where geography permits, CSR parts will be shipped for next business day
delivery. Same-day or four-hour delivery may be offered at an additional charge where geography
permits. If assistance is required, you can call the HP Technical Support Center and a technician will
help you over the phone. HP specifies in the materials shipped with a replacement CSR part whether
a defective part must be returned to HP. In cases where it is required to return the defective part to HP,
you must ship the defective part back to HP within a defined period of time, normally five (5) business
days. The defective part must be returned with the associated documentation in the provided shipping
material. Failure to return the defective part may result in HP billing you for the replacement. With a
customer self repair, HP will pay all shipping and part return costs and determine the courier/carrier to
be used.
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Print cartridge limited warranty statement
This HP product is warranted to be free from defects in materials and workmanship.
This warranty does not apply to products that (a) have been refilled, refurbished, remanufactured or
tampered with in any way, (b) experience problems resulting from misuse, improper storage, or
operation outside of the published environmental specifications for the device product or (c) exhibit wear
from ordinary use.
To obtain warranty service, please return the product to place of purchase (with a written description of
the problem and print samples) or contact HP customer support. At HP's option, HP will either replace
products that prove to be defective or refund your purchase price.
TO THE EXTENT ALLOWED BY LOCAL LAW, THE ABOVE WARRANTY IS EXCLUSIVE AND NO
OTHER WARRANTY OR CONDITION, WHETHER WRITTEN OR ORAL, IS EXPRESSED OR
IMPLIED AND HP SPECIFICALLY DISCLAIMS ANY IMPLIED WARRANTIES OR CONDITIONS OF
MERCHANTABILITY, SATISFACTORY QUALITY, AND FITNESS FOR A PARTICULAR PURPOSE.
TO THE EXTENT ALLOWED BY LOCAL LAW, IN NO EVENT WILL HP OR ITS SUPPLIERS BE
LIABLE FOR DIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL (INCLUDING LOST PROFIT OR
DATA), OR OTHER DAMAGE, WHETHER BASED IN CONTRACT, TORT, OR OTHERWISE.
THE WARRANTY TERMS CONTAINED IN THIS STATEMENT, EXCEPT TO THE EXTENT
LAWFULLY PERMITTED, DO NOT EXCLUDE, RESTRICT OR MODIFY AND ARE IN ADDITION TO
THE MANDATORY STATUTORY RIGHTS APPLICABLE TO THE SALE OF THIS PRODUCT TO YOU.

Customer support
Get telephone support, free during your warranty period, for
your country/region

Country/region phone numbers are on the flyer that was in the
box with your product or at www.hp.com/support/.

Have the product name, serial number, date of purchase, and
problem description ready.
Get 24-hour Internet support

www.hp.com/support/ljm1319

Get support for products used with a Macintosh computer

www.hp.com/go/macosx

Download software utilities, drivers, and electronic information

www.hp.com/go/ljm1319_software

Order supplies and paper

www.hp.com/go/suresupply

Order genuine HP parts or accessories

www.hp.com/buy/parts

Order additional HP service or maintenance agreements

www.hp.com/go/carepack

Repack the device
If HP Customer Care determines that your device needs to be returned to HP for repair, follow the steps
below to repack the device before shipping it.
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CAUTION: Shipping damage as a result of inadequate packing is the customer’s responsibility.
1.

Remove and retain the print cartridge.
CAUTION: It is extremely important to remove the print cartridge before shipping the device. A
print cartridge that remains in the device during shipping will leak and entirely cover the device
engine and other parts with toner.
To prevent damage to the print cartridge, avoid touching the roller on it, and store the print cartridge
in its original packing material or so that it is not exposed to light.

2.

Remove and retain the power cable, interface cable, and optional accessories.

3.

If possible, include print samples and 50 to 100 sheets of paper or other print media that did not
print correctly.

4.

In the U.S., call HP Customer Care to request new packing material. In other areas, use the original
packing material, if possible. Hewlett-Packard recommends insuring the equipment for shipment.
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Specifications

This section contains the following information about the product:
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●

Physical specifications

●

Electrical specifications

●

Power consumption

●

Environmental specifications

●

Acoustic emissions
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Physical specifications
Table C-1 Physical specifications
Product

Height

Depth

Width

Weight

HP LaserJet M1319

459 mm (18.1 inches)

443 mm (17.3 inches)

429 mm (16.9 inches)

10 kg (22 lb)

Electrical specifications
CAUTION: Power requirements are based on the country/region where the product is sold. Do not
convert operating voltages. This will damage the product and void the product warranty.
Table C-2 Electrical specifications
Item

110-volt models

230-volt models

Power requirements

110 to 127 V (+/- 10%)

220 to 240 V (+/- 10%)

50 / 60 Hz (+/- 2 Hz)

50 / 60 Hz (+/- 2 Hz)

4.5 A

2.6 A

Rated current

Power consumption
Table C-3 Power consumption (average, in watts)1
Product model

Printing2

Copying2

Ready/Sleep3

Off

HP LaserJet M1319

290 W

225 W

5W

<0.1 W

1

Values are based on preliminary data. See www.hp.com/support/ljm1319 for current information.

2

Power reported is highest values measured using all standard voltages.

3

Instant on fuser technology.

4

Recovery time from Ready/Sleep to start of printing = 8.5 seconds.

5

Maximum heat dissipation for all models in Ready mode = 45 BTU/hour
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Environmental specifications
Table C-4 Environmental specifications1

Temperature

Relative humidity
1

Recommended

Operating

Storage

15° to 32.5° C

15° to 32.5° C

–20° to 40° C

(59° to 90.5° F)

(59° to 90.5° F)

(–4° to 104° F)

10% to 80%

10% to 80%

95% or less

Values are subject to change.

Acoustic emissions
Table C-5 Acoustic emissions

ENWW

Sound Power Level

Declared per ISO 92961

Printing (18 ppm)

LWAd = 6.3 Bels (A) [65 dB (A)]

Ready

Inaudible

Sound Pressure Level - Bystander Position

Declared per ISO 92961

Printing (18 ppm)

LpAm = 49 dB(A)

Ready

Inaudible

1

Values are based on preliminary data. See www.hp.com/support/ljm1319 for current information.

2

Configuration tested: HP LaserJet M1319 printing simplex using A4 paper at 18 ppm.
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Regulatory information

This section contains the following regulatory information:
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●

FCC compliance

●

Environmental product stewardship program

●

Telephone Consumer Protection Act (United States)

●

IC CS-03 requirements

●

EU statement for telecom operation

●

New Zealand telecom statements

●

Declaration of conformity

●

Safety statements
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FCC compliance
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses, and can radiate radio
frequency energy. If it is not installed and used in accordance with the instructions, it may cause harmful
interference to radio communications. However, there is no guarantee that interference will not occur
in a particular installation. If this equipment does cause harmful interference to radio or television
reception, which can be determined by turning the equipment off and on, the user is encouraged to try
to correct the interference by one or more of the following measures:
●

Reorient or relocate the receiving antenna.

●

Increase separation between equipment and receiver.

●

Connect equipment to an outlet on a circuit different from that to which the receiver is located.

●

Consult your dealer or an experienced radio/TV technician.

NOTE: Any changes or modifications to the printer that are not expressly approved by HewlettPackard could void the user's authority to operate this equipment.
Use of a shielded interface cable is required to comply with the Class B limits of Part 15 of FCC rules.
This equipment complies with FCC rules, Part 68. On the back of this equipment is a label that contains,
among other information, the FCC registration number and ringer equivalence number (REN) for this
equipment. If requested, this information must be provided to the telephone company. The REN is used
to determine the quantity of devices which may be connected to the telephone line. Excessive RENs
on the telephone line may result in the devices not ringing in response to an incoming call. In most, but
not all, areas, the sum of the RENs should not exceed five (5.0). To be certain of the number of devices
that may be connected to the line, as determined by the total RENs, contact the telephone company to
determine the maximum REN for the calling area.
This equipment uses the following USOC jacks: RJ11C.
An FCC-compliant telephone cord and modular plug is provided with this equipment. This equipment is
designed to be connected to the telephone network or premises wiring using a compatible modular jack
which is Part 68 compliant. This equipment cannot be used on telephone company-provided coin
service. Connection to Party Line Service is subject to state tariffs. If this equipment causes harm to the
telephone network, the telephone company will notify you in advance that temporary discontinuance of
service may be required. If advance notice is not practical, the telephone company will notify the
customer as soon as possible. Also, you will be advised of your right to file a complaint with the FCC if
you believe it is necessary. The telephone company may make changes in its facilities, equipment,
operations, or procedures that could affect the operation of the equipment. If this happens, the telephone
company will provide advance notice in order for you to make the necessary modifications in order to
maintain uninterrupted service. If trouble is experienced with this equipment, please see the numbers
in the front of this manual for repair and (or) warranty information. If the trouble is causing harm to the
telephone network, the telephone company may request you remove the equipment from the network
until the problem is resolved. The following repairs can be done by the customer: Replace any original
equipment that came with the device. This includes the print cartridge, the supports for trays and bins,
the power cord, and the telephone cord. It is recommended that the customer install an AC surge arrestor
in the AC outlet to which this device is connected. This is to avoid damage to the equipment caused by
local lightning strikes and other electrical surges.
NOTE: For HP LaserJet M1319 MFP series models that include a handset, this equipment is hearingaid compatible.
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Environmental product stewardship program
Protecting the environment
Hewlett-Packard Company is committed to providing quality products in an environmentally sound
manner. This product has been designed with several attributes to minimize impacts on our environment.

Ozone production
This product generates no appreciable ozone gas (O3).

Power consumption
Power usage drops significantly while in Ready/Sleep mode, which saves natural resources and saves
money without affecting the high performance of this product. To determine the ENERGY STAR®
qualification status for this product see the Product Data Sheet or Specifications Sheet. Qualified
products are also listed at:
www.hp.com/go/energystar

Toner consumption
EconoMode uses less toner, which might extend the life of the print cartridge.

Paper use
This device’s manual duplex feature (two-sided printing) and N-up printing (multiple pages printed on
one page) capability can reduce paper usage and the resulting demands on natural resources.

Plastics
Plastic parts over 25 grams are marked according to international standards that enhance the ability to
identify plastics for recycling purposes at the end of the product’s life.

HP LaserJet print supplies
It’s easy to return and recycle your empty HP LaserJet print cartridges—free of charge—with HP Planet
Partners. Multilingual program information and instructions are included in every new HP LaserJet print
cartridge and supplies package. You help reduce the toll on the environment further when you return
multiple cartridges together rather than separately.
HP is committed to providing inventive, high-quality products and services that are environmentally
sound, from product design and manufacturing to distribution, customer use and recycling. When you
participate in the HP Planet Partners program, we ensure your HP LaserJet print cartridges are recycled
properly, processing them to recover plastics and metals for new products and diverting millions of tons
of waste from landfills. Since this cartridge is being recycled and used in new materials, it will not be
returned to you. Thank you for being environmentally responsible!
NOTE: Use the return label to return original HP LaserJet print cartridges only. Please do not use this
label for HP inkjet cartridges, non-HP cartridges, refilled or remanufactured cartridges or warranty
returns. For information about recycling your HP inkjet cartridges please go to http://www.hp.com/
recycle.
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Return and recycling instructions
United States and Puerto Rico
The enclosed label in the HP LaserJet toner cartridge box is for the return and recycling of one or more
HP LaserJet print cartridges after use. Please follow the applicable instructions below.
Multiple returns (two to eight cartridges)
1.

Package each HP LaserJet print cartridge in its original box and bag.

2.

Tape up to eight single boxes together using strapping or packaging tape (up to 70 lbs).

3.

Use a single pre-paid shipping label.

OR
1.

Use your own suitable box, or request a free bulk collection box from the http://www.hp.com/
recycle or 1-800-340-2445 (holds up to eight HP LaserJet print cartridges).

2.

Use a single pre-paid shipping label.

Single returns
1.

Package the HP LaserJet print cartridge in its original bag and box.

2.

Place the shipping label on the front of the box.

Shipping
For all HP LaserJet print cartridge recycling returns, give the package to UPS during your next delivery
or pickup, or take it to an authorized UPS drop-off center. For the location of your local UPS drop-off
center, call 1-800-PICKUPS or visit http://www.ups.com. If you are returning via USPS label, give the
package to a U.S. Postal Service carrier or drop off at a U.S.Postal Service Office. For more information,
or to order additional labels or boxes for bulk returns, visit http://www.hp.com/recycle or call
1-800-340-2445. Requested UPS pickup will be charged normal pickup rates. Information subject to
change without notice.

Non-US returns
To participate in HP Planet Partners return and recycling program, just follow the simple directions in
the recycling guide (found inside the packaging of your new printer supply item) or visit
http://www.hp.com/recycle. Select your country/region for information on how to return your HP LaserJet
printing supplies.

Paper
This product is capable of using recycled papers when the paper meets the guidelines outlined in the
HP LaserJet Printer Family Print Media Guide. This product is suitable for the use of recycled paper
according to EN12281:2002.

Material restrictions
This HP product does not contain added mercury.
This HP product contains a battery that might require special handling at end-of-life. The batteries
contained in or supplied by Hewlett-Packard for this product include the following:
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HP LaserJet M1319
Type

Carbon monofluoride lithium

Weight

1.5 g

Location

On formatter board

User-removable

No

For recycling information, you can go to www.hp.com/recycle, or contact your local authorities or the
Electronics Industries Alliance: www.eiae.org.

Disposal of waste equipment by users in private households in the
European Union
This symbol on the product or on its packaging indicates that this product must not be disposed of with
your other household waste. Instead, it is your responsibility to dispose of your waste equipment by
handing it over to a designated collection point for the recycling of waste electrical and electronic
equipment. The separate collection and recycling of your waste equipment at the time of disposal will
help to conserve natural resources and ensure that it is recycled in a manner that protects human health
and the environment. For more information about where you can drop off your waste equipment for
recycling, please contact your local city office, your household waste disposal service or the shop where
you purchased the product.

Chemical substances
HP is committed to providing our customers with information about the chemical substances in our
products as needed to comply with legal requirements such as REACH (Regulation EC No 1907/2006
of the European Parliament and the Council). A chemical information report for this product can be found
at: www.hp.com/go/reach.
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Material Safety Data Sheet (MSDS)
Material Safety Data Sheets (MSDS) for supplies containing chemical substances (for example, toner)
can be obtained by contacting the HP Web site at www.hp.com/go/msds or www.hp.com/hpinfo/
globalcitizenship/environment.

For more information
To obtain information about these environmental topics:
●

Product environmental profile sheet for this and many related HP products

●

HP’s commitment to the environment

●

HP’s environmental management system

●

HP’s end-of-life product return and recycling program

●

Material Safety Data Sheets

Visit www.hp.com/go/environment or www.hp.com/hpinfo/globalcitizenship/environment/index.html.
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Telephone Consumer Protection Act (United States)
The Telephone Consumer Protection Act of 1991 makes it unlawful for any person to use a computer
or other electronic device, including fax machines, to send any message unless such message clearly
contains, in a margin at the top or bottom of each transmitted page or on the first page of the
transmission, the date and time it is sent and an identification of the business, other entity, or individual
sending the message and the telephone number of the sending machine or such business, other entity,
or individual. (The telephone number provided cannot be a 900 number or any other number for which
charges exceed local or long-distance transmission charges.)

IC CS-03 requirements
Notice: The Industry Canada label identifies certified equipment. This certification means the equipment
meets certain telecommunications network protective, operational, and safety requirements as
prescribed in the appropriate Terminal Equipment Technical Requirement document(s). The
Department does not guarantee the equipment will operate to the user’s satisfaction. Before installing
this equipment, users should ensure that it is permissible for the equipment to be connected to the
facilities of the local telecommunications company. The equipment must also be installed using an
acceptable method of connection. The customer should be aware that compliance with the above
conditions may not prevent degradation of service in some situations. Repairs to certified equipment
should be coordinated by a representative designated by the supplier. Any repairs or alterations made
by the user to this equipment, or equipment malfunctions, may give the telecommunications company
cause to request the user to disconnect the equipment. Users should ensure for their own protection
that the electrical ground connections of the power utility, telephone lines, and internal metallic water
pipe system, if present, are connected together. This precaution can be particularly important in rural
areas.
CAUTION: Users should not attempt to make such connections themselves, but should contact the
appropriate electric inspection authority, or electrician, as appropriate. The Ringer Equivalence Number
(REN) of this device is 0.2.
Notice: The Ringer Equivalence Number (REN) assigned to each terminal device provides an indication
of the maximum number of terminals allowed to be connected to a telephone interface. The termination
on an interface may consist of any combination of devices subject only to the requirement that the sum
of the Ringer Equivalence Number of all the devices does not exceed five (5.0). The standard connecting
arrangement code (telephone jack type) for equipment with direct connections to the telephone network
is CA11A.
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EU statement for telecom operation
This product is intended to be connected to the analog Public Switched Telecommunication Networks
(PSTN) of European Economic Area (EEA) countries/regions. It meets requirements of EU R&TTE
Directive 1999/5/EC (Annex II) and carries appropriate CE conformity marking. For more details, see
Declaration of Conformity issued by the manufacturer in another section of this manual. However, due
to differences between individual national PSTNs, the product may not guarantee unconditional
assurance of successful operation on every PSTN termination point. Network compatibility depends on
the correct setting being selected by the customer in preparation of its connection to the PSTN. Please
follow the instructions provided in the user manual. If you experience network compatibility issues,
please contact your equipment supplier or Hewlett-Packard help desk in the country/region of operation.
Connecting to a PSTN termination point may be the subject of additional requirements set out by the
local PSTN operator.

New Zealand telecom statements
The grant of a Telepermit for any item of terminal equipment indicates only that Telecom has accepted
that the item complies with minimum conditions for connection to its network. It indicates no endorsement
of the product by Telecom, nor does it provide any sort of warranty. Above all, it provides no assurance
that any item will work correctly in all respects with another item of Telepermitted equipment of a different
make or model, nor does it imply that any product is compatible with all of Telecom’s network services.
This equipment may not provide for the effective hand-over of a call to another device connected to the
same line.
This equipment shall not be set up to make automatic calls to the Telecom “111” Emergency Service.
This product has not been tested to ensure compatibility with the FaxAbility distinctive ring service for
New Zealand.
WARNING! The handset used on this product might attract dangerous objects like pins, staples, or
needles. When using the handset, be careful to avoid harm that might occur from dangerous objects on
the ear piece of the handset.
NOTE: This equipment will be inoperable when main power fails.
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Declaration of conformity
Declaration of Conformity
according to ISO/IEC 17050-1 and EN 17050-1
Manufacturer's Name:
Manufacturer's Address:

Hewlett-Packard Company
DoC#: BOISB-0405-06-rel.1.0
11311 Chinden Boulevard,
Boise, Idaho 83714-1021, USA

declares, that the product
Product Name:

HP LaserJet M1319f MFP Series

Regulatory Model Number2)
Product Options:
Print Cartridge:

BOISB-0405-06
ALL
Q2612A

conforms to the following Product Specifications:
SAFETY:

IEC 60950-1:2001 / EN60950-1: 2001 +A11
IEC 60825-1:1993 +A1 +A2 / EN 60825-1:1994 +A1 +A2 (Class 1 Laser/LED Product)
GB4943-2001

EMC:

CISPR22:2005 / EN55022:2006 – Class B1)
EN 61000-3-2:2000 +A2
EN 61000-3-3:1995 +A1
EN 55024:1998 +A1 +A2
FCC Title 47 CFR, Part 15 Class B1) / ICES-003, Issue 4
GB9254-1998, GB17625.1-2003

TELECOM:

ES 203 021; FCC Title 47 CFR, Part 683)
TBR38:1998

Supplementary Information:
The product herewith complies with the requirements of the EMC Directive 2004/108/EC and the Low Voltage Directive 2006/95/EC, the
R&TTE Directive 1999/5/EC (Annex II), and carries the CE-Marking
accordingly.
This Device complies with Part 15 of the FCC Rules. Operation is subject to the following two Conditions: (1) this device may not cause
harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.
1) The product was tested in a typical configuration with Hewlett-Packard Personal Computer Systems.
2) For regulatory purposes, this product is assigned a Regulatory model number. This number should not be confused with the product name
or the product number(s).
3) Telecom approvals and standards appropriate for the target countries/regions have been applied to this product, in addition to those listed
above.
Boise, Idaho , USA
April 1, 2008
For regulatory topics only:
European Contact: Your Local Hewlett-Packard Sales and Service Office or Hewlett-Packard GmbH, Department HQ-TRE / Standards
Europe,, Herrenberger Strasse 140, , D-71034, Böblingen, (FAX: +49-7031-14-3143), http://www.hp.com/go/certificates
USA Contact:
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Product Regulations Manager, Hewlett-Packard Company,, PO Box 15, Mail Stop 160, Boise, ID 83707-0015, , (Phone:
208-396-6000)
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Safety statements
Laser safety
The Center for Devices and Radiological Health (CDRH) of the U.S. Food and Drug Administration has
implemented regulations for laser products manufactured since August 1, 1976. Compliance is
mandatory for products marketed in the United States. The device is certified as a “Class 1” laser product
under the U.S. Department of Health and Human Services (DHHS) Radiation Performance Standard
according to the Radiation Control for Health and Safety Act of 1968. Since radiation emitted inside the
device is completely confined within protective housings and external covers, the laser beam cannot
escape during any phase of normal user operation.
WARNING! Using controls, making adjustments, or performing procedures other than those specified
in this user guide may result in exposure to hazardous radiation.

Canadian DOC regulations
Complies with Canadian EMC Class B requirements.
« Conforme à la classe B des normes canadiennes de compatibilité électromagnétiques. « CEM ». »

EMI statement (Korea)
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Laser statement for Finland
Luokan 1 laserlaite
Klass 1 Laser Apparat
HP LaserJet M1319f, laserkirjoitin on käyttäjän kannalta turvallinen luokan 1 laserlaite. Normaalissa
käytössä kirjoittimen suojakotelointi estää lasersäteen pääsyn laitteen ulkopuolelle. Laitteen
turvallisuusluokka on määritetty standardin EN 60825-1 (1994) mukaisesti.
VAROITUS !
Laitteen käyttäminen muulla kuin käyttöohjeessa mainitulla tavalla saattaa altistaa käyttäjän
turvallisuusluokan 1 ylittävälle näkymättömälle lasersäteilylle.
VARNING !
Om apparaten används på annat sätt än i bruksanvisning specificerats, kan användaren utsättas för
osynlig laserstrålning, som överskrider gränsen för laserklass 1.
HUOLTO
HP LaserJet M1319f - kirjoittimen sisällä ei ole käyttäjän huollettavissa olevia kohteita. Laitteen saa
avata ja huoltaa ainoastaan sen huoltamiseen koulutettu henkilö. Tällaiseksi huoltotoimenpiteeksi ei
katsota väriainekasetin vaihtamista, paperiradan puhdistusta tai muita käyttäjän käsikirjassa lueteltuja,
käyttäjän tehtäväksi tarkoitettuja ylläpitotoimia, jotka voidaan suorittaa ilman erikoistyökaluja.
VARO !
Mikäli kirjoittimen suojakotelo avataan, olet alttiina näkymättömällelasersäteilylle laitteen ollessa
toiminnassa. Älä katso säteeseen.
VARNING !
Om laserprinterns skyddshölje öppnas då apparaten är i funktion, utsättas användaren för osynlig
laserstrålning. Betrakta ej strålen. Tiedot laitteessa käytettävän laserdiodin säteilyominaisuuksista:
Aallonpituus 775-795 nm Teho 5 m W Luokan 3B laser.
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Substances table (China)
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Glossary

ADF Automatic document feeder. The ADF is used to automatically feed originals into the product for copying,
scanning, or faxing.
browser

Short for Web browser, a software program that is used to locate and open Web pages.

collate The process of printing a multiple-copy job in sets. When collate is selected, the product prints an entire
set before printing additional copies. Otherwise, the product prints the specified number of copies of one page
before printing the subsequent pages.
comma (,) A comma in a fax dial sequence indicates that the product will pause at that point in the dialing
sequence.
contrast The difference between the dark and light areas of an image. The lower the number value, the more
closely the shades resemble each other. The higher the number, the more the shades appear separate from each
other.
dedicated line

A single telephone line that is used exclusively for either voice calls or fax calls.

distinctive ring A service offered by some telephone companies in some countries/regions that allows two or
three phone numbers to be set up on the same telephone line. Each phone number has a different ring pattern,
and the fax machine can be configured to recognize the distinctive ring of the fax number.
dots per inch (dpi) A measurement of resolution that is used for printing. Generally, more dots per inch result
in a higher resolution, more visible detail in the image, and a larger file size.
DSL Digital subscriber line, a technology that enables a high-speed, direct connection to the Internet through
telephone lines.
e-mail (electronic mail) An abbreviation for electronic mail. Software that can be used to electronically transmit
items over a communications network.
fax An abbreviation of facsimile. The electronic encoding of a printed page and the transmission of the electronic
page over a telephone line. The product software can send items to electronic fax programs, which require a
modem and fax software.
fax functions Fax-related tasks that are done from the control panel or software that affect only the current job,
or are done only once before returning to the Ready state, such as clearing memory. These functions are in their
own section in the control-panel menu.
fax settings Fax-related items that, when set or changed, continue to use the choice made until changed again.
An example would be the number of times set for the product to redial a busy number. These settings are in their
own section of the control panel menu.
file format The way the contents of a file are structured by a program or group of programs.
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grayscale Shades of gray that represent light and dark portions of an image when color images are converted
to grayscale; colors are represented by various shades of gray.
halftone An image type that simulates grayscale by varying the number of dots. Highly colored areas consist of
a large number of dots, while lighter areas consist of a smaller number of dots.
HP Director A software screen that is used when working with documents. When the document is loaded into
the automatic document feeder (ADF) and the computer is connected directly to the product, the HP Director
appears on the computer screen to initiate faxing, copying, or scanning.
HP Toolbox HP Toolbox is a program that provides access to the product management and troubleshooting
tools, and product documentation. HP Toolbox does not support Macintosh operating systems.
ISDN Integrated Services Digital Network (ISDN) is a suite of internationally adopted standards for end-to-end
digital communication over the public telephone network.
link A connection to a program or device that can be used to send information from the product software to other
programs, such as e-mail, electronic fax, and OCR links.
optical character recognition (OCR) software OCR software converts an electronic image of text, such as a
scanned document, into a form that word processor, spreadsheet, and database programs can use.
pixels per inch (ppi) A measurement of resolution that is used for scanning. Generally, more pixels per inch
result in a higher resolution, more visible detail in the image, and a larger file size.
printer driver A printer driver is a program that software programs use to gain access to a product’s features.
A printer driver translates a software program’s formatting commands (such as page breaks and font selection)
into a printer language, and then sends the print file to the product.
private branch exchange (PBX) A small telephone switching system that typically is used by large businesses
or universities to connect all telephone extensions within the organization. A PBX also connects to the public
switched telephone network (PSTN) and may be either manual or dial, depending on the method used by
extensions to place incoming or outgoing calls. Normally, the equipment is owned by the customer rather than
leased from the telephone company.
public switched telephone network (PSTN) The worldwide dial-up telephone network or a portion of that
network. Users are assigned unique phone numbers, which allow them to connect to the PSTN through local
telephone exchange companies. Often, this phrase is used when referring to data or other non-telephone services
carried over a path initially established using normal telephone signaling and ordinary switched long-distance
telephone circuits.
Readiris An optical character recognition (OCR) program that was developed by I.R.I.S. and that is included
with the product software.
resolution The sharpness of an image, measured in dots per inch (dpi). The higher the dpi, the greater the
resolution.
shared line A single telephone line that is used for both voice and fax calls.
surge protector

A device that protects a power supply and communications lines from electrical surges.

TWAIN An industry standard for scanners and software. By using a TWAIN-compliant scanner with a TWAINcompliant program, a scan can be initiated from within the program.
URL Uniform resource locator, the global address of documents and resources on the Internet. The first part of
the address indicates what protocol to use, the second part specifies the IP address or the domain name where
the resource is located.
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USB Universal serial bus (USB) is a standard that was developed by the USB Implementers Forum, Inc., to
connect computers and peripherals. USB is designed to concurrently connect a single computer USB port to
multiple peripherals.
watermarks A watermark adds background text to a document that is being printed. For example, “Confidential”
can be printed in the background text of a document to indicate that the document is confidential. A selection can
be made from a set of predefined watermarks, and the font, size, angle, and style can be changed. The product
can place the watermark on the first page only or all pages.
WIA Windows Imaging Architecture (WIA) is an imaging architecture that is available in Windows XP and
Windows Vista. A scan can be initiated from within these operating systems by using a WIA-compliant scanner.
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Index

A
accessibility features 3
accessories
part numbers 168
acoustic emissions 175
activity log, fax
troubleshooting 120
ad hoc groups, sending faxes
to 101
ADF
jams 142
locating 4
page sizes supported 116
advanced software installation 6
alert messages 138
alerts, setting up 124
answer mode, setting 91
answering machines, connecting
fax settings 90
automatic document feeder (ADF)
capacity 58
jams 142
locating 4
page sizes supported 116
autoreduction settings, fax 94
B
background shading,
troubleshooting 149
bands and streaks,
troubleshooting 149
batteries included 180
bin, output
capacity 3
jams, clearing 145
locating 4
black and white scanning
blank copies,
troubleshooting 158
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72

blank pages
printing 50
troubleshooting 154
blank scans, troubleshooting 161
blocking faxes 95
booklet settings
Windows 48
busy signals, redialing options 88
C
cables
part numbers 168
USB, troubleshooting 155
call report, fax
troubleshooting 120
caller-ID boxes, connecting 78
calling cards 101
Canadian DOC regulations 186
canceling
copy jobs 59
faxes 97
print job 46
scan jobs 70
capacity
output bin 3
cartridge-door release, locating 4
cartridges
HP fraud hotline 130
part number 168
recycling 130, 179
replacing 131
reusing 131
status, checking 129
status, viewing 124
storing 130
warranty 171
characters, troubleshooting 150
cleaning
exterior 133

glass 72, 133
paper path 132
color
scanning settings 72
color, scanning settings 71
comparison, product models 1
configuration page
printing 122
contrast settings
copy 61
fax 88
control panel
cleaning page, printing 132
menus 11
messages,
troubleshooting 138
scanning from (Macintosh) 31
settings 20, 26
supplies status, checking
from 129
control-panel
troubleshooting display
problems 141
copying
canceling 59
changing default number 59
contrast, adjusting 61
double-sided 64
edge-to-edge 62
enlarging 59
light/dark settings 61
media settings 62
media sizes 62
media types 62
media, troubleshooting 157
multiple copies 59
one-touch 59
quality, adjusting 60
quality, troubleshooting 156
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reducing 59
restore default settings 63
setup menu 12
size, troubleshooting 158
troubleshooting 158
cover pages 28, 50
creases, troubleshooting 151
crooked pages 151, 153
curled media 151
custom-size copies 59
custom-size paper settings
Macintosh 28
customer support
online 171
repacking device 171

dpi (dots per inch)
fax 89
faxing 14
scanning 71
specifications 3
drivers
default settings 47
Macintosh settings 28
Macintosh,
troubleshooting 164
operating systems
supported 7
presets (Macintosh) 28
settings 20, 21, 26
supported 20

D
dark copying 156
darkness, contrast settings
copy 61
fax 88
defaults, restoring 137
delaying fax sending 106
deleting faxes from memory 98
demo page, printing 122
density, print
changing settings 48
changing settings for copy
jobs 62
dial-tone detection settings 87
dialing
fax 14
from a telephone 106
manually 101
pauses, inserting 82
prefixes, inserting 87
redial manually 101
redialing automatically,
settings 88
tone or pulse settings 90
troubleshooting 117
dimensions
media 37
disposal, end-of-life 180
distinctive-ring settings 92
dots per inch (dpi)
fax 89
specifications 3
dots, troubleshooting 148

E
e-mail, scanning to
Macintosh 31
resolution settings 72
easy software installation 6
EconoMode setting 52
edge-to-edge printing 62
electrical specifications 174
electronic faxes
receiving 93
sending 104
end-of-life disposal 180
enlarging documents
copying 59
environmental specifications 175
environmental stewardship
program 179
EPS files, troubleshooting 165
error messages
control panel 138
critical 139
error messages, fax 109
error report, fax
printing 114
error-correction setting, fax 115
EU statement for telecom
operation 184
European Union, waste
disposal 181
extension phones
receiving faxes from 96
sending faxes from 106
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F
factory-set defaults, restoring 137
faded print 148
FastRes 3
fax
ad hoc groups 101
answer mode 15, 91
autoreduction 94
blocking 95
canceling 97
contrast setting 88
delaying sending 106
deleting from memory 98
detect-dial-tone settings 87
dial prefixes 87
dialing, tone or pulse 90
error messages 109
error report, printing 114
error-correction 115
extension phone receiving 96
factory-set defaults,
restoring 137
forwarding 91
group-dial entries 102
jams, troubleshooting 141
manual dialing 101
pauses, inserting 82
polling 85
private receive 92
receive log 127
receiving from software 93
receiving when you hear fax
tones 108
redial manually 101
redial settings 88
reports 13
reports, printing all 113
reports, troubleshooting 120
reprinting from memory 107
resolution 89
ring patterns 92
ring type 15
rings-to-answer 90
security, private receive 92
send by using speed dial 102
send log 127
sending from a telephone 106
sending from software 104
silence-detect mode 94
speed dials 102
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stamp-received 95
troubleshooting receiving 117
troubleshooting sending 116
V.34 setting 116
volume settings 86
fax date, setup
use control panel 80
use HP Fax Setup Wizard 80
fax header, setup
use control panel 80
use HP Fax Setup Wizard 80
fax ports, locating 5
fax reports, printing 13
Fax tab 125
fax time, setup
use control panel 80
use HP Fax Setup Wizard 80
faxing
from a computer
(Macintosh) 32
FCC compliance 178
features
product 3
feeding problems,
troubleshooting 153
file, scanning to
Macintosh 31
Finnish laser safety
statement 187
firmware updates 133
first page
blank 50
use different paper 28, 50
Fit to Page setting, fax 94
forwarding faxes 91
fraud hotline 130
fuser
media guidelines 49
warranty 171
G
General Protection FaultException
OE 164
glass, cleaning 72, 133
glossary of terms 189
gray background,
troubleshooting 149
grayscale scanning 72
group-dial entries
creating 84
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deleting 84
editing 84
sending faxes to

102

H
HP Customer Care 171
HP fraud hotline 130
HP LaserJet Scan (Windows) 69
HP Toolbox
about 123
Fax tab 125
Status tab 124
humidity specifications
environment 175
I
IC CS-03 requirements 183
Illegal Operation errors 164
image quality
copy, troubleshooting 156
print, troubleshooting 148,
161
scans, troubleshooting 159,
161
installation, software
advanced 6
easy 6
types (Windows) 22
installing
Macintosh software for direct
connections 27
Windows software 6, 22
interface ports
cables, ordering 168
locating 5
types included 3
international dialing 101
IP address
Macintosh,
troubleshooting 164
J
jams
ADF, clearing 142
causes of 141
fax, clearing 142
locating 142
output-bin, clearing 145
preventing 147

print cartridge area,
clearing 146
trays, clearing 143
K
Korean EMI statement

186

L
landscape orientation, setting 52
laser safety statements 186, 187
LaserJet Scan (Windows) 69
light copying 156
light print, troubleshooting 148
lightness
copy contrast 61
faded print,
troubleshooting 148
fax contrast 88
lines, troubleshooting
copies 156
printed pages 149
scans 161
loading media
priority input tray 39
tray 1 39
logs, fax
error 114
printing all 113
troubleshooting 120
loose toner, troubleshooting 150
M
Macintosh
double-sided printing 29
driver settings 26, 28
drivers supported 7
drivers, troubleshooting 164
faxing 32
faxing from 104
installing printing system for
direct connections 27
Intel Core Processor 6
PPC 6
print settings 26
problems, solving 164
resize documents 28
scanning from control
panel 31
scanning from TWAINcompliant software 69
scanning page-by-page 31
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scanning to e-mail 31
scanning to file 31
support 171
supported operating
systems 6, 26
USB card,
troubleshooting 165
Macintosh driver settings
custom-size paper 28
watermarks 29
manual dialing 101
manual redial 101
material restrictions 180
Material Safety Data Sheet
(MSDS) 182
media
ADF, sizes supported 116
copy settings 62
curled, troubleshooting 151
custom-size, Macintosh
settings 28
default size for tray 41
document size, selecting 51
fax autoreduction settings 94
first page 28, 50
jams 141
orientation, setting 52
pages per sheet 29
pages per sheet, Windows 55
printing on special media 49
select size and type 44
size, changing 63
size, selecting 51
source, selecting 51
supported sizes 37
troubleshooting 152
type, changing 63
type, selecting 51
wrinkled 151
memory
deleting faxes 98
reprinting faxes 107
specifications 3
menu
control panel, access 11
Copy setup 12
Fax functions 11
Fax Job status 11
Fax setup 13
Reports 12
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Service 17
System setup 16
menu map
printing 122
mercury-free product 180
messages
control panel 138
critical 139
Microsoft Word, faxing from 105
model
comparison 1
number, locating 5
modems, connecting 78
multiple pages per sheet 29, 55
N
n-up printing
Windows 55
New Zealand telecom
statements 184
noise specifications 175
number of copies, changing 59
O
OCR software 70
on/off switch, locating 4
online support 171
operating environment,
specifications 175
operating systems supported 6,
7, 20, 26
optical character recognition
software 70
ordering supplies and
accessories 168
orientation, setting 52
output bin
capacity 3
locating 4
output quality
copy, troubleshooting 156
print, troubleshooting 148,
161
scans, troubleshooting 159,
161
outside lines
dial prefixes 87
pauses, inserting 82
P
packaging device 171

page-by-page scanning
(Macintosh) 31
pages
blank 154
excessive curl 153
misfeeding 153
not printing 155
skewed 151, 153
pages per minute 3
pages per sheet
Windows 55
paper
ADF, sizes supported 116
copy settings 62
curled, troubleshooting 151
custom-size, Macintosh
settings 28
document size, selecting 51
fax autoreduction settings 94
first page 28, 50
jams 141
pages per sheet 29
size, changing 63
size, selecting 51
source, selecting 51
supported sizes 37
supported types 44
troubleshooting 152
type, changing 63
type, selecting 51
wrinkled 151
paper input trays
feeding problems,
troubleshooting 153
part numbers
cables 168
supplies 168
pauses, inserting 82
phone book, fax
adding entries 102
deleting all entries 82
HP Toolbox 125
importing 81
phone numbers
HP fraud hotline 130
phones
receiving faxes from 96, 108
phones, connecting extra 79
phones, downstream
sending faxes from 106
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photos
scanning, troubleshooting 159
physical specifications 174
pixels per inch (ppi), scanning
resolution 71
polling faxes 85
portrait orientation, setting 52
ports
cables, ordering 168
locating 5
troubleshooting
Macintosh 165
types included 3
power
requirements 174
power consumption 174
power switch, locating 4
PPDs, Macintosh 164
ppi (pixels per inch), scanning
resolution 71
prefixes, dial 87
presets (Macintosh) 28
print cartridge area jams,
clearing 146
print cartridges
door release, locating 4
HP fraud hotline 130
part number 168
recycling 130, 179
replacing 131
reusing 131
status, checking 129
status, viewing 124
storing 130
warranty 171
print density
changing copy job settings 62
changing settings 48
print job
canceling 46
print media
supported 37
print quality
troubleshooting 148, 161
printer drivers
Macintosh,
troubleshooting 164
supported 20
printing
configuration page 122
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demo page 122
direct connection to
computer 34
double-sided (duplex),
Macintosh 29
double-sided, Windows 53
edge-to-edge 62
Macintosh 28
menu map 122
on different media size 51
troubleshooting 155
USB connection 34
priority input tray
loading 39
priority, settings 20, 26
private receive 92
problem solving
Macintosh problems 164
problem-solving
Windows issues 164
product
model comparison 1
serial number, locating 5
product registration 128
protocol settings, fax 116
pulse-dialing 90
Q
quality
copy settings 60
copy, troubleshooting 156
print settings (Macintosh) 28
print settings (Windows) 162
print, troubleshooting 148,
161
scans, troubleshooting 159,
161
R
Readiris OCR software 70
receiving faxes
answer mode, setting 91
autoreduction settings 94
blocking 95
error report, printing 114
from extension phone 96
from software 93
log, HP Toolbox 127
polling 85
reprinting 107

ring patterns, settings 92
rings-to-answer settings 90
silence-detect mode 94
stamp-received setting 95
troubleshooting 117
when you hear fax tones 108
recycling
HP printing supplies returns and
environmental program 180
recycling supplies 130
redial
manually 101
redialing
automatically, settings 88
redistribute toner 131
reducing documents
copying 59
registration, product 128
regulatory information 178
removing software
Windows 22
repacking device 171
repetitive defects,
troubleshooting 152
replacing print cartridges 131
reports
configuration page 13, 122
demo page 12, 122
fax 13
menu map 13, 122
reports, fax
error 114
printing all 113
troubleshooting 120
reprinting faxes 107
resize documents
Macintosh 28
resizing documents
copying 59
resolution
fax 89
features 3
scanning 71
specifications 3
restoring factory-set defaults 137
ring patterns 92
ring tones
distinctive 92
rings-to-answer setting 90
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S
safety statements 186, 187
scale documents
Macintosh 28
scaling documents
copying 59
scanner
glass cleaning 72
scanning
black and white 72
blank pages,
troubleshooting 161
canceling 70
color 71
file formats 71
from control panel
(Macintosh) 31
from HP LaserJet Scan
(Windows) 69
grayscale 72
methods 69
OCR software 70
page-by-page (Macintosh) 31
quality, troubleshooting 159,
161
resolution 71
speed, troubleshooting 160
to e-mail (Macintosh) 31
to file (Macintosh) 31
TWAIN-compliant software 69
WIA-compliant software 69
scatter, troubleshooting 152
sending faxes
ad hoc groups 101
canceling 97
delaying 106
error report, printing 114
forwarding 91
from downstream
telephone 106
from software 104
group-dial entries 102
log, HP Toolbox 127
manual dialing 101
speed dial 102
troubleshooting 116
serial number, locating 5
service
critical error messages 139
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part numbers 168
repacking device 171
Service menu 17
settings
default 47
driver presets (Macintosh) 28
drivers 21, 26
factory-set defaults,
restoring 137
priority 20, 26
shipping device 171
silence-detect mode 94
size 174
size, copy
reducing or enlarging 59
troubleshooting 158
size, media
tray selection 44
sizes, media
Fit to Page setting, faxing 94
skewed pages 151, 153
slow speed, troubleshooting
faxing 120
scanning 160
smeared toner,
troubleshooting 149
software
advanced installation 6
components 6
direct connection installation,
Macintosh 27
easy installation 6
Readiris OCR 70
receiving faxes 93
scanning from TWAIN or
WIA 69
sending faxes 104
settings 20, 26
supported operating
systems 6, 20, 26
Windows 23
Windows components 19
special media
guidelines 38
special paper
guidelines 38
specifications
acoustic emissions 175
electrical 174
environmental 175

physical 174
product features 3
specks, troubleshooting 148
speed
fax, troubleshooting 120
print specifications 3
scanning, troubleshooting 160
speed dials
creating 82
deleting 83
deleting all 82
editing 82
programming 102
Spool32 errors 164
spots, troubleshooting 148
status
alerts 124
fax job 11
supplies, checking 129
viewing 124
storing
environmental
specifications 175
print cartridges 130
streaks, troubleshooting 149
supplies
HP fraud hotline 130
ordering 128
recycling 130, 179
replacing print cartridges 131
reusing 131
status, checking 129
status, viewing 124
storing 130
support
online 128, 171
repacking device 171
supported media 37
System setup menu 16
T
technical support
online 171
repacking device 171
Telephone Consumer Protection
Act 183
telephone numbers
HP fraud hotline 130
telephones
receiving faxes from 96, 108
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telephones, connecting extra 79
telephones, downstream
sending faxes from 106
temperature specifications
environment 175
terminology 189
text, troubleshooting 150
tone-dialing 90
toner
loose, troubleshooting 150
saving 52
scatter, troubleshooting 152
smeared, troubleshooting 149
specks, troubleshooting 148
transfer unit warranty 171
tray 1
jams, clearing 143
loading 39
locating 4
trays
capacities 3
capacity 44
default media size 41
feeding problems,
troubleshooting 153
jams, clearing 143
locating 4
troubleshooting
blank pages 154
blank scans 161
checklist 136
control panel messages 138
control-panel display 141
copy quality 156
copy size 158
copying 158
critical error messages 139
curled media 151
dialing 117
EPS files 165
faded print 148
fax error-correction
setting 115
fax reports 120
feeding problems 153
jams 141
lines, copies 156
lines, printed pages 149
lines, scans 161
loose toner 150
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pages not printing 155
pages too dark 156
pages too light 156
paper 152
print quality 148
receiving faxes 117
repetitive defects 152
scan quality 159, 161
sending faxes 116
skewed pages 151, 153
speed, faxing 120
text 150
toner scatter 152
toner smear 149
toner specks 148
USB cables 155
wrinkles 151
TWAIN-compliant software,
scanning from 69
types, media
tray selection 44
U
unblocking fax numbers 95
uninstalling
Windows software 22
USB port
locating 5
Macintosh installation 27
troubleshooting 155
troubleshooting
Macintosh 165
type included 3
Use different paper/covers 50

product 169
transfer unit and fuser 171
watermarks 29, 52
wavy paper, troubleshooting 151
Web sites
customer support 171
Macintosh customer
support 171
Material Safety Data Sheet
(MSDS) 182
weight 174
white or faded stripes,
troubleshooting 156
WIA-compliant software, scanning
from 69
Windows
default settings 47
driver settings 21
drivers supported 7
faxing from 104
pages per sheet 55
problem-solving issues 164
scanning from TWAIN or WIA
software 69
software components 19, 23
software for 123
supported operating
systems 6, 20
Windows driver settings
booklets 48
Word, faxing from 105
wrinkles, troubleshooting 151

V
V.34 setting 116
vertical lines,
troubleshooting 149
vertical white or faded
stripes 156
voltage requirements 174
volume
settings 17
volume, adjusting 86
W
warning messages 138
warranty
Customer self repair 170
print cartridge 171
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